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Notebook Interface

Using a Notebook Interface

If you use your computer via a purely graphical interface, you will typically double-click the
Mathematica icon to start Mathematica. If you use your computer via a textually based operat-

ing system, you will typically type the command mathematica to start Mathematica.

use an icon or the Start menu graphical ways to start Mathematica

mathematica the shell command to start Mathematica

text ending with Shift +Return input for Mathematica ( Shift +Return on some keyboards)
choose the Exit menu item exiting Mathematica (Quit on some systems)

Running Mathematica with a notebook interface.

In a "notebook" interface, you interact with Mathematica by creating interactive documents.

The notebook front end includes many menus and graphical tools for creating and reading
notebook documents and for sending and receiving material from the Mathematica kernel.
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A notebook mixing text, graphics and Mathematica input and output.

Examples of Integrals

Here is an example of a very simple algebraic integral:

1
Inj1]: J - dx
x*=-1

li2 x

ArcTan
1

/3 3
And here is a plot from a resulting function:

Inj2 Plot [%, {x, 1, 2}]

1 :
Log|[-1+ x] Log|l+x+x°
&

L L
|

|
1

L 12 14 16

20

When Mathematica is first started, it displays an empty notebook with a blinking cursor. You

can start typing right away. Mathematica by default will interpret your text as input. You enter

Mathematica input into the notebook, then type Shift +Return to make Mathematica process

your input. (To type Shift +Return, hold down the Shift key, then press Return.) You can use

the standard editing features of your graphical interface to prepare your input, which may go

on for several lines. Shift +Return tells Mathematica that you have finished your input. If your

keyboard has a humeric keypad, you can use its Enter key instead of Shift +Return.



Notebooks and Documents | 3

After you send Mathematica input from your notebook, Mathematica will label your input with
In[n]:=. It labels the corresponding output Out[n]=. Labels are added automatically.

You type 2 + 2, then end your input with Shift +Return. Mathematica processes the input, then

adds the input label In[1]:=, and gives the output.
2+2 3
24+2 ]"
s 4 kN

The output is placed below the input. By default, input/output pairs are grouped using rectangu-

lar cell brackets displayed in the right margin.

In Mathematica documentation, "dialogs" with Mathematica are shown in the following way:

With a notebook interface, you just type in 2 + 2. Mathematica then adds the label In[1]:=,
and prints the result.

2+2
4

You should realize that notebooks are part of the "front end" to Mathematica. The Mathematica
kernel which actually performs computations may be run either on the same computer as the
front end, or on another computer connected via a network. Sometimes, the kernel is not even

started until you actually do a calculation with Mathematica.

The built-in Mathematica Documentation Center (Help » Documentation Center), where you
might be reading this documentation, is itself an example of a Mathematica notebook. You can

evaluate and modify examples in place, or type your own examples.

In addition to the standard textual input, Mathematica supports the use of generalized, non-

textual input such as graphics and user interface controls, freely mixed with textual input.

To exit Mathematica, you typically choose the Exit menu item in the notebook interface.
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Doing Computations in Notebooks

A typical Mathematica notebook containing text, graphics and Mathematica expressions. The
brackets on the right indicate the extent of each cell.

Here is a Factorial: h|
- 1001 97
93 326215443944 152681699 238 856 266 700490715968 264 381621 s

468592963 895217599993229915608941463 976 156 518286253
697920827 223758251 185210916 864000000000000 000000000

ooo 1]

Injz):= N[%] 37

9.33262 « 107 3]

This is a plot of the related I” function: ]

i~ Plot [Gamma[x], {x, -5, 5}]

a
|

14

Mathematica notebooks are structured interactive documents that are organized into a
sequence of cells. Each cell may contain text, graphics, sounds or Mathematica expressions in
any combination. When a notebook is displayed on the screen, the extent of each cell is indi-
cated by a bracket on the right.

The notebook front end for Mathematica provides many ways to enter and edit the material in a
notebook. Some of these ways will be standard to whatever computer system or graphical

interface you are using. Others are specific to Mathematica.

Shift +Return send a cell of input to the Mathematica kernel

Doing a computation in a Mathematica notebook.
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Once you have prepared the material in a cell, you can send it as input to the Mathematica
kernel simply by pressing Shift +Return. The kernel will send back whatever output is gener-

ated, and the front end will create new cells in your notebook to display this output. Note that if

you have a numeric keypad on your keyboard, then you can use its Enter key as an alternative

to Shift +Return.

Here is a cell ready to be sent as input to the Mathematica kernel.

37100

The output from the computation is inserted in a new cell.

In1 37100

515377 520732011331036461129765621272702107522001

7]
El

Most kinds of output that you get in Mathematica notebooks can readily be edited, just like
input. Usually Mathematica will convert the output cell into an input cell when you first start

editing it.

Once you have done the editing you want, you can typically just press Shift +Return to send

what you have created as input to the Mathematica kernel.

Here is a typical computation in a Mathematica notebook.

1~ Integrate [Sgre[x+ 1] /Sgre[=x-1], x]

1+x)y1+x+2+-1+x Arcsinh| X 1*

|
—

If you start editing the output cell, Mathematica will automatically change it to an input cell.

1~ Integrate [Sqre[x + 1] /Sqre[=x-1], x]

(=1+x)YV14x+2 ‘V-1+xl\_rcsinh[""%]
N

1luc .‘(1 + X
\’ +x

)
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After you have edited the output, you can send it back as further input to the Mathematica
kernel.

1~ Integrate [Sgre[x+ 1] /Sqre[x-1], x]

(=1+x)V1+ex+2yV=14x D[Arcsinh[%], :f.]

Inj2]: // Simplify

—11"‘ V14x
X

A

When you do computations in a Mathematica notebook, each line of input is typically labeled

with In[n] :=, while each line of output is labeled with the corresponding out [n] =.

There is no reason, however, that successive lines of input and output should necessarily
appear one after the other in your notebook. Often, for example, you will want to go back to an
earlier part of your notebook, and reevaluate some input you gave before.

It is important to realize that in most cases wherever a particular expression appears in your
notebook, it is the line number given in In[n] := or out [rn] = which determines when the expres:
sion was processed by the Mathematica kernel. Thus, for example, the fact that one expression
may appear earlier than another in your notebook does not mean that it will have been evalu-
ated first by the kernel. This will only be the case if it has a lower line number.

Each line of input and output is given a label when it is evaluated by the kernel. It is these
labels, not the position of the expression in the notebook, that indicate the ordering of evalua-
tion by the kernel.

Results: 3

nz:- 8“2+ 2 1]
146 3]

njap- 8“2+ 2 I
uar- 10 002 3]
Settings for s: ]

inf1:= 8 = 12 17
12 3

- s = 100 17
100 3
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The exception to this rule is when an output contains the formatted results of a Dynamic or
Manipulate function. Such outputs will reevaluate in the kernel on an as-needed basis long
after the evaluation which initially created them. See "Dynamic Interactivity Language" for

more information on this functionality.

As you type, Mathematica applies syntax coloring to your input using its knowledge of the
structure of functions. The coloring highlights unmatched brackets and quotes, undefined global
symbols, local variables in functions and various programming errors. You can ask why Mathe-
matica colored your input by selecting it and using the Why the Coloring? item in the Help

menu.

If you make a mistake and try to enter input that the Mathematica kernel does not understand,
then the front end will produce a beep and emphasize any syntax errors in the input with color.
In general, you will get a beep whenever something goes wrong in the front end. You can find

out the origin of the beep using the Why the Beep? item in the Help menu.

Notebooks as Documents

Mathematica notebooks allow you to create documents that can be viewed interactively on

screen or printed on paper.

Particularly in larger notebooks, it is common to have chapters, sections and so on, each repre-

sented by groups of cells. The extent of these groups is indicated by a bracket on the right.



8 | Notebooks and Documents

The grouping of cells in a notebook is indicated by nested brackets on the right.

% Untitled-1* =

> |ES)

Section Heading

m Subsection Heading
Text within a subsection

Ivlore text.

m Another subsection

Text within the second subsection

100% =

A group of cells can be either open or closed. When it is open, you can see all the cells in it
explicitly. But when it is closed, you see only the cell around which the group is closed. Cell
groups are typically closed around the first or heading cell in the group, but you can close a
group around any cell in that group.

Large notebooks are often distributed with many closed groups of cells, so that when you first
look at the notebook, you see just an outline of its contents. You can then open parts you are

interested in by double-clicking the appropriate brackets.
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Double-clicking the bracket that spans a group of cells closes the group, leaving only the first
cell visible.

A& Untitled-1 * E]@
™
Section Heading }
m Subsection Heading JJ
= Another subsection A =
™
100% «

When a group is closed, the bracket for it has an arrow at the bottom. Double-clicking this
arrow opens the group again.

4 Untitled-1 * E]@
-

Section Heading
= Subsection Heading 1]
Text within a subsection J 1
Ivlore text. J
m Another subsection jl

100% =
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Double-clicking the bracket of a cell that is not the first of a cell group closes the cell group
around that cell and creates a bracket with up and down arrows (or only an up arrow if the cell

was the last in the group).
# Untitled-1 * M=%

~

Section Heading

Text within a subsection ]

m Another subsection

100% =

Each cell within a notebook is assigned a particular style which indicates its role within the
notebook. Thus, for example, material intended as input to be executed by the Mathematica
kernel is typically in Input style, while text that is intended purely to be read is typically in
Text style.

The Mathematica front end provides menus and keyboard shortcuts for creating cells with

different styles, and for changing styles of existing cells.
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This shows cells in various styles. The styles define not only the format of the cell contents, but
also their placement and spacing.

4 Untitled-1 * l:J@y

~

This cell is in the Section Style

m This cell is in the Subsection style

u This cell is in the Subsubsection siyle
This cell is in Text style.

Thiz cell is in Code style.

This cell is in Input style.

100% =

By putting a cell in a particular style, you specify a whole collection of properties for the cell,
including for example how large and in what font text should be given.

The Mathematica front end allows you to modify such properties, either for complete cells, or

for specific material within cells.

Even within a cell of a particular style, the Mathematica front end allows a wide range of proper-
ties to be modified separately.

# Untitled-1* =JoJ&d
~

Within a text cell, there can be large fONLS, bold font, and funny fonts

A cell can have properties such as a frame or background |

'
125% =

Ordinary Mathematica notebooks can be read by non-Mathematica users using the free product,
Mathematica Player, which allows viewing and printing, but does not allow computations of any
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kind to be performed. This product also supports notebook player files (.nbp), which have been
specially prepared by Wolfram Research to allow interaction with dynamic content such as the
output of Manipulate. For example, all the notebook content on The Wolfram Demonstrations

Project site is available as notebook player files.

Mathematica front end creating and editing Mathematica notebooks
Mathematica kernel doing computations in notebooks
Mathematica Player reading Mathematica notebooks and running

Demonstrations

Programs required for different kinds of operations with notebooks.

Working with Cells

Mathematica notebooks consist of sequences of cells. The hierarchy of cells serves as a struc-
ture for organizing the information in a notebook, as well as specifying the overall look of the

notebook.

Font, color, spacing, and other properties of the appearance of cells are controlled using
stylesheets. The various kinds of cells associated with a notebook's stylesheet are listed in
Format » Style. Mathematica comes with a collection of color and black-and-white stylesheets,

which are listed in the Format » Stylesheet menu.

In a New Session:
When Mathematica is first started, it displays an empty notebook with a blinking cursor. You
can start typing right away.

# Untitled-1 =Jlo/&ed
I

100% =
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The insertion point is indicated by the cell insertion bar, a solid gray line with a small black
cursor running horizontally across the notebook. The cell insertion bar is the place where new

cells will be created, either as you type or programmatically. To set the position of the insertion
bar, click in the notebook.

# Untitled-1 * M= =
- ,A‘

dadaad 7‘

100% =

To Create a New Cell:

Move the pointer in the notebook window until it becomes a horizontal I-beam.

Click, and a cell insertion bar will appear; start typing. By default, new cells are Mathematica
input cells.

# Untitled-1 * M==
nf]= 2+2 ‘ ‘ 1"‘,
out[1]= 4 \ ‘
v
100% =
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To Create a New Cell to Hold Ordinary Text:
Click in the notebook to get a cell insertion bar. Choose Format » Style » Text or use the

keyboard shortcut Cmd +7.

When you start typing, a text cell bracket appears.

To Change the Style of a Cell:
Click the cell bracket. The bracket is highlighted.

4 Untitled-1 * Mi=<

|~

Infl]= 2+ 2 =
out[i]= 4 1

This cell's style will change. ] =

[

100% =

Select a style from Format » Style. The cell will immediately reflect the change.

4 Untitled-1 * E]@]j
-

Infi]= 2+2

1]
out[i]= 4 j 1

This cell's style will
change.

100% =
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Alternatively, you can simultaneously press Cmd with one of the numbered keys, 0 through 9,
to select a style.
Choose Window » Show Toolbar to get a toolbar at the top of the notebook.

# Untitled-1* =Jlo/&ed
Title v B &

Infl]:= 2 +2

out[i]= 4

This cell’s style will
change. !

100% =~

Choose Window » Show Ruler to get a ruler at the top of the notebook.

% Untitled-1 * =Jo&d

[, L. 2, L. i, L. 2, L. 5. L. 5 [ A
L| 1 1 1 1 1 1 1 1 1 J

Infl]= 2+ 2

out[1]= 4

This cell's style will
change. .

100% =
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To Close a Group of Cells:

Double-click the outermost cell bracket of the group.

# Untitled-1 * (=<

An Introduction
1.1 The Basics

graphics, titles, sections, and figures.

1.2 Input Cells

Input cells are where Mathemafica coramands
should be placed, since input cells can always be
evvaluated. Results from evaluations are put in

cells, but ywou do not need to.

nf]= 1+1

out[1]= 2

1.3 Output Cells

While oatput cells are the results retwmed from

output cells. You can use typeset matheratics in

The basic units in a Mathemafica notebook are cells.
Cells can be a variety of styles: input, output, text,

100%

-
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When a group is closed, only the first cell in the group is displayed by default. The group

bracket is shown with a triangular flag at the bottom.

4 Untitled-1 * mEx|]
=

An Introduction |

1]

|v

100% =~
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To specify which cells remain visible when the cell group is closed, select those cells and double-
click to close the group. The closed group bracket is shown with triangular flags at the top and
bottom if the visible cells are within a cell group, or with a triangular flag at the top if they are
at the end of a cell group.

4 Untitled-1 * ==
1|le

Parametric Plot of a Torus

In[z]:= ParametricPlot3D[
{Cos[t] {3 + Cos[u]), Sin[t] {2 + Cos[ul]},
Simful}, {t, 0, 27}, {u, 0, 27}]

11l

Out[2]=

v
100%, =
4 Untitled-1 * M=%
Parametric Plot of a Torus e
S A
Out[2]=
v

100% =




To Open a Group of Cells:

Double-click a closed group’s cell bracket.

To Print a Notebook:
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Choose File » Print. The notebook style will be automatically optimized for printing.

To Change the Overall Look of a Notebook:

4% Untitled-1 *

1.1 The Basics

graphics, titles, sections, and figures.

1.2 Input Cells

cells, but you do not need to.

nfi]= 1+1

out[i]= 2

1.3 Output Cells

An Introduction

Input cells are where Mathemafica corarmands
should be placed, since input cells can always be
evaluated. Results from evaluations are put in
output cells. You can use typeset matheratics in

While output cells are the results returned fror

E]@

The basic units in a Mathemafica notebook are cells.
Cells can be a varlety of styles: input, output, text,

100%

L g
)

e

]

|

)

FY
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Choose Format » Stylesheet. Select a stylesheet from the menu. All cells in the notebook will
change appearance, based on the definitions in the new stylesheet.

e o

4 Untitled-1 * M=)

An Introduction
1.1 The Basics

The basic units in a Mathematica notehook
are cells. Cells can be avariety of styles:
input, output, text, araphics, titles, sections,
and figures.

1.2 Input Cells

Input cellz are where Mathematica
commands should he placed, since input
cells can abways be evaluated. Results
fram evaluations are put in output cells. You
can use typeset mathematics in cells, hut
yvou do not need to.

= | 1+1

Out[1]= 2

1.3 Output Cells e

100% =~

Use Format » Edit Stylesheet to customize stylesheets for Mathematica notebooks.

Changes to a notebook that only involve opening or closing cell groups will not cause the front
end to ask you if you want to save such changes when you close the notebook before saving.
To save these changes, use File » Save before you close the notebook or quit Mathematica.

To close a notebook, click the Close button in the title bar. You will be prompted to save any

unsaved changes.

On Windows, to close notebooks without being prompted to save, hold down the Shift key when
clicking the Close box.
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The Option Inspector

Introduction

Many aspects of the Mathematica front end, such as the styles of cells, the appearance of
notebooks, or the parameters used in typesetting, are controlled by options. For example, text
attributes such as size, font, and color each correspond to a separate option. You can set
options by directly editing the expression for a cell or notebook. But in most cases it is simpler

to use the Option Inspector.

The Option Inspector is a special tool for viewing and modifying option settings. It provides a
comprehensive listing of all front end options, grouped according to their function. You can
specify not only the setting for an option, but also the level at which it will take effect: globally,

for an entire notebook, or for a selection.

To use the Option Inspector, choose Format » Option Inspector. This brings up a dialog box
with two popup menus on top. The popup menu on the left specifies the level at which options
will take effect. The popup menu on the right allows you to choose if you want the options listed

by category, alphabetically, or as text.

Inheritance of Options

The Option Inspector allows you to set the value of an option on three different levels. In increas

ing order of precedence, the levels are as follows.
Global Preferences - settings for the entire application
Selected Notebook - settings for an entire notebook

Selection - settings for the current selection, e.g. for a group of cells, a single cell, or text

within a cell
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The levels lower in the hierarchy inherit their options from the level immediately above them.
For example, if a notebook has the option Editable set to True, by default all cells in the
notebook will be editable.

You can, however, override the inherited value of an option by explicitly changing its value. For
example, if you do not want a particular cell in your notebook to be editable, you can select the
cell and set Editable to False. This inheritance property of options provides you with a great
deal of control over the behavior of the front end, since you can set any option to have different
values at each level, as required.

Note: At each level, only the options that can be set at that level are listed in the Option Inspec-
tor. All other options appear dimmed, indicating that they cannot be changed unless you go to
a higher or lower level.

Searching for an Option

To search for a specific option, begin typing its name in the text field. The Option Inspector
goes to the first matching option. Press Enter to go to the next matching item on the list. (On

Macintosh, the Option Inspector displays all matching options at once).

Each line in the list of options gives the option name followed by its current value. You can
change the option's value by choosing from the popup menu next to the option setting, or by

selecting the option and clicking the value, typing over it, and pressing Enter.

When you start Mathematica for the first time, the values of all the options are set to their
default values. Each time you modify one of the options, a symbol appears next to it, indicating

that the value has been changed. Clicking the symbol resets the option to its default value.
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Setting Options: An Example

Suppose you want to draw a frame around a cell. The option that controls this property of a cell
is called cellFrame.

To Draw a Frame around a Cell:

1. Select the cell by clicking the cell bracket.

2. Choose Format » Option Inspector to open the Option Inspector window.
3. Choose Selection from the first popup menu.
4

. Click Cell Options » Display Options. This gives a list of all options that control how a
cell is displayed in the notebook.

5. Type True into the value field next to the option cellFrame. An icon appears next to the
option, indicating that its value has been changed. The cell that you selected now has a
frame drawn around it.

Alternatively, you can begin typing "cellframe" in the text field. This leads you directly to the
CellFrame option without having to search by category. This feature provides a useful way to

locate an option if you are unsure of the category it belongs in.

Notebook History Dialog

This dialog displays information regarding the editing times of the input notebook. This is a
"live" dialog that dynamically updates as changes are made to the notebook. It can be accessed
through Cell » Notebook History.
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‘Notebook Modification History Overview

[

|| sum.nb | Track notebook history

History for: - T
Controls— ¥ @ AllCells < Selected Cells Clear History
¥ Madification Timeline Copy Raw Data| [Copy Image

— Tue 4 Nov 2008 12:08:38 — Tue 4 Nowv 2008 12:09.43

P ——

.. Actions

Graphics —|

l. V — . h |>Z00ming

L Zoom: 1h 1d 1w im 1y Al
—|| ¥ Cell Statistics

First edited ' Tue 4 Nov 2008 12:08:40
Last edited ' Tue 4 Nov 2008 12:09:46
Total bytes 10552
Summary | Content bytes 6833

Number of cells |5
Number of edits 9

Merge interval | 30. seconds

The time information is saved in each cell of the notebook, in the form of a list of numbers
and/or pairs of numbers.
Cellf[
BoxData["123"], "Input",
CellChangeTimes->{{3363263352.09502, 3363263354.03695}, 3363263406.22268,
3363263441.939}
]
Each number represents the exact time of an edit, in absolute time units. A list of pairs indi-

cates multiple edits that have occurred during this interval.

Consecutive edits are recorded as an interval if they happen within a set time period. This
period is determined by CellChangeTimesMergeInterval, which can be set through the Option

Inspector or the Advanced section of the Preferences dialog. The default is 30 seconds.

The notebook history tracking feature can be turned off at the global level by using the Prefer-

ences dialog or by setting TrackCellChangeTimes t0O False.
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Features

Controls

sum.nb ‘v‘ Track notebook history

History for: & all Cells 0 Selected Cells Clear History

¥ Modification Timeline [Copy Raw Data| [Copy Image]

Notebook Chooser Popup Menu

This popup menu allows users to choose from all current open notebooks. The chosen notebook

will be brought to the front, making it the new input notebook.

Track History Checkbox

This checkbox enables or disables the notebook history tracking feature for the input notebook.

All/Selected Cells Radio Buttons

These radio buttons allow the graphics display to show information associated only with the
selected cells or all cells in the input notebook.

Clear History Button

This button will clear the stored edit time information from all currently displayed cells. This

operation cannot be undone.

Copy Buttons

The Copy Raw Data button will copy the raw data (in the form of a list of humbers and/or

pairs of numbers) from currently displayed cells to the clipboard.

The Copy Image button will copy the currently displayed graphics to the clipboard. All dynamic
features, except tooltips, are stripped from the copied graphics. This includes the zooming

features.
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Tue 11 Nov 2008 1730:46 Tue 4 Now 2008 12:08:38 — Tue 4 Nov 2008 12:09:48
W—
. o
B—
Ne cell history information available
.
WDVEIERD 9 G D VERD )7 D FRID ) 1 DVEILE
l * l l + A

Zoom: 1h 1d 1w 1m 1y Al Zoom: 1h 1d 1w 1m 1y Al

The graphics display plots cells versus time. Each cell in the notebook corresponds to each row
on the y axis. The corresponding edit times are plotted as points, while edit intervals are repre-

sented by lines.

As you mouse over the graphics, the mouse tooltip may provide some useful details for the

following elements:

m Each row on the y axis will display the corresponding cell's contents.

[

TS (n+4)? —
'

m Points will display the exact time of the edit (which corresponds to the computer clock at
the time of edit).

3
|Tue 4 Mov 2008 12:09:04] * *

m Lines will display the length of the edit interval (this value may be greater than the
CellChangeTimesMergelInterval value).

9.5 seconds = - ‘

Clicking a highlighted row will select the corresponding cell in the input notebook if and only if

the selection-only checkbox is unchecked.
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Bl o jl A 1 N Bl :-&
l ’ A

The graphics display comes with a couple of zooming features for the time axis:

m The blue triangles at the bottom can be dragged to change the plotted time interval. Use
the middle diamond to pan the graphics using the same time interval.

m Clicking any time label blocks will zoom into that interval of time. With this feature, users
can actually zoom down to the last second (which may be out of range with the previous
zoom feature).

m Clicking the shaded area will undo the last zoom action. Click outside the shaded area to
revert to showing the entire time interval.

First edited | Tue 4 Nov 2008 12:08:40
Last edited | Tue 4 Noy 2008 12:09:46
Total bytes | 10552
Content bytes | 6833
Mumber of cells | 5
Mumber of edits |9
Merge interval | 30. seconds

The summary is a concise, overall display of relevant cell information. This display also respects
the setting of the selection-only checkbox.
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Input and Output in Notebooks

Entering Greek Letters

click on o use a button in a palette

\[Alpha] use a full name

EscaEsc or EscalphaEsc use a standard alias (shown below as EscaEsc)
Esc\alphaEsc use a TgX alias

Esc& alpha; Esc use an HTML alias

Ways to enter Greek letters in a notebook.

Here is a palette for entering common Greek letters.

Special Characters

Letters | Symbols

ol|lalajala]a

¢ 8 ¥y 4 ¢ n @
Pk A ox v £ o =&
P T T ¥ X w
F 2 g B

4 BT A E 2 H &
I E A MNZE OO
P ETY T & X ¥
n F 9 ¢ 3

= & xr W g @

You can use Greek letters just like the ordinary letters that you type on your keyboard.
Expand[ (a + ) " 3]

o®+3a?B+3ap%+ B3



Q © § m < ® » X O I s O O X W K

o

g€ & X 8 ©

Commonly used Greek letters

There are several ways to enter Greek letters

Expand[ (a + B) ~ 3]

o®+3a?B+3ap%+ 33

full name
\[ Al pha]
\ [ Bet a]

\ [ Ganma]
\ [ Del ta]
\ [ Epsi | on]
\ [ Zet a]
\[ Et a]

\ [ Thet a]
\ [ Kappa]
\ [ Lanbda]
\ [ Mu]

\ [ Nu]
\[Xi]
\[Pi]

\ [ Rho]

\ [ Si gna]
\ [ Tau]

\ [ Phi ]

\ [ Curl yPhi]
\[Chi]
\[Psi]

\ [ Onega]

aliases

EscaEsc,
Escb Esc,
Esc g Esc,
Escd Esc,
Esc e Esc,
Esc z Esc,
Esch Esc,
Escq Esc,
Esck Esc,
Escl Esc,
Esc mEsc,
Escn Esc,
Esc x Esc,
Escp Esc,
Escr Esc,
Escs Esc,
Esct Esc,
Escf Esc,
Escj Esc,
Escc Esc,
Escy Esc,

Esco Esc,

Escal phaEsc

Escbet a Esc

Esc gamma Esc

Escdel t a Esc

Escepsi | on Esc
Esczet aEsc

Escet Esc, Escet aEsc
Esct h Esc, Esct het a Esc
Esc kappa Esc

Escl| anbda Esc

Esc nmu Esc

Escnu Esc

Escxi Esc

Escpi Esc

Escr ho Esc

Escsi gnma Esc

Esct au Esc

Esc ph Esc, Escphi Esc
Esc cph Esc, Esccphi Esc
Escch Esc, Escchi Esc
Esc ps Esc, Escpsi Esc

Esc WEsc, Esconega Esc

Do’ X B K M Hd > 0 > A
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. This input uses full names.

full name

\ [ Capi t al Gamma]
\ [ Capi tal Del ta]
\ [ Capi t al Thet a]
\ [ Capi t al Lanbda]
\[Capital Pi]

\ [ Capi tal Si gna]
\ [ Capi t al Upsi | on]
\ [ Capi t al Phi ]

\ [ Capi tal Chi]
\[Capital Psi]

\ [ Capi t al Orega]

. TeX aliases are not listed explicitly.

aliases
Esc GEsc,

Esc DEsc,
Esc QEsc,
EscL Esc,
Esc PEsc,
Esc SEsc,
Esc UEsc,
Esc FEsc,
Esc CEsc,
Esc YEsc,
Esc OEsc,

Esc Gamma Esc

EscDel t aEsc

Esc Th Esc, Esc Thet a Esc
Esc Lanbda Esc

Esc Pi Esc

Esc Si gma Esc

Esc Upsi | on Esc

Esc Ph Esc, Esc Phi Esc
Esc Ch Esc, Esc Chi Esc
EscPs Esc, EscPsi Esc
Esc WEsc, Esc Onega Esc
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Note that in Mathematica the letter n stands for pi. None of the other Greek letters have spe-

cial meanings.

st stands for Pi.
N[r]
3.14159

You can use Greek letters either on their own or with other letters.
Expand[ (Raf + E) ~ 4]

RoB? + 4 Rap® = + 6 Rap? =2 + 4 RaB =% + =4

The symbol rra is not related to the symbol .
Factor[rma"4 - 1]

(-1 +70) (1+70) (1+70?)

Entering Two-Dimensional Input

When Mathematica reads the text x "y, it interprets it as x raised to the power y.
x"y

xY

In a notebook, you can also give the two-dimensional input xY directly. Mathematica again
interprets this as a power.

xY

xY

One way to enter a two-dimensional form such as %Y into a Mathematica notebook is to paste

this form into the notebook by clicking the appropriate button in the palette.
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Here is a palette for entering some common two-dimensional notations.

Basic Math Assistant =
» Calculatar

» Basic Commands

¥ Typesetting ®
o x| e | Y
w ow o VaYe m [
afl=®a FREL NG
“w @ o= m g i [a] |m

o ()] (G2) | {aa] &

[ado fodn .o IEao

» Help and Settings

There are also several ways to enter two-dimensional forms directly from the keyboard.

x Ctrl+~ y Ctrl+Space use control keys that exist on most keyboards
x Ctrl+6 y Ctrl+Space use control keys that should exist on all keyboards

Ways to enter a superscript directly from the keyboard.

You type Ctrl+~ by holding down the Control key, then pressing the ~ key. As soon as you do
this, your cursor will jump to a superscript position. You can then type anything you want and it

will appear in that position.



32 | Notebooks and Documents

When you have finished, press Ctrl4+Space to move back down from the superscript position.
You type Ctrl+Space by holding down the Control key, then pressing the Space bar.

This sequence of keystrokes enters xY.

x Ctrl+” y

xY

Here the whole expression y + z is in the superscript.

x Ctrl+”™ y + z

x¥*?

Pressing Ctrl+Space takes you down from the superscript.

x Ctrl+~ y Ctrl+Space + z

XY + z

You can remember the fact that Ctrl+~ gives you a superscript by thinking of Ctrl+~ as just a
more immediate form of ~. When you type x"y, Mathematica will leave this one-dimensional
form unchanged until you explicitly process it. But if you type x Ctrl+”~ y then Mathematica will

immediately give you a superscript.

On a standard English-language keyboard, the character ~ appears as the shifted version of 6.
Mathematica therefore accepts Ctrl+6 as an alternative to Ctrl+~. Note that if you are using
something other than a standard English-language keyboard, Mathematica will almost always
accept Ctrl+6 but may not accept Ctrl+~.

x Ctrl+_ y Ctrl+Space use control keys that exist on most keyboards

x Ctrl+- y Ctrl+Space use control keys that should exist on all keyboards

Ways to enter a subscript directly from the keyboard.
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Subscripts in Mathematica work very much like superscripts. However, whereas Mathematica
automatically interprets x¥ as x raised to the power y, it has no similar interpretation for x,.

Instead, it just treats x, as a purely symbolic object.

This enters y as a subscript.

x Ctrl+_ y

Xy

Here is the usual one-dimensional Mathematica input that gives the same output expression.

Subscript[x, y]

Xy

x Ctrl+/ y Ctrl+Space use control keys

How to enter a built-up fraction directly from the keyboard.

This enters the built-up fraction Jy—‘

x Ctrl+/ y

X

y

Here the whole y + z goes into the denominator.

x Ctrl+/ y + z

X

y+2

But pressing Ctrl+Space takes you out of the denominator, so the + z does not appear in the
denominator.
x Ctrl+/ y Ctrl+Space + z

b
—+z
y
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Mathematica automatically interprets a built-up fraction as a division.

8888

2222

4
Ctrl+@ x Ctrl+Space use control keys that exist on most keyboards
Ctrl+2 x Ctrl+Space use control keys that should exist on all keyboards

Ways to enter a square root directly from the keyboard.

This enters a square root.

Ctrl+@ x + y

X+y
Ctrl+Space takes you out of the square root.
Ctrl+@ x Ctrl+Space + y

Vx +y

Here is the usual one-dimensional Mathematica input that gives the same output expression.

Sqrt([x] +y
Vx oy
Ctrl+~ or Ctrl+6 go to the superscript position
Ctrl+_ or Ctrl+- go to the subscript position
Ctrl+@ or Ctrl+2 go into a square root
Ctrl+% or Ctrl+5 go from subscript to superscript or vice versa, or to the
exponent position in a root
Ctri+/ go to the denominator for a fraction
Ctrl+Space return from a special position

Special input forms based on control characters. The second forms given should work on any keyboard.



Notebooks and Documents | 35

This puts both a subscript and a superscript on x.

x Ctrl+~ y Ctrl+% =z

Xy
Here is another way to enter the same expression.

x Ctrl+_ z Ctrl+% vy

xy
The same procedure can be used to enter a definite integral.

Escint Esc Ctrl+_ 0 Ctrl+% 1 Ctrl+Space f[x] EscddEsc x

1
Jf[x] dx
0

In addition to subscripts and superscripts, Mathematica also supports the notion of underscripts
and overscripts—elements that go directly underneath or above. Among other things, you can

use underscripts and overscripts to enter the limits of sums and products.

x Ctrl+Plus y Ctrl+Space or x Ctrl+= y Ctrl+Space

create an underscript x
y

x Ctrl+& y Ctrl+Space or x Ctrl+7 y Ctrl+Space

R
create an overscript x

Creating underscripts and overscripts.

Here is a way to enter a summation.

Esc sumEsc Ctrl+Plus x=0 Ctrl+% n Ctrl+Space f[x]

if[x]
x=0
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Editing and Evaluating Two-Dimensional Expressions

When you see a two-dimensional expression on the screen, you can edit it much as you would
edit text. You can for example place your cursor somewhere and start typing. Or you can select
a part of the expression, then remove it using the Delete key, or insert a new version by typing
it in.

In addition to ordinary text editing features, there are some keys that you can use to move
around in two-dimensional expressions.

Ctrl+. select the next larger subexpression
Ctrl+Space move to the right of the current structure
- move to the next character

(= move to the previous character

Ways to move around in two-dimensional expressions.

This shows the sequence of subexpressions selected by repeatedly typing Ctrl+..

142 x E
ArcTan
[ ] Log[-1+x] Log[l+x+x] Log[-l+x+x2 +x]
- + - +
ﬁ 3 6 E |
142 x 3
ArcTan
[ l Log[-1+%] Log[l+x+3x] Log[-1+x+x +%°]
- + - +
3 3 & 9

ArcTan [ 12 T
[ ] Log[-1+x] Lng[1+x+x2] Log[—1+x+x2 +x3]
+

h 3 * 3 h 5 9 |
ArcTan| 12* 3
[ ] Log[-1+x] Log[l+x+x%] Log[-l+x+:3xC +x]

) N * 3 - 6 " E |
ArcTan | 122 3
[ ] Log[-1+x] Log[l+x+3x] Log[-l+x+x +%°]

i 3 * 3 ) 6 } E |
hrcTan[“le 3

Log[-1+x] Lug[1+x+x2] Log[—1+x+x2 +x3]
3 * 3 - & * B
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Shift +Return evaluate the whole current cell
Shift+Ctrl+Enter (Windows/Unix/Linux) or Cmd+Return (Mac OS X)

evaluate only the selected subexpression

Ways to evaluate two-dimensional expressions.

In most computations, you will want to go from one step to the next by taking the whole expres-
sion that you have generated, and then evaluating it. But if for example you are trying to manip-
ulate a single formula to put it into a particular form, you may instead find it more convenient

to perform a sequence of operations separately on different parts of the expression.

You do this by selecting each part you want to operate on, then inserting the operation you
want to perform, then using Shift+Ctrl+Enter for Windows/Unix/Linux or Cmd+Return for Mac
0s X.

Here is an expression with one part selected.

{Factor[x* -1]. Factor[z® -1]. Factor[z® -1]. }

Factor[x" - 1]}

Pressing Shift+Ctrl+Enter (Windows/Unix/Linux) or Cmd+Return (Mac OS X) evaluates the selected
part.

{Factor[x*-1]. (-1+x) (1 +x +x* +x* + x). Factor[x® -1]. '
Factor[x? -1]}

The Basic Commands » y=x tab in the Basic Math Assistant, Classroom Assistant, and
Writing Assistant palettes also provides a number of convenient operations which will trans-

form in place any selected subexpression.
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Entering Formulas

character short form long form symbol

s Escp Esc \[Pi] Pi

o0 Escinf Esc \[Infinity] Infinity
° Escdeg Esc \ [Degree] Degree

Special forms for some common symbols.

This is equivalent to Sin[60 Degree].
Sin[60 °]
V3

2

Here is the long form of the input.
Sin[60 °]
V3

2

You can enter the same input like this.
Sin[60 :deg:]

V3

2

Here the angle is in radians.
T

Sin[—]
3

V3

2
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special characters short form long form ordinary characters
X<y x Esc<=Esc y x \[LessEqual] y x <=y
x> x Esc>=Esc y x X >=y

\ [GreaterEqual]

y
X+y x Esc!=Esc y x \ [NotEqual] vy x =y
xey x EscelEsc y x \[Element] y Element [x,y]
x>y x Esc->Esc y x \[Rule] vy X ->y

Special forms for a few operators. "Operator Input Forms" gives a complete list.

Here the replacement rule is entered using two ordinary characters, as ->.
X/ (x+1) /.x->3+y

3+y

4+y

This means exactly the same.
x/(x+1) /.x » 3+y

3+y

4+y

As does this.

x/(x+1) /. x Esc->Esc 3 + y
3+y

4+y

When you type the ordinary-character form for certain operators, the front end automatically
replaces them with the special-character form. For instance, when you type the last three

examples, the front end automatically substitutes the —» character for ->.

The special arrow form — is by default also used for output.
Solve[x"2 == 1, x]

{({x>-1}, {x>1}}
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special characters  short form long form ordinary characters
X =y x EscdivEsc y x \[Divide] y x /'y

X Xy x EscxEsc y x \[Times] y X %y

X x y x Esc x \[Cross] y Cross [x,V]

cross Esc y

X =y x Esc==Esc y x \[Equal] y X ==y
X =y x Escl=Esc y x \ [LongEqual] y X ==y
x Ay x Escas&Esc y x \[And] Yy X && y
x\V y x Esc || Esc y x \[Or] y x ||y
- X Esc! Esc x \ [Not] x 1 ox
X =y x Esc=>Esc y x \[Implies] y x =>y
x Uy x EscunEsc y x \[Union] y Union [x,y]
x Ny x Esc x \[Intersection] y Intersection [x,y]
interEsc y
xy x Esc, Esc y x \[InvisibleComma] y X,y
fx f Esc@Esc x f f @ x or f[x]
\ [InvisibleApplicati-
on]
x
x% x Esc+Esc f x \[ImplicitPlus] % xX+y/z

Some operators with special forms used for input but not output.

Mathematica understands +, but does not use it by default for output.

X +y

X

y

Many of the forms of input discussed here use special characters, but otherwise just consist of
ordinary one-dimensional lines of text. Mathematica notebooks, however, also make it possible

to use two-dimensional forms of input.
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two-dimensional

one-dimensional

x¥ x%y power

= x/y division

\/? Sqrt [x] square root

Vx x™ (1/n) n" root

ZZ(ZM f Sum [fr {lr imin ’ imax} ] sum

Hi'l‘;fmnf Product [ f {i,iminsimax} ] product

[fdx Integrate[f,x] indefinite integral
fxx'f’”‘“f dx Integrate [f, {X, Xminr Xmax } | definite integral

o f D[f,x] partial derivative
Oy f D[f,x,y] multivariate partial derivative
z Conjugate [x] complex conjugate
m Transpose [m] transpose

m' ConjugateTranspose [m] conjugate transpose
expriii Part [expr,i,j,...] part extraction

Some two-dimensional forms that can be used in Mathematica notebooks.

You can enter two-dimensional forms using any of the mechanisms discussed in "Entering Two-
Dimensional Input". Note that upper and lower limits for sums and products must be entered as
overscripts and underscripts—not superscripts and subscripts.

This enters an indefinite integral. Note the use of Escdd Esc to enter the “differential d”.

Escint Esc f[x] EscddEsc x

Jf [x] dx

Here is an indefinite integral that can be explicitly evaluated.

jExp[—xz] dx

1
— 7 Erfx]
2
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Here is the usual Mathematica input for this integral.

Integrate[Exp[-x " 2], x]

%\/7 Erf [x]
short form long form
Esc sum Esc \ [Sum] summation sign ),
Escprod Esc \ [Product] product sign ]
Escint Esc \ [Integral] integral sign f
Escdd Esc \ [DifferentialD] special d for use in integrals
Escpd Esc \ [PartialD] partial derivative operator 9
EsccoEsc \ [Conjugate] conjugate symbol *
Esctr Esc \ [Transpose] transpose symbol "
Escct Esc \ [ConjugateTranspose] conjugate transpose symbol *
Esc [ [ Esc \ [LeftDoubleBracket] part brackets

Some special characters used in entering formulas. "Mathematical and Other Notation" gives a complete
list.

You should realize that even though a summation sign can look almost identical to a capital
sigma it is treated in a very different way by Mathematica. The point is that a sigma is just a

letter; but a summation sign is an operator which tells Mathematica to perform a sum operation.

Capital sigma is just a letter.
a+x"2

a+x?

A summation sign, on the other hand, is an operator.
EscsumEsc Ctrl++ n=0 Ctrl+% m Ctrl+Space 1/f[n]

>

n=0

1

f[n]

Much as Mathematica distinguishes between a summation sign and a capital sigma, it also
distinguishes between an ordinary d, the “partial d” o that is used for taking derivatives, and

the special “differential d” 4 that is used in the standard notation for integrals. It is crucial that
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you use the differential d—entered as Escdd Esc—when you type in an integral. If you try to use
an ordinary d, Mathematica will just interpret this as a symbol called d—it will not understand

that you are entering the second part of an integration operator.

This computes the derivative of x".
Oy x"

n x71+n

Here is the same derivative specified in ordinary one-dimensional form.
D[x"n, x]

n X71+n

This computes the third derivative.
6x,x,x xn

(-2+n) (-1 +n) nx>7D

Here is the equivalent one-dimensional input form.
D[x"n, x, X, X]

(-2+n) (-1+n) nx>7"

Entering Tables and Matrices

The Mathematica front end provides an Insert » Table/Matrix submenu for creating and
editing arrays with any specified number of rows and columns. Once you have such an array,

you can edit it to fill in whatever elements you want.

Mathematica treats an array like this as a matrix represented by a list of lists.

a b c
12 3
{{a, b, ¢}, {1, 2, 3}}

Putting parentheses around the array makes it look more like a matrix, but does not affect its
interpretation.

(abc)
1 2 3

{{a, b, ¢}, {1, 2, 3}}
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Using MatrixForm tells Mathematica to display the result of the Transpose as a matrix.

MatrixForm[TranSPOSe [ ( 2be ) ”

12 3

al

b 2

c 3
Ctrl+, add a column
Ctrl+Enter add a row
Tab go to the next o or m element
Ctrl+Space move out of the table or matrix

Entering tables and matrices.

Note that you can use Ctrl+, and Ctrl+Enter to start building up an array, and particularly for
small arrays this is often more convenient than using the New menu item in the Table/Matrix
submenu. The Table/Matrix menu items typically allow you to make basic adjustments, such

as drawing lines between rows or columns.

Entering a Piecewise expression is a special case of entering a table.

Enter the \ [Piecewise] character and press Ctrl+, to get a template of placeholders for two
cases.

O a

flx_] :={

o O

Fill in the placeholders to complete the piecewise expression.

0 x<0

flx_] =={1 x=0

To add additional cases, use Ctrl+Enter.

0 x<0
flx ] :=[1 x=0

O O

You can make an element in a table span over multiple rows or columns by selecting the entire
block that you want the element to span and using the Insert » Table/Matrix » Make Span-
ning menu command. To split a spanning element into individual components, use Insert »

Table/Matrix » Split Spanning.
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To make the top element span across both columns, first select the row.

Yy 2

Now use the Make Spanning menu command.

X
Y 2

Subscripts, Bars and Other Modifiers

Here is a typical palette of modifiers.

» Calculatar

Basic Math Assistant

» Basic Commands

v Typesetting

u” oo 8

o

- (=)

Indn

X

o go
3

(o o)
(o)

o0

P odo

=

¥
N
R
i @

» Help and Settings

Mathematica allows you to use any expression as a subscript.

Expand [ (1 + X1.n) *]

2 3 4
1+4%,,+6x7,,+4x], +X],,
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Unless you specifically tell it otherwise, Mathematica will interpret a superscript as a power.
Factor [x; - 1]

(-1 +%n) (1+ %) (1 + xg)

Ctrl+_ or Ctrl+- go to the position for a subscript
Ctrl++ or Ctrl+= go to the position underneath
Ctrl+~ or Ctrl+6 go to the position for a superscript
Ctrl+& or Ctrl+7 go to the position on top
Ctrl+Space return from a special position

Special input forms based on control characters. The second forms given should work on any keyboard.

This enters a subscript using control keys.
Expand[ (1 + xCtrl+_ 1+n Ctrl+Space)"4]

2 3 4
1+4X,n+6X],,+4X, +X],,

Just as Ctrl+~ and Ctrl+_ go to superscript and subscript positions, so also Ctrl+& and Ctrl+=
can be used to go to positions directly above and below. With the layout of a standard English-
language keyboard Ctrl+& is directly to the right of Ctrl+~ while Ctrl+= is directly to the right
of Ctrl+_.

key sequence displayed form expression form
x Ctrl+& _ x OverBar [x]

x Ctrl+& Escvec Esc X OverVector [x]
x Ctrl+& ~ X OverTilde [x]
x Ctrl+& ~ x OverHat [x]

x Ctrl+& . X OverDot [x]

x Ctrl+= _ X UnderBar [x]

Ways to enter some common modifiers using control keys.

Here is x.

x Ctrl+& _ Ctrl+Space

x

You can use x as a variable.
Solve[a”2 == %, a]

(o=} fanilx )
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Non-English Characters and Keyboards

If you enter text in languages other than English, you will typically need to use various addi-
tional accented and other characters. If your computer system is set up in an appropriate way,
then you will be able to enter such characters directly using standard keys on your keyboard.

But however your system is set up, Mathematica always provides a uniform way to handle such

characters.

full name alias full name alias
& \ [AGrave] :a”: @\ [0Slash] :0/:
& \ [ARing] :ao: O \ [ODoubleDot] 0"
& \ [ADoubleDot] :@a'": U \ [UGrave] sut:
¢ \ [CCedilla] :c,: U \ [UDoubleDot] u "
¢ \ [CHacek] :ev: B\ [sz] :s2:, :SS:
€ \ [EAcute] ': A\ [capitalARing] :Ao:
e \ [EGrave] e’ A\ [CapitalADoubleDot] :A":
i\ [IAcute] :1': § \ [CapitalODoubleDot] :0":
rrl \ [NTilde] - U \ [CcapitalUDoubleDot] U ":
O \ [OGrave] T

Some common European characters.

Here is a function whose name involves an accented character.
Lamé[x, y]

Lamé [x, y]

This is another way to enter the same input.
Lam:e ':[x, Y]

Lamé [x, Y]

You should realize that there is no uniform standard for computer keyboards around the world,
and as a result it is inevitable that some details of what has been said in this tutorial may not
apply to your keyboard.



48 | Notebooks and Documents

In particular, the identification for example of Ctrl+6 with Ctrl+~ is valid only for keyboards on
which ~ appears as Shift+6. On other keyboards, Mathematica uses Ctrl+6 to go to a super-

script position, but not necessarily Ctri+~.

Regardless of how your keyboard is set up you can always use palettes or menu items to set up
superscripts and other kinds of notation. And assuming you have some way to enter characters
such as \, you can always give input using full names such as \[Infinity].

Other Mathematical Notation

Mathematica supports an extremely wide range of mathematical notation, although often it
does not assign a pre-defined meaning to it. Thus, for example, you can enter an expression
such as x @ y, but Mathematica will not initially make any assumption about what you mean by

D.

Mathematica knows that @ is an operator, but it does not initially assign any specific meaning to
it.

{17 ® 5, 8 ® 3}

{1765, 883}

This gives Mathematica a definition for what the @ operator does.
X_@®y_:=Mod[x+y, 2]

Now Mathematica can evaluate @ operations.
{17 ® 5, 8 ® 3}
{0, 1}
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full name alias full name alias

® \[CirclePlus] :c+: — \[LongRightArrow] im—>:
® \[CircleTimes] HoLE <> \[LeftRightArrow] <>z
+ \[PlusMinus] +: T \ [UpArrow]
~  \[Wedge] B8 = \[Equilibrium] zequi:
v \[Vee] v +  \[RightTee]
~ \[TildeEqual] ~=: 5 \ [Superset] :sup:
~ \[TildeTilde] =% ﬂ \ [SquareIntersection]
=\ [EeR] - € \ [Element] zelem:
= \[Proportional] “PrOP: 3 \ [NotElement] :lelem:
= \[Congruent] == . \[SmallCircle] s
> \[GreaterTilde] >~: \ [Therefore]
> \[GreaterGreater] .

| \ [VerticalSeparator] HE
> \[Succeeds]
S RlilghtTr iangle] | \ [VerticalBar] = |:

\ \ [Backslash] A\:

A few of the operators whose input is supported by Mathematica.

Mathematica assigns built-in meanings to = and =, but not to = or ».
{3 24,3 >4,3 24,3 >» 4}

{False, False, 324, 3>»4}

There are some forms which look like characters on a standard keyboard, but which are inter-
preted in a different way by Mathematica. Thus, for example, \[Backslash] or : \ : displays as \

but is not interpreted in the same way as a \ typed directly on the keyboard.

The \ and ~ characters used here are different from the \ and * you would type directly on a
keyboard.

{a :\: b, a :": b}
{a\b, arb}

Most operators work like @ and go in between their operands. But some operators can go in
other places. Thus, for example, : < : and : > : or \[LeftAngleBracket] and \[RightAngleBracket]

are effectively operators which go around their operand.

The elements of the angle bracket operator go around their operand.
(l+x)
(1+x)
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full name alias full name alias
¢  \[ScriptL] :scl: A \[Angstrom] :Ang:
& \[ScriptCapitalE] :scE:  h \[HBar] :hb:
R \[GothicCapitalR] :goR: £ \[Sterling]
Z \[DoubleStruckCapitalZ] :dsz: L \[Angle]
X \[Aleph] :al: e \[Bullet] bu:
¢® \[EmptySet] :es: t+ \[Dagger] :dg:
y  \[Micro] mmi: § \[Natural]

Some additional letters and letter-like forms.

You can use letters and letter-like forms anywhere in symbol nhames.
{R@, LABC}

{R®, LABC}

@ is assumed to be a symbol, and so is just multiplied by a and b.
agb
abg

Forms of Input and Output

Here is one way to enter a particular expression.

x"2+8qrt[y]

Xy

Here is another way to enter the same expression.
Plus[Power[x, 2], Sqrt[y]]

@y

With a notebook front end, you can also enter the expression directly in this way.
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Mathematica allows you to output expressions in many different ways.

In Mathematica notebooks, expressions are by default output in StandardForm.

X" 2 +8Sqrt[y]

N

OutputForm uses only ordinary keyboard characters and is the default for text-based
interfaces to Mathematica.

OutputForm[x "2 + Sqrt[y]]

2
X + Sqgrt[y]

InputForm yields a form that can be typed directly on a keyboard.
InputForm[x "2 + Sqrt[y]]

x"2 + Sqrt[y]

FullForm shows the internal form of an expression in explicit functional notation.
FullForm[x "2 + Sqrt[y]]

Plus [Power [x, 2], Power|[y, Rational[l, 2]]]

FullForm [expr] the internal form of an expression

InputForm [expr] a form suitable for direct keyboard input

OutputForm [expr] a two-dimensional form using only keyboard characters
StandardForm [expr] the default form used in Mathematica notebooks

Some output forms for expressions.

Output forms provide textual representations of Mathematica expressions. In some cases these
textual representations are also suitable for input to Mathematica. But in other cases they are
intended just to be looked at, or to be exported to other programs, rather than to be used as
input to Mathematica.

TraditionalForm uses a large collection of ad hoc rules to produce an approximation to
traditional mathematical notation.

TraditionalForm[x"~2 + Sqrt[y] + Gamma[z] EllipticK[z]]

P +KQT@+y
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TeXForm yields output suitable for export to TeX.
TeXForm[x "2 + Sqrt[y]]

x"2+\sqrt{y}

MathMLForm yields output in MathML.
MathMLForm[x "2 + Sqrt[y]]

<math>
<mrow>
<msup>
<mi>x</mi>
<mn>2</mn>
</msup>
<mo>+</mo>
<msqgrt>
<mi>y</mi>
</msqrt>
</mrow>
</math>

CForm yields output that can be included in a C program. Macros for objects like Power are
included in the header file mdefs.h.

CForm[x "2 + Sqrt[y]]

Power(x,2) + Sqrt(y)

FortranForm yields output suitable for export to Fortran.

FortranForm[x "2 + Sqrt[y]]

X**2 + Sqrt(y)

TraditionalForm [expr] traditional mathematical notation

TeXForm [expr] output suitable for export to TgX

MathMLForm [expr] output suitable for use with MathML on the web
CForm [expr] output suitable for export to C

FortranForm [expr] output suitable for export to Fortran

Output forms not normally used for Mathematica input.

"Low-Level Input and Output Rules" discusses how you can create your own output forms. You
should realize however that in communicating with external programs it is often better to use
MathLink to send expressions directly than to generate a textual representation for these expres-

sions.
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m Exchange textual representations of expressions.

= Exchange expressions directly via MathLink.

Two ways to communicate between Mathematica and other programs.

Mixing Text and Formulas

The simplest way to mix text and formulas in a Mathematica notebook is to put each kind of
material in a separate cell. Sometimes, however, you may want to embed a formula within a

cell of text, or vice versa.

Ctrl+( or Ctrl+9 begin entering a formula within text, or text within a
formula
Ctrl+) or Ctrl+0 end entering a formula within text, or text within a formula

Entering a formula within text, or vice versa.

Here is a notebook with formulas embedded in a text cell.

x=-1
log (x%ixil | 3 | 1o i ) .
p =29 ‘x . The formulas flow with text.

3 1

Mathematica notebooks often contain both formulas that are intended for actual evaluation by

Mathematica, and ones that are intended just to be read in a more passive way.

When you insert a formula in text, you can use the Convert to StandardForm and Convert
to TraditionalForm menu items within the formula to convert it to StandardForm or
TraditionalForm. StandardForm is normally appropriate whenever the formula is thought of
as a Mathematica program fragment.

In general, however, you can use exactly the same mechanisms for entering formulas, whether

or not they will ultimately be given as Mathematica input.
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You should realize, however, that to make the detailed typography of typical formulas look as
good as possible, Mathematica automatically does things such as inserting spaces around
certain operators. But these kinds of adjustments can potentially be inappropriate if you use
notation in very different ways from the ones Mathematica is expecting. In such cases, you may
have to make detailed typographical adjustments by hand.

Displaying and Printing Mathematica Notebooks

Depending on the purpose for which you are using a Mathematica notebook, you may want to
change its overall appearance. The front end allows you to specify independently the styles to
be used for display on the screen and for printing. Typically you can do this by choosing appropri
ate items in the Format menu.

ScreenStyleEnvironment styles to be used for screen display
PrintingStyleEnvironment styles to be used for printed output

Working standard style definitions for screen display
Presentation style definitions for presentations

SlideShow style definitions for displaying presentation slides
Printout style definitions for printed output

Front end settings that define the global appearance of a notebook.

Here is a typical notebook as it appears in working form on the screen.

= A Symbolic Sum 1]

Here is the input: ]

m
2w
(n+5) (n+8)2
n=0
Here is the output: i

[~91 086576 - 40839986 m- 6053061 m* ~ 296641 m" 4
98TH 400 70 + 4292400mn? + 617 400 m* 7 4 29400 m” 1)

1
(529200 (6+m) (T+m) (8+m)) 4 PolyGamma|l, 9 +m]
3
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Here is a preview of how the notebook would appear when printed out.

= A Symbolic Sum

Here 13 the impul:

Here 13 the cutput:
91 0A6576 - 40 B39 986 m - 6053061 =" - 296 641m’ + 9BTE 400 #° + 4292 400 =

617 400 = 7 + 29400 & o7 529200 {6 +m) {T+m) {B+m - PolyGamma[l, 9 +=

Mﬂ
|
e
_'{'l
-
o

=

[T B Y R Ty WY R

Setting Up Hyperlinks

Insert » Hyperlink menu item to make the selected object a hyperlink

Hyperlink [ "uri"] generate as output a hyperlink with the label and destina-
tion set as uri

Hyperlink [ "label" , "uri"] generate as output a hyperlink with the label label and the
destination uri

Hyperlink [ { " file .nb" ,None” generate as output a hyperlink to the specified notebook

Hyperlink [ {" file.nb", "tag"}] generate as output a hyperlink to the cell tagged as rag in

the specified notebook

Methods for generating hyperlinks.

A hyperlink is a special kind of button which jumps to another part of a notebook when it is
pressed. Typically hyperlinks are indicated in Mathematica by blue text.

To set up a hyperlink, just select the text or other object that you want to be a hyperlink. Then
choose the menu item Insert » Hyperlink and fill in the specification of where you want the

destination of the hyperlink to be.

The destination of a hyperlink can be any standard web address (URI). Hyperlinks can also
point to notebooks on the local file system, or even to specific cells inside those notebooks.
Hyperlinks which point to specific cells in notebooks use cell tags to identify the cells. If a particu-
lar cell tag is used for more than one cell in a given notebook, then the hyperlink will go to the

first instance of a cell with that cell tag.
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A hyperlink can be generated in output by using the Mathematica command Hyperlink. These
hyperlinks can be copied and pasted into text or used in a larger interface being generated by
Mathematica.

This command generates a hyperlink to the web.

Hyperlink["Wolfram Research, Inc.", "http://www.wolfram.com"]

Wolfram Research, Inc.

Automatic Numbering

m Choose a cell style such as DisplayFormulaNumbered.

= Use the Insert » Automatic Numbering menu item, with a counter name such as Section

Two ways to set up automatic numbering in a Mathematica notebook.

Using the DisplayFormulaNumbered style

These cells are in DisplayFormulaNumbered style. DisplayFormulaNumbered style is
available in stylesheets such as "Report".

b4
‘ dx 1) j
x+1
Sin|x] j
‘ ax (2
X+l
Log|[x] + EXp[x
‘ g[x] PIX] v - j
X+1

Using the AutomaticNumbering menu item

The input for each cell here is exactly the same, but the cells contain an element that displays
as a progressively larger number as one goes through the notebook.

® 1. A Section ]
= 2. A Section ]
= 3. A Section ]
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Exposition in Mathematica Notebooks

Mathematica notebooks provide the basic technology that you need to be able to create a very
wide range of sophisticated interactive documents. But to get the best out of this technology

you need to develop an appropriate style of exposition.

Many people at first tend to use Mathematica notebooks either as simple worksheets containing
a sequence of input and output lines, or as onscreen versions of traditional books and other
printed material. But the most effective and productive uses of Mathematica notebooks tend to
lie at neither one of these extremes, and instead typically involve a fine-grained mixing of
Mathematica input and output with explanatory text. In most cases the single most important

factor in obtaining such fine-grained mixing is uniform use of the Mathematica language.

One might think that there would tend to be four kinds of material in a Mathematica notebook:
plain text, mathematical formulas, computer code, and interactive interfaces. But one of the
key ideas of Mathematica is to provide a single language that offers the best of both traditional

mathematical formulas and computer code.

In standardForm, Mathematica expressions have the same kind of compactness and elegance
as traditional mathematical formulas. But unlike such formulas, Mathematica expressions are
set up in a completely consistent and uniform way. As a result, if you use Mathematica expres-
sions, then regardless of your subject matter, you never have to go back and reexplain your
basic notation: it is always just the notation of the Mathematica language. In addition, if you
set up your explanations in terms of Mathematica expressions, then a reader of your notebook
can immediately take what you have given, and actually execute it as Mathematica input.

If one has spent many years working with traditional mathematical notation, then it takes a
little time to get used to seeing mathematical facts presented as standardForm Mathematica
expressions. Indeed, at first one often has a tendency to try to use TraditionalForm whenever
possible, perhaps with hidden tags to indicate its interpretation. But quite soon one tends to
evolve to a mixture of SstandardForm and TraditionalForm. And in the end it becomes clear

that standardForm alone is for most purposes the most effective form of presentation.

In traditional mathematical exposition, there are many tricks for replacing chunks of text by

fragments of formulas. In standardForm many of these same tricks can be used. But the fact



58 | Notebooks and Documents

that Mathematica expressions can represent not only mathematical objects but also procedures,
algorithms, graphics, and interfaces increases greatly the extent to which chunks of text can be

replaced by shorter and more precise material.

Named Characters

Mathematica provides systemwide support for a large number of special characters. Each charac-
ter has a name and a number of shortcut aliases. They are fully supported by the standard

Mathematica fonts.

Interpretation of Characters

The interpretations given here are those used in StandardForm and InputForm. Most of the

interpretations also work in TraditionalForm.

You can override the interpretations by giving your own rules for MakeExpression.

Letters and letter-like forms used in symbol names

Infix operators e.g. x®y

Prefix operators e.g. -x

Postfix operators e.g. x!

Matchfix operators e.g. (x)

Compound operators e.q. [fdx

Raw operators operator characters that can be typed on an ordinary
keyboard

Spacing characters interpreted in the same way as an ordinary space

Structural elements characters used to specify structure; usually ignored in

interpretation

Uninterpretable elements characters indicating missing information
Types of characters.

The precedences of operators are given in "Operator Input Forms".

Infix operators for which no grouping is specified in the listing are interpreted so that for exam-

ple xé&y®z becomes CirclePlus [x, y, z].
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Naming Conventions

Characters that correspond to built-in Mathematica functions typically have names correspond-

ing to those functions. Other characters typically have hames that are as generic as possible.

Characters with different names almost always look at least slightly different.

\ [Capital...] uppercase form of a letter

\ [Left...] and \[Right...] pieces of a matchfix operator (also arrows)

\ [Raw...] a printable ASCII character

\[...Indicator] a visual representation of a keyboard character

Some special classes of characters.

style Script, Gothic, etc.
variation Curly, Gray, etc.

case Capital, etc.

modifiers Not, Double, Nested, etc.
direction Left, Up, UpperRight, etc.
base A, Epsilon, Plus, etc.
diacritical mark Acute, Ring, etc.

Typical ordering of elements in character names.

Aliases

Mathematica supports both its own system of aliases, as well as aliases based on character
names in TeX and SGML or HTML. Except where they conflict, character names corresponding
to plain TeX, LaTeX and AMSTeX are all supported. Note that TeX and SGML or HTML aliases

are not given explicitly in the list of characters below.

Esc xxx Esc ordinary Mathematica alias
Esc \xxx Esc TeX alias
Esc & xxx Esc SGML or HTML alias

Types of aliases.
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The following general conventions are used for all aliases:

Characters that are alternatives to standard keyboard operators use these operators as
their aliases (e.g. Esc -> Esc for —, Esc && Esc for A).

Most single-letter aliases stand for Greek letters.
Capital-letter characters have aliases beginning with capital letters.

When there is ambiguity in the assignment of aliases, a space is inserted at the beginning
of the alias for the less common character (e.g. Esc ->Esc for \ [Rule] and Esc_-> Esc for \
[RightArrow]).

! is inserted at the beginning of the alias for a Not character.
TeX aliases begin with a backslash \.
SGML aliases begin with an ampersand &.

User-defined aliases conventionally begin with a dot or comma.

Font Matching

The special fonts provided with Mathematica include all the characters given in this listing.

Some of these characters also appear in certain ordinary text fonts.

When rendering text in a particular font, the Mathematica notebook front end will use all the

characters available in that font. It will use the special Mathematica fonts only for other charac-

ters.

A choice is made between Times-like, Helvetica-like (sans serif) and Courier-like (monospaced)

variants to achieve the best matching with the ordinary text font in use.
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Textual Input and Output

How Input and Output Work

Input convert from a textual form to an expression
Processing do computations on the expression
Output convert the resulting expression to textual form

Steps in the operation of Mathematica.

When you type something like x "2 what Mathematica at first sees is just the string of charac-
ters x, ~, 2. But with the usual way that Mathematica is set up, it immediately knows to convert

this string of characters into the expression Power [x, 2].

Then, after whatever processing is possible has been done, Mathematica takes the expression

Power [x, 2] and converts it into some kind of textual representation for output.

Mathematica reads the string of characters x, *, 2 and converts it to the expression
Power [x, 2].
x"2

XZ

This shows the expression in Fortran form.
FortranForm[%]

X**2

FortranForm is just a “wrapper”: the value of Out [2] is still the expression Power [x, 2].
%

XZ

It is important to understand that in a typical Mathematica session In[n] and out[n] record
only the underlying expressions that are processed, not the textual representations that happen

to be used for their input or output.
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If you explicitly request a particular kind of output, say by using TraditionalForm[expr], then
what you get will be labeled with out [n] // TraditionalForm. This indicates that what you are

seeing is expr // TraditionalForm, even though the value of out [n] itself is just expr.

Mathematica also allows you to specify globally that you want output to be displayed in a particu-
lar form. And if you do this, then the form will no longer be indicated explicitly in the label for
each line. But it is still the case that In[n] and out [n] will record only underlying expressions,

not the textual representations used for their input and output.

This sets t to be an expression with FortranForm explicitly wrapped around it.
t = FortranForm[x "2 +y" 2]

XK**2 4 yH*2

The result on the previous line is just the expression.

But t contains the FortranForm wrapper, and so is displayed in FortranForm.
t

X**¥2 + y**2

Wherever t appears, it is formatted in FortranForm.
{t*2,1/¢}
1

{x**Z + ¥ xx 27, 44444444447}
X**x 2 + Y*x2

The Representation of Textual Forms

Like everything else in Mathematica the textual forms of expressions can themselves be repre-
sented as expressions. Textual forms that consist of one-dimensional sequences of characters
can be represented directly as ordinary Mathematica strings. Textual forms that involve sub-
scripts, superscripts and other two-dimensional constructs, however, can be represented by

nested collections of two-dimensional boxes.
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One-dimensional strings InputForm, FullForm, etc.

Two-dimensional boxes StandardForm, TraditionalForm, etc.

Typical representations of textual forms.

This generates the string corresponding to the textual representation of the expression in
InputForm.

ToString[x"2 +y" 3, InputForm]
X2 + y"3

FullForm shows the string explicitly.
FullForm[%]

"x*2 4 yh3"

Here are the individual characters in the string.
Characters[%]

(x, v 2, v 4y Y0 "0 3}

Here is the box structure corresponding to the expression in StandardForm.
ToBoxes[x"2 +y" 3, StandardForm]

RowBox [ {SuperscriptBox[x, 2], +, SuperscriptBox[y, 3]}]

Here is the InputForm of the box structure. In this form the structure is effectively repre-
sented by an ordinary string.

ToBoxes[x"2 +y”~ 3, StandardForm] // InputForm
\(x\"2 + y\"3\)

If you use the notebook front end for Mathematica, then you can see the expression that corre-

sponds to the textual form of each cell by using the Show Expression menu item.

Here is a cell containing an expression in StandardForm.

Log[1+x2] )
- ¢+ Log [x] - —————
2(1+x2) 2
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Here is the underlying representation of that expression in terms of boxes, displayed using the
Show Expression menu item.

Cell [BoxData| 3
RowBox |
FractionBox["1",
RowBox|[["2",
RowBox[{" (",
RowBox|[{"1", "+",
SuperscriptBox["x", "Z7]}1, ")"F]i 11, T4,
RowBox[{"Log”, "[", "x", "1"}1, "-",
FractionBox|
RowBox [{"Log", "[",
RowBox[["17, "+",
SuperscriptBox|["x", "Z"]}1, "1"}], "2"]}11, "Input”] ]
ToString [expr, form] create a string representing the specified textual form of
expr
ToBoxes [expr, form] create a box structure representing the specified textual

form of expr

Creating strings and boxes from expressions.

The Interpretation of Textual Forms

ToExpression [input] create an expression by interpreting strings or boxes

Converting from strings or boxes to expressions.

This takes a string and interprets it as an expression.
ToExpression["2 + 3 + x/y"]

X
5+ —
y

Here is the box structure corresponding to the textual form of an expression in StandardForm.
ToBoxes[2 + x"~ 2, StandardForm]

RowBox[{2, +, SuperscriptBox[x, 2]}]

ToExpression interprets this box structure and yields the original expression again.

ToExpression[%]

2+ x?
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In any Mathematica session, Mathematica is always effectively using ToExpression to interpret

the textual form of your input as an actual expression to evaluate.

If you use the notebook front end for Mathematica, then the interpretation only takes place
when the contents of a cell are sent to the kernel, say for evaluation. This means that within a
notebook there is no need for the textual forms you set up to correspond to meaningful Mathe-
matica expressions; this is only necessary if you want to send these forms to the kernel.

FullForm explicit functional notation
InputForm one-dimensional notation
StandardForm two-dimensional notation

The hierarchy of forms for standard Mathematica input.

Here is an expression entered in FullForm.
Plus[1l, Power[x, 2]]

1+ x?

Here is the same expression entered in InputForm.
1+x"2

1+ x?

And here is the expression entered in StandardForm.

1+x2

1+x2

Built into Mathematica is a collection of standard rules for use by ToExpression in converting

textual forms to expressions.

These rules define the grammar of Mathematica. They state, for example, that x+y should be
interpreted as plus[x, y], and that x’ should be interpreted as power [x, y]. If the input you
give is in FullForm, then the rules for interpretation are very straightforward: every expression
consists just of a head followed by a sequence of elements enclosed in brackets. The rules for
InputForm are slightly more sophisticated: they allow operators such as +, =, and ->, and
understand the meaning of expressions where these operators appear between operands.
standardForm involves still more sophisticated rules, which allow operators and operands to be

arranged not just in a one-dimensional sequence, but in a full two-dimensional structure.
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Mathematica is set up so that FullForm, InputForm and StandardForm form a strict hierarchy:
anything you can enter in FullForm will also work in InputForm, and anything you can enter in

InputForm Wwill also work in StandardForm.

If you use a notebook front end for Mathematica, then you will typically want to use all the
features of standardForm. If you use a text-based interface, however, then you will typically be

able to use only features of InputForm.

When you use StandardForm in a Mathematica notebook, you can enter directly two-dimen-
sional forms such as x? or annotated graphics. But InputForm allows only one-dimensional

forms.

If you copy a standardForm expression whose interpretation can be determined without evalua-
tion, then the expression will be pasted into external applications as InputForm. Otherwise, the
text is copied in a linear form that precisely represents the two-dimensional structure using \
1\ (...\). When you paste this linear form back into a Mathematica notebook, it will automati-

cally "snap" into two-dimensional form.

ToExpression [input, form] attempt to create an expression assuming that input is
given in the specified textual form

Importing from other textual forms.

StandardForm and its subsets FullForm and InputForm provide precise ways to represent any
Mathematica expression in textual form. And given such a textual form, it is always possible to

convert it unambiguously to the expression it represents.

TraditionalForm is an example of a textual form intended primarily for output. It is possible to
take any Mathematica expression and display it in TraditionalForm. But TraditionalForm
does not have the precision of standardForm, and as a result there is in general no unambigu-
ous way to go back from a TraditionalForm representation and get the expression it

represents.

Nevertheless, ToExpression [input, TraditionalForm] takes text in TraditionalForm and

attempts to interpret it as an expression.

This takes a string and interprets it as TraditionalForm input.
ToExpression["f(6)", TraditionalForm]

£[e6]
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In SstandardForm the same string would mean a product of terms.
ToExpression["£f(6)", StandardForm]
6f

When TraditionalForm output is generated as the result of a computation, the actual collec-
tion of boxes that represent the output typically contains special Interpretation objects or
other specially tagged forms which specify how an expression can be reconstructed from the

TraditionalForm output.

The same is true of TraditionalForm that is obtained by explicit conversion from
StandardForm. But if you edit TraditionalForm extensively, or enter it from scratch, then
Mathematica will have to try to interpret it without the benefit of any additional embedded
information.

Short and Shallow Output

When you generate a very large output expression in Mathematica, you often do not want to
see the whole expression at once. Rather, you would first like to get an idea of the general

structure of the expression, and then, perhaps, go in and look at particular parts in more detail.

The functions short and shallow allow you to see “outlines” of large Mathematica expressions.

Short [expr] show a one-line outline of expr

Short [expr,n] show an n-line outline of expr

Shallow [expr] show the “top parts” of expr

Shallow [expr, {depth,length} ] show the parts of expr to the specified depth and length

Showing outlines of expressions.

This generates a long expression. If the whole expression were printed out here, it would go on
for 23 lines.

t = Expand[(1+x+y) ~12];

This gives a one-line “outline” of t. The << >> indicates the number of terms omitted.
Short[t]

1+12x+66x%+220x +495x%x% + «<81> +132xy%+66x*y®+ 12yt +12xy!t +y??
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When Mathematica generates output in a textual format such as outputForm, it first effectively
writes the output in one long row. Then it looks at the width of text you have asked for, and it
chops the row of output into a sequence of separate “lines”. Each of the “lines” may of course
contain superscripts and built-up fractions, and so may take up more than one actual line on
your output device. When you specify a particular number of lines in short, Mathematica takes
this to be the number of “logical lines” that you want, not the number of actual physical lines on

your particular output device.

Here is a four-line version of t. More terms are shown in this case.
Short[t, 4]

1+12x+66x%+220x>+495x*+792x%+924x%+792x7 +495x%+220x%°+66x+
12xM + x4+ 12y+132xy+ <«<61> +495y% + 1980 xy® + 2970 x? y® + 1980 x® y® + 495 x* y® +
220y° + 660xy° + 660x%y° +220x°y® + 66y +132xy0 +66x%y®+ 12yt + 12 xy!t 4+ yt?

Short works in other formats too, such as standardForm and TraditionalForm. When using
these formats, linewrapping is determined by the notebook interface when displaying the out-
put rather than by the kernel when creating the output. As a result, setting the number of lines

generated by short can only approximate the actual number of lines displayed onscreen.

You can use Short with other output forms, such as InputForm.
Short [InputForm[t]]

1 + 12xX + 66%x"2 + 220%xX"3 + 495xx"4 + <<83>> + 12xy"11 + 12xxxy"11 + y"12

Short works by removing a sequence of parts from an expression until the output form of the
result fits on the number of lines you specify. Sometimes, however, you may find it better to
specify not how many final output lines you want, but which parts of the expression to drop.
Shallow [expr, {depth, length}] includes only length arguments to any function, and drops all
subexpressions that are below the specified depth.

Shallow shows a different outline of t.
Shallow[t]

1+12x+66Power|[<<2>] + 220 Power [ <<2>>] + 495 Power [ <<2>>] + 792 Power [ <<2>>] +
924 Power [ <<2>>] + 792 Power [ <<2>>] + 495 Power [ <<2>>] + 220 Power [ <<2>>] + <<81>>

This includes only 10 arguments to each function, but allows any depth.
Shallow[t, {Infinity, 10}]

1+12x+66x%+220x>+495x" +792x%+924x%+792x7 +495%x% +220%° + «<81>
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Shallow is particularly useful when you want to drop parts in a uniform way throughout a

highly nested expression, such as a large list structure returned by Trace.

Here is the recursive definition of the Fibonacci function.
fib[n ] := fib[n-1] + £ib[n-2]; £ib[0] = fib[1] = 1
1

This generates a large list structure.
tr = Trace[fib[8]];

You can use Shallow to see an outline of the structure.
Shallow[tr]

{fib[<«<1>>], Plus[<<2>], {{«<2>}, «<l>», «<l1>, {<7>}, {<7>}, <l1>, «<l>},
{{<2>}, <1, <l>, {<7>}, {<7>}, «<l>»>, «<l=}, Plus[«<2>], 34}

Short gives you a less uniform outline, which can be more difficult to understand.
Short[tr, 4]

(£ib[8], fib[8 - 1] + fib[8 - 2], {{8 -1, 7}, £ib[7], <<3>>, 13 +8, 21}, {<1>}, 21 + 13, 34}

When generated outputs in the notebook interface are exceedingly large, Mathematica automati-
cally applies short to the output. This user interface enhancement prevents Mathematica from
spending a lot of time generating and formatting the printed output for an evaluation which

probably generated output you did not expect.

Typically, an assignment like this would have a semicolon at the end.

1st = Range[lOG]

A very large output was generated. Here is a sample of it:

{1, 2,3, 4,5,6,7,8,9, 100,11, 12, 13, 14, 15, 16, 17, 18, <<999964>,
999983, 999984, 999985, 999986, 999987, 999988, 999989, 999990, 999991,
999992, 999993, 999994, 999995, 999996, 999997, 999998, 999999, 1000000}

Show Less I Show More I Show Full Qutput I Set Size Limit...

The buttons in the user interface allow you to control how much of the output you see. The size
threshold at which this behavior takes effect is determined by the byte count of the output
expression. That byte count can be set in the Preferences dialog of the notebook interface,
which is opened by the Set Size Limit button.
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String-Oriented Output Formats

"text" a string containing arbitrary text

Text strings.

The quotes are not included in standard Mathematica output form.

"This is a string."

This is a string.

In input form, the quotes are included.

InputForm[%]

"This is a string."

You can put any kind of text into a Mathematica string. This includes non-English characters, as
well as newlines and other control information. "Strings and Characters" discusses in more

detail how strings work.

~

output a string in which successive ~~ are replaced by

successive x;

StringForm [ "cccc™ “ceee" X1, X2y -.. ]

StringForm|[ "cccc™ i cceec" ,x1,%2,...] output a string in which each ™ i~ is replaced by the

corresponding x;

Using format strings.
In many situations, you may want to generate output using a string as a “template”, but

“splicing” in various Mathematica expressions. You can do this using StringForm.

This generates output with each successive ™~ replaced by an expression.
StringForm["x = ~°, y = °°", 3, (1+u) "2]

X =3,y = (lL+u)?

You can use numbers to pick out expressions in any order.
StringForm["{~ 1", ~2°, “1°}", a, b]

{a’ b’ a}
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The string in stringForm acts somewhat like a “format directive” in the formatted output state-
ments of languages such as C and Fortran. You can determine how the expressions in

stringForm will be formatted by wrapping them with standard output format functions.

You can specify how the expressions in StringForm are formatted using standard output
format functions.

StringForm["The ~~ of ~~ is ~~.", TeXForm, a/b, TeXForm[a / b]]

a
The TeXForm of — is \frac {a} {b}.
b

You should realize that stringForm is only an output format. It does not evaluate in any way.

You can use the function Tostring to create an ordinary string from a stringForm object.

StringForm generates formatted output in standard Mathematica output form.
StringForm["Q: ~~ -> ", a, b]

Q: a -> b

In input form, you can see the actual StringForm object.
InputForm[%]

StringForm["Q: > -> ", a, b]

This creates an ordinary string from the StringForm object.
InputForm[ToString[%]]
"Q: a -> b"

SstringForm allows you to specify a “template string”, then fill in various expressions. Some-

times all you want to do is to concatenate together the output forms for a sequence of expres-
sions. You can do this using Row.

Row [ {expr, ,expry, ...}] give the output forms of the expr; concatenated together
Row [list, s] insert s between successive elements

Spacer [w] a space of w points which can be used in Row
Invisible [expr] a space determined by the physical dimensions of expr

Output of sequences of expressions.
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Row prints as a sequence of expressions concatenated together.
Row[{"[x = ", 56, "]"}]
[x = 56]

Row also works with typeset expressions.
Row[{"[y = ", Subscript[a, b], "]"}]

ly = ap]

Row can automatically insert any expression between the displayed elements.

Row[{a, b, c, d}, "e"]

a«—>b«ce—d

Spacer can be used to control the precise spacing between elements.

Row[{"x", Spacer[10], "y"}]

Xy
Column [ {expr| ,expry, ...} ] a left-aligned column of objects
Column [list, alignment] a column with a specified horizontal alignment (Left,
Center or Right)
Column [list, alignment , s a column with elements separated by s x-heights

Output of columns of expressions.

This arranges the two expressions in a column.
Column[{a+b, x"2}]

a+b

X2

give the output form of expr, with expr maintained
unevaluated

Defer [expr]
Interpretation[e,expr] give an output which displays as ¢, but evaluates as expr

Output of unevaluated expressions.

Using text strings and functions like Row, you can generate pieces of output that do not necessar-

ily correspond to valid Mathematica expressions. Sometimes, however, you want to generate
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output that corresponds to a valid Mathematica expression, but only so long as the expression
is not evaluated. The function Defer maintains its argument unevaluated, but allows it to be

formatted in the standard Mathematica output form.

Defer maintains 1 + 1 unevaluated.
Defer[1l + 1]

1+1

The Defer prevents the actual assignment from being done.
Defer[x = 3]

Xx=3

When the output of Defer is evaluated again, which might happen by modifying the output or

by using copy and paste, it will evaluate normally.

The following output was copied from the previous output cell into an input cell.
x=3

3

It is also possible to produce output whose appearance has no direct correlation to how it
evaluates by using Interpretation. This method is effectively used by Mathematica when
formatting some kinds of outputs where the most readable form does not correspond well to
the internal representation of the object. For example, Series always generates an

Interpretation object in its default output.

Although this output displays as vy, it will evaluate as x.
Interpretation[y, x]

y

Copying and pasting the previous output will reference the value earlier assigned to x.

2y
6
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Output Formats for Numbers

ScientificForm [expr] print all numbers in scientific notation

EngineeringForm [expr] print all numbers in engineering notation (exponents
divisible by 3)

AccountingForm [expr] print all numbers in standard accounting format

Output formats for numbers.

These numbers are given in the default output format. Large numbers are given in scientific
notation.

{6.7"-4,6.7"6, 6.7"8}

{0.00049625, 90458.4, 4.06068x10°}
This gives all numbers in scientific notation.
ScientificForm[%]

{4.9625x107™, 9.04584x10%, 4.06068x10°}

This gives the numbers in engineering notation, with exponents arranged to be multiples of
three.

EngineeringForm[%]

{496.25x107°%, 90.4584x10%, 4.06068x10°}

In accounting form, negative humbers are given in parentheses, and scientific notation is never
used.

AccountingForm[{5.6, -6.7, 10."7}]

(5.6, (6.7), 10000000.}

NumberForm [expr, tot] print at most rot digits of all approximate real numbers in
expr

ScientificForm [expr,tot] use scientific notation with at most ror digits

EngineeringForm [expr,tot] use engineering notation with at most ror digits

Controlling the printed precision of real numbers.



Here is 7° to 30 decimal places.

N[Pi"9, 30]

29809.0993334462116665094024012

This prints just 10 digits of n°.

NumberForm[%, 10]
29809.09933

This gives 12 digits, in engineering notation.

EngineeringForm[%, 12]

29.8090993334x10°
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option name

default value

DigitBlock
NumberSeparator
NumberPoint
NumberMultiplier
NumberSigns
NumberPadding
SignPadding

NumberFormat
ExponentFunction

Options for number formatting.

Infinity

"t

False
Automatic
Automatic

maximum length of blocks of digits
between breaks

strings to insert at breaks between blocks
of digits to the left and right of a decimal
point

string to use for a decimal point

string to use for the multiplication sign in
scientific notation

strings to use for signs of negative and
positive numbers

strings to use for padding on the left and
right

whether to insert padding after the sign
function to generate final format of number
function to determine the exponent to use

All the options in the table except the last one apply to both integers and approximate real

numbers.

All the options can be used

in any of the functions NumberForm, ScientificForm,

EngineeringForm and AccountingForm. In fact, you can in principle reproduce the behavior of

any one of these functions simply by giving appropriate option settings in one of the others.

The default option settings listed in the table are those for NumberForm.
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Setting DigitBlock -> n breaks digits into blocks of length n.
NumberForm[30!, DigitBlock -> 3]
265,252,859,812,191,058,636,308,480,000,000

You can specify any string to use as a separator between blocks of digits.
NumberForm[30!, DigitBlock -> 5, NumberSeparator -> " "]

265 25285 98121 91058 63630 84800 00000

This gives an explicit plus sign for positive numbers, and uses | in place of a decimal point.

NumberForm[{4.5, -6.8}, NumberSigns -> {"-", "+"}, NumberPoint -> "|"]

{+415, -6]8}

When Mathematica prints an approximate real number, it has to choose whether scientific
notation should be used, and if so, how many digits should appear to the left of the decimal
point. What Mathematica does is first to find out what the exponent would be if scientific nota-
tion were used, and one digit were given to the left of the decimal point. Then it takes this
exponent, and applies any function given as the setting for the option ExponentFunction. This
function should return the actual exponent to be used, or Null if scientific notation should not

be used.

The default is to use scientific notation for all numbers with exponents outside the range -5 to
3.

(8.75, 11.717, 13."9}

{32768., 1.94872x107, 1.06045x10%°}

This uses scientific notation only for numbers with exponents of 10 or more.
NumberForm[%, ExponentFunction -> (If[-10 < # < 10, Null, #] &) ]

{32768., 19487171., 1.06045x10'°}

This forces all exponents to be multiples of 3.

NumberForm[%, ExponentFunction -> (3 Quotient[#, 3] &)]

{32.768x10%, 19.4872x10°, 10.6045x10°}
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Having determined what the mantissa and exponent for a number should be, the final step is to
assemble these into the object to print. The option NumberFormat allows you to give an arbi-
trary function which specifies the print form for the number. The function takes as arguments
three strings: the mantissa, the base, and the exponent for the number. If there is no expo-

nent, it is given as "".

This gives the exponents in Fortran-like “e” format.
NumberForm[{5.6"10, 7.8"20}, NumberFormat -> (SequenceForm[#1l, "e", #3] &)]

{3.03305e7, 6.94852el7}

You can use FortranForm to print individual numbers in Fortran format.

FortranForm[7.8"20]

6.94851587086215e17/

PaddedForm [expr, tot] print with all numbers having room for ot digits, padding
with leading spaces if necessary

PaddedForm [expr, {tot, frac} ] print with all numbers having room for ot digits, with
exactly frac digits to the right of the decimal point

NumberForm [expr, {tot, frac} | print with all numbers having at most tor digits, exactly
frac of them to the right of the decimal point

Column [ {expr;,expry, ...} 1] print with the expr; left aligned in a column

Controlling the alignment of numbers in output.

Whenever you print a collection of numbers in a column or some other definite arrangement,
you typically need to be able to align the nhumbers in a definite way. Usually you want all the
numbers to be set up so that the digit corresponding to a particular power of 10 always appears

at the same position within the region used to print a number.

You can change the positions of digits in the printed form of a number by “padding” it in various
ways. You can pad on the right, typically adding zeros somewhere after the decimal. Or you can

pad on the left, typically inserting spaces in place of leading zeros.

This pads with spaces to make room for up to 7 digits in each integer.
PaddedForm|[ {456, 12345, 12}, 7]

{ 456, 12345, 12}
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This creates a column of integers.
PaddedForm[Column|[ {456, 12345, 12}], 7]

456
12345
12

This prints each number with room for a total of 7 digits, and with 4 digits to the right of the
decimal point.

pPaddedForm[{-6.7, 6.888, 6.99999}, {7, 4}]

{ -6.7000, 6.8880, 7.0000}

In NumberForm, the 7 specifies the maximum precision, but does not make Mathematica pad
with spaces.

NumberForm[{-6.7, 6.888, 6.99999}, {7, 4}]

{-6.7000, 6.8880, 7.0000}

If you set the option SignPadding -> True, Mathematica will insert leading spaces after the
sign.
PaddedForm[{-6.7, 6.888, 6.99999}, {7, 4}, SignPadding -> True]

{- 6.7000, 6.8880, 7.0000}

Only the mantissa portion is aligned when scientific notation is used.
PaddedForm[Column[{6.7 x10"8, 48.7, -2.310"-16}], {4, 2}]

6.70x108
48.70

-2.30x1071®

With the default setting for the option NumberPadding, both NumberForm and PaddedForm insert
trailing zeros when they pad a number on the right. You can use spaces for padding on both the
left and the right by setting NumberPadding -> {" ", " "}.

This uses spaces instead of zeros for padding on the right.
PaddedForm[{-6.7, 6.888, 6.99999}, {7, 4}, NumberPadding -> {" ", " "}]

{ -6.7 , 6.888 , 7. }
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BaseForm [expr,b] print with all nhumbers given in base b

Printing numbers in other bases.

This prints a number in base 2.
BaseForm|[2 342 424, 2]

1000111011111000011000,

In bases higher than 10, letters are used for the extra digits.
BaseForm[242 345341, 16]

e7le57d4

BaseForm also works with approximate real numbers.
BaseForm[2.3, 2]
10.010011001100110011,

You can even use BaseForm for numbers printed in scientific notation.
BaseForm[2.3x 1078, 2]

1.1011011010110000101,x 227

"Digits in Numbers" discusses how to enter numbers in arbitrary bases, and also how to get

lists of the digits in a number.

Tables and Matrices

Column [ /ist] typeset as a column of elements
Grid [list] typeset as a grid of elements
TableForm [ /ist] print in tabular form

Formatting lists as tables and matrices.

Here is a list.
Table[ (i +45) "j, {i, 3}, {j, 3}]
({46, 2116, 97336}, {47, 2209, 103823}, {48, 2304, 110592}}
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Grid gives the list typeset in a tabular format.
Grid[%]

46 2116 97336
47 2209 103823
48 2304 110592

TableForm displays the list in a tabular format.
TableForm[%%]

46 2116 97336
47 2209 103823
48 2304 110592

Grid and Column are wrappers which do not evaluate, but typeset their contents into appropri-

ate forms. They are typesetting constructs and require a front end to render correctly.

Column is a shorthand for a Grid with one column.

Column[Range[5]]

g o W N

The FullForm of a Grid or Column demonstrates that the head is inert.
FullForm[%]

Column[List[1, 2, 3, 4, 5]]

All of these wrappers can be used to present any kind of data, including graphical data.

Grid[{{"disk", Graphics[Disk[], ImageSize -» 25]},
{"square", Graphics[Rectangle[], ImageSize » 25]}}]

disk .
square .
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PaddedForm [Column [list] ,tot] print a column with all numbers padded to have room for
tot digits

PaddedForm [Grid [list] , tot | print a table with all numbers padded to have room for rot
digits

PaddedForm [Grid [list], {tot, frac}|  put frac digits to the right of the decimal point in all approxi:
mate real numbers

Printing tables of numbers.

Here is a list of numbers.
fac = {10!, 15!, 20!}
(3628800, 1307674368000, 2432902008176640000}

Column displays the list in a column.
Column[fac]

3628800
1307674368000
2432902008176640000

This aligns the numbers by padding each one to leave room for up to 20 digits.
PaddedForm[Column[fac], 20]

3628800
1307674368000
2432902008176640000

In this particular case, you could also align the numbers using the Alignment option.
Column|[fac, Alignment -> {Right}]

3628800
1307674368000
2432902008176640000

This lines up the numbers, padding each one to have room for 8 digits, with 5 digits to the right
of the decimal point.

PaddedForm[Column[{6.7, 6.888, 6.99999}], {8, 5}]

6.70000
6.88800
6.99999
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SpanFromLeft
SpanFromAbove

SpanFromBoth

span from the element on the left

span from the element above

span from the element above and to the left

Symbols used to represent spanning in Grid.

Grid takes a rectangular matrix as its first argument. Individual elements of the Grid can span

across multiple rows, columns, or a rectangular subgrid by specifying the areas to be spanned.

The spanning element is always specified in the upper left-hand corner of the spanning area,

and the remaining area is filled in with the appropriate spanning symbols.

This shows a spanning row, where the spanning portion is filled in using SpanFromLeft.

Grid[{{"t", SpanFromLeft, SpanFromLeft, SpanFromLeft}, {"a", "b", "¢", "d"}}]

t
a b cd

Similarly, a column can be spanned using SpanFromAbove.

Grid[{{"t", "a"},

t a
b

{SpanFromAbove,

When specifying a rectangular spanning area, SpanFromBoth is used in every element which is
both below and to the right of the spanning element.
Grid[{{"t", SpanFromLeft, "a"},

{SpanFromAbove, SpanFromBoth, "b"}, {"c", "d", "e"}}]
t a
b
c de
option default value
Background None what background colors to use
BaselinePosition Automatic what to align with a surrounding text
baseline
BaseStyle {1} base style specifications for the grid
Frame None where to draw frames in the grid
FrameStyle Automatic style to use for frames

Some options which affect the behavior of a Grid as a whole.



Notebooks and Documents | 83

The Frame option can specify a frame around the entire Grid.

Grid[{{"a", "b"}, {"e¢", "d"}}, Frame - True]

ab
c d

This uses FrameStyle to change the appearance of a frame.

Grid[{{"a", "b"}, {"¢", "d"}}, Frame -» True,
FrameStyle -» {Brown, AbsoluteThickness[5]}]

a b
c d

This uses Background to specify a background color for the entire Grid.

Grid[{{"a", "b"}, {"c¢", "d"}}, Background - Pink, Frame - True]

ab
c d

The position of a Grid relative to its surroundings can be controlled using the
BaselinePosition option.

Row[{"A matrix:", Grid[{{1l, 2}, {3, 4}}, BaselinePosition - Top]}]

A matrix:

This aligns the bottom of the grid with the baseline.

Row[{"A matrix:", Grid[{{1, 2}, {3, 4}}, BaselinePosition - Bottom]}]
12

A matrix: 3 4

This sets the base style of the entire Grid to be the Subsection style.
Grid[{{"a", "bit"}, {"of", "text"}}, BaseStyle - {"Subsection"}]

a bit
of text
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Column is a shorthand for specifying a Grid with one column. Since the two functions are simi-

lar, the same options can be used for each one.

This sets some Grid options for Column.

Column[{1l, 2, 3, 4}, Background -» Pink, Frame -» True]

1

2

3

4
option default value
Alignment {Center, horizontal and vertical alignment of items

Baseline }

Dividers None where to draw divider lines in the grid
ItemSize Automatic width and height of each item
ItemStyle None styles for columns and rows
Spacings {0.8,0.1} horizontal and vertical spacings

Some options which affect the columns and rows of a Grid.

The options for Grid which affect individual rows and columns all share a similar syntax. The

options can be specified as {x, y}, where x applies to all of the columns and y applies to all of the

rows; x and y can be single values, or they can be a list of values which represent each column

or row in turn.

With no Alignment setting, elements align to the center horizontally and on the baseline
vertically.

Grid[{{"ten", 10!}, {"twenty", 20!}}]

ten 3628800
twenty 2432902008176640000

This changes the horizontal alignment of columns to be on the right.
Grid[{{"ten", 10!}, {"twenty", 20!}}, Alignment » {Right, Baseline}]

ten 3628800
twenty 2432902008176640000

This sets the horizontal alignment of each column separately.
Grid[{{"ten", 10!}, {"twenty", 20!}}, Alignment -» {{Left, Right}, Baseline}]

ten 3628800
twenty 2432902008176640000
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When Background or ItemStyle options specify distinct settings for rows and columns, the

front end will attempt to combine the settings where the rows and columns overlap.

This shows how the green row combines with columns of various colors.

Grid[{{1, 2, 3}, {4, 5, 6}, {7, 8, 9}},
Background -» {{Orange, None, Cyan}, {None, Green, None}}]

This example shows how ItemStyle can combine styles specified in both rows and columns.
Grid[{{1, 2}, {3, 4}}, ItemStyle -» {{Red, Automatic}, {Bold, Italic}}]

To repeat an individual row or column specification over multiple rows or columns, wrap it in a
list. The repeated element will be used as often as necessary. If you wrap multiple elements in
a list, the entire list will be repeated in sequence.

The red divider is repeated.

Grid[{{1, 2, 3, 4, 5, 6}, {7, 8, 9, 10, 11, 12}},
Dividers -» {{None, {Red}, None}, None}]

12|34 |56
71891011 12

Here, red and black dividers are repeated in sequence.

Grid[{{1, 2, 3, 4, 5, 6}, {7, 8, 9, 10, 11, 12}},
Dividers -» {{None, {Red, Black}, None}, None}]

; :‘: 140‘151‘162
The ItemSize and Spacings options take their horizontal measurements in ems and their
vertical measurements in line heights based upon the current font. Both options also can take a
Scaled coordinate, where the coordinate specifies the fraction of the total cell width or window
height. The 1temSize option also allows you to request as much space as is required to fit all of
the elements in the given row or column by using the keyword Full.

This makes all of the items 3 ems wide and 1 line height tall.
Grid[{{1, 2}, {3, 4}}, Dividers - All, ItemSize - {3, 1}]

1 2
3 4
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The same example in a new font size will show at a different size.

Style[Grid[{{1, 2}, {3, 4}}, Dividers -» All, ItemSize -» {3, 1}], FontSize -» 18]

1 2
3 4

The buttons in this example will always be sized to be a quarter of the width of the cell.

Grid[{{Button["Left button"], Button["Right button"]}},
ItemSize -» {{{Scaled[0.25]}}, Full}]

Left button Right button

The first and last settings for Spacings specify one-half of the top and bottom space.
Grid[{{1, 2}, {3, 4}}, Frame -» True, Spacings -» {{1, 0, 1}, {1, 1, 1}}]

12

34

option default value

Alignment {Center, horizontal and vertical alignment of items
Baseline }

Background None what background colors to use

BaseStyle {} base style specifications for the item

Frame None where to draw frames around the item

FrameStyle Automatic style to use for frames

ItemSize Automatic width and height of each item

Some options for Item.

Many of the settings which can be applied to entire rows and columns can also be applied
individually to the elements of a Grid or Column by using the Item wrapper. Item allows you to
change these settings at the granularity of a single item. Settings which are specified at the

Item level always override settings from the Grid or Column as a whole.

This sets item-specific options for the lower left-hand element.
Grid[{{1, 2}, {Item[3, Background -» LightGreen, Frame - True], 4}}]

1 2

4
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The Background setting for Item overrides the one for the Column.

Column[{1l, 2, Item[3, Background - Pink]}, Background - Yellow]

1
2
3
Most of the options to Item take the same settings as their Grid counterparts. However, the

Alignment and ItemSize options, which allow complex row and column settings in Grid, take

only the {horizontal, vertical} setting in Item.

This specifies a larger item area and how the text should be aligned within it.

Column[{Item["Some aligned text", Frame - True,
ItemSize » {15, 3}, Alignment -» {Center, Bottom}], "caption"}]

Some aligned text

caption

The width value of the ItemSize option is used to determine line breaking.
Column[{Item[N[Pi, 20], ItemSize -» {10, 2}], "digits of pi"}]

3.141592653589793"
2385

digits of pi

The ItemSize here specifies a minimum height of 2 line heights, but the item is larger.

Column[{Item[N[Pi, 50], ItemSize -» {10, 2}], "digits of pi"}]

3.141592653589793-
238462643383279"
502884197169399-
3751

digits of pi

Formatting Higher-Dimensional Data

Column supports one-dimensional data, and Grid supports two-dimensional data. To print

arrays with an arbitrary number of dimensions, you can use TableForm.

Here is the format for a 2x2 array of elements a[i, j].
TableForm[Array[a, {2, 2}]]

a[l, 1] a[l, 2]
a[2, 1] a[2, 2]
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Here is a 2x2x2 array.
TableForm[ {Array[a, {2, 2}], Array[b, {2, 2}]}]
a[l, 1] a[2, 1]
all, 2] a[2, 2]
1
1

b(l, 1] b[2, 1
b1, 2] b[2, 2

And here is a 2x2x2x2 array.

TableForm|[
{{Array[a, {2, 2}], Array[b, {2, 2}]}, {Array[c, {2, 2}], Array[d, {2, 2}]}}]

a[l, 1] a[l, 2] b[l, 1] b[l, 2

]
af2, 1] a[2, 2] b[2, 1] b[2, 2]
c(l, 1] e[1, 2] 4d[1, 1] d[1, 2]
cl2, 1] ¢[2, 2] d[2, 1] d[2, 2]

In general, when you print an n-dimensional table, successive dimensions are alternately given
as columns and rows. By setting the option TableDirections -> {dir, dir,, ...}, Where the dir;
are Column Or Row, yYou can specify explicitly which way each dimension should be given. By

default, the option is effectively set to {Column, Row, Column, Row, ...}.

The option TableDirections allows you to specify explicitly how each dimension in a multidi-
mensional table should be given.

TableForm[ {Array[a, {2, 2}], Array[b, {2, 2}]},
TableDirections -> {Row, Row, Column}]

a[l, 1] a[2, 1] b[l, 1] b[2, 1]
a[l, 2] a[2, 2] b[l, 2] b[2, 2]

TableForm can handle arbitrary “ragged” arrays. It leaves blanks wherever there are no ele-

ments supplied.

TableForm can handle “ragged” arrays.
TableForm[{{a, a, a}, {b, b}}]

You can include objects that behave as “subtables”.
TableForm[{{a, {{p, 4}, {r, s}}, a, a}, {{x, vy}, b, b}}]

a p g a a
r s

b4
v b b
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You can control the number of levels in a nested list to which TableForm goes by setting the
option TableDepth.

This tells TableForm only to go down to depth 2. As a result {x, y} is treated as a single table
entry.

TableForm[{{a, {x, y}}, {c, d}}, TableDepth -> 2]

a {x, vy}
c d
option name default value
TableDepth Infinity maximum number of levels to include in
the table
TableDirections {Column,Row, whether to arrange dimensions as rows or
Column,...} columns
TableAlignments {Left,Bottom, how to align the entries in each dimension
Left, }
TableSpacing {1,3,0,1,0,...} how many spaces to put between entries in
each dimension
TableHeadings {None,None,...}  how to label the entries in each dimension

Options for TableForm.

With the option TableAlignments, you can specify how each entry in the table should be
aligned with its row or column. For columns, you can specify Left, Center or Right. For rows,
you can specify Bottom, Center or Top. If you set TableAlignments -> Center, all entries will
be centered both horizontally and vertically. TableAlignments -> Automatic uses the default
choice of alignments.

Entries in columns are by default aligned on the left.
TableForm[ {a, bbbb, ccccccece}l]

a
bbbb
ccceceecc

This centers all entries.
TableForm[{a, bbbb, cccccccc}, TableAlignments -> Center]

a
bbbb
cccecececce
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You can use the option TableSpacing to specify how much horizontal space there should be
between successive columns, or how much vertical space there should be between successive
rows. A setting of 0 specifies that successive objects should abut.

This leaves 6 spaces between the entries in each row, and no space between successive rows.
TableForm[{{a, b}, {ccc, d}}, TableSpacing -> {0, 6}]

a b

ccc d
None no labels in any dimension
Automatic successive integer labels in each dimension
{{laby, ,labyy,...},...} explicit labels

Settings for the option TableHeadings.

This puts integer labels in a 2x2x2 array.

TableForm[Array[a, {2, 2, 2}], TableHeadings -> Automatic]

1 2

1la[l, 1, 1] 1la[l, 2, 1]
2la[1, 1, 21 2la[l, 2, 2]
1la[2, 1, 1] 1laf2, 2, 1]
2laf2, 1, 2] 2|a[2, 2, 2]

This gives a table in which the rows are labeled by integers, and the columns by a list of strings.
TableForm[{{a, b, c}, {ap, bp, cp}},
TableHeadings -> {Automatic, {"first", "middle", "last"}}]
‘first middle last
1la b c
2 |ap bp cp

This labels the rows but not the columns. TableForm automatically drops the third label since
there is no corresponding row.
TableForm[{{2, 3, 4}, {5, 6, 1}},

TableHeadings -> {{"row a", "row b", "row c"}, None}]

row a2 3 4
row b |5 6 1
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Styles and Fonts in Output

Style [expr,options] print with the specified style options
Style [expr, "style" ] print with the specified cell style

Specifying output styles.

The second x? is here shown in boldface.
{x"~2, Style[x"2, FontWeight -> "Bold"]}

(0, 27)

This shows the word text in font sizes from 10 to 20 points.
Table[Style["text", FontSize -> s], {s, 10, 20}]

{text, text, text, text, text, text, text, text, text, text, text}

This shows the text in the Helvetica font.
Style["some text", FontFamily -> "Helvetica"]

some text

Style allows an abbreviated form of some options. For options such as FontSize, FontWeight,

FontSlant and FontColor, you can include merely the setting of the option.

Options are specified here in a short form.
Style["text", 20, Italic]

text
option typical setting(s)
FontSize 12 size of characters in printer's points
FontWeight "Plain" or "Bold" weight of characters
FontSlant "Plain" or "Italic" slant of characters
FontFamily "Courier", font family

"Times" , "Helvetica"

FontColor GrayLevel [0] color of characters
Background GrayLevel[1] background color for characters

A few options that can be used in Style.
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If you use the notebook front end for Mathematica, then each piece of output that is generated
will by default be in the style of the cell in which the output appears. By using
style [expr, "style"] however, you can tell Mathematica to output a particular expression in a

different style.

Here is an expression output in the style normally used for section headings.
Style[x"2+y”~2, "Section"]

x2 +y?

"Cells as Mathematica Expressions" describes in more detail how cell styles work. By using
style [expr, "style", options] you can generate output that is in a particular style, but with cer-

tain options modified.

Representing Textual Forms by Boxes

All textual and graphical forms in Mathematica are ultimately represented in terms of nested
collections of boxes. Typically the elements of these boxes correspond to objects that are to be

placed at definite relative positions in two dimensions.

Here are the boxes corresponding to the expression a + b.
ToBoxes[a + b]

RowBox|[{a, +, b}]

DisplayForm shows how these boxes would be displayed.
DisplayForm[%]

a+b

DisplayForm [boxes] show boxes as they would be displayed
Showing the displayed form of boxes.
This displays three strings in a row.

RowBox[{"a", "+", "b"}] // DisplayForm

a+b
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This displays one string as a subscript of another.
SubscriptBox["a", "i"] // DisplayForm

aj

This puts two subscript boxes in a row.
RowBox [ {SubscriptBox["a", "1"], SubscriptBox["b", "2"]}] // DisplayForm

a, b,

"text" literal text
RowBox [{a,b,...}] a row of boxes or strings a, b, ...
GridBox [{{ai,bi,...},{az,by,...} ,...} ]
ar b
a grid of boxes a, b,

SubscriptBox [a,b] subscript a,
SuperscriptBox[a,b] superscript a®
SubsuperscriptBox[a,b,c] subscript and superscript aj,
UnderscriptBox[a,b] underscript a
b
. . b
OverscriptBox [a,b] overscript a
UnderoverscriptBox [a,b,c] underscript and overscript a
b
FractionBox [a,b] fraction %
SqrtBox [a] square root \ a
RadicalBox [a,b] b root Va

Some basic box types.

This nests a fraction inside a radical.

RadicalBox [FractionBox[x, y], n] // DisplayForm

X

y
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This puts a superscript on a subscripted object.
SuperscriptBox[SubscriptBox[a, b], c] // DisplayForm

E

This puts both a subscript and a superscript on the same object.
SubsuperscriptBox[a, b, c] // DisplayForm

c
ap

FrameBox [box] render box with a frame drawn around it
GridBox [list,RowLines ->True | put lines between rows in a GridBox
GridBox |list,ColumnLines ->True| put lines between columns

GridBox [list,RowLines -> {True,False} ]

put a line below the first row, but not subsequent ones

Inserting frames and grid lines.

This shows a fraction with a frame drawn around it.

FrameBox [FractionBox["x", "y"]] // DisplayForm

X

y

This puts lines between rows and columns of an array.

GridBox [Table[i +j, {i, 3}, {j, 3}1,
RowLines -> True, ColumnLines -> True] // DisplayForm

2(3|4
314|5
415|6

And this also puts a frame around the outside.

FrameBox[%] // DisplayForm
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StyleBox [boxes, options ]
StyleBox [boxes, "style" ]

Modifying the appearance of boxes.

render boxes with the specified option settings

render boxes in the specified style

StyleBox takes the same options as style. The difference is that style is a high-level function

that applies to an expression to determine how it will be displayed, while styleBox is the corre-

sponding low-level function in the underlying box structure.

This shows the string "name" in italics.

StyleBox["name", FontSlant -> "Italic"] // DisplayForm

name

This shows "name" in the style used for section headings in your current notebook.

StyleBox|["name", "Section"] // DisplayForm

name

This uses section heading style, but with characters shown in gray.

StyleBox|["name", "Section", FontColor -> GrayLevel[0.5]] // DisplayForm

If you use a notebook front end for Mathematica, then you will be able to change the style and

appearance of what you see on the screen directly by using menu items. Internally, however,

these changes will still be recorded by the insertion of appropriate styleBox objects.

FormBox [ boxes, form]

InterpretationBox [boxes, expr]
TagBox [boxes , tag ]

ErrorBox [boxes]

Controlling the interpretation of boxes.

interpret boxes using rules associated with the specified
form

interpret boxes as representing the expression expr
use tag to guide the interpretation of boxes

indicate an error and do not attempt further interpretation
of boxes
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This prints as x with a superscript.

SuperscriptBox["x",

It is normally interpreted as a power.

ToExpression[%] // InputForm

x"2

This again prints as x with a superscript.

"2"] // DisplayForm

InterpretationBox[SuperscriptBox["x", "2"], vec[x, 2]] // DisplayForm

But now it is interpreted as vec[x, 2], following the specification given in the

InterpretationBox.

ToExpression[%] // InputForm

vec[x, 2]

If you edit the boxes given in an InterpretationBox, then there is no guarantee that the

interpretation specified by the interpretation box will still be correct. As a result, Mathematica

provides various options

InterpretationBox objects.

that allow vyou

to control the selection and editing of

option default value

Editable Automatic whether to allow the contents to be edited

Selectable True whether to allow the contents to be selected

Deletable True whether to allow the box to be deleted

DeletionWarning False whether to issue a warning if the box is
deleted

BoxAutoDelete False whether to strip the box if its contents are
modified

StripWrapperBoxes False whether to remove StyleBox etc. from

Options for InterpretationBox and related boxes.

within boxes in TagBox [boxes, ...]
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TagBox Objects are used to store information that will not be displayed but which can neverthe-
less be used by the rules that interpret boxes. Typically the tag in TagBox [boxes, tag] is @ symbol
which gives the head of the expression corresponding to boxes. If you edit only the arguments of
this expression then there is a good chance that the interpretation specified by the TagBox will
still be appropriate. As a result, Editable -> True is effectively the default setting for a

TagBox.

The rules that Mathematica uses for interpreting boxes are in general set up to ignore details of
formatting, such as those defined by StyleBox objects. Thus, unless
StripWrapperBoxes -> False, a red x, for example, will normally not be distinguished from an
ordinary black x.

A red x is usually treated as identical to an ordinary one.
ToExpression[StyleBox[x, FontColor -> RGBColor[1l, 0, 0]]] ==x

True

String Representation of Boxes

Mathematica provides a compact way of representing boxes in terms of strings. This is particu-

larly convenient when you want to import or export specifications of boxes as ordinary text.

This generates an InputForm string that represents the SuperscriptBox.

ToString[SuperscriptBox["x", "2"], InputForm]

\ (x\"2\)

This creates the SuperscriptBox.
\(x\"2))

SuperscriptBox[x, 2]

ToExpression interprets the SuperscriptBox as a power.
ToExpression[%] // FullForm

Power [x, 2]
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It is important to distinguish between forms that represent just raw boxes, and forms that
represent the meaning of the boxes.

This corresponds to a raw SuperscriptBox.
\N(x\"2))

SuperscriptBox[x, 2]

This corresponds to the power that the SuperscriptBox represents.
NN (x\ 2))

x2

The expression generated here is a power.
FullForm[\!\ (x \" 2\)]

Power [x, 2]

\ (input\) raw boxes
\ !\ (input\) the meaning of the boxes

Distinguishing raw boxes from the expressions they represent.

If you copy the contents of a standardForm cell into another program, such as a text editor,
Mathematica will generate a \ ! \ (...\) form where necessary. This is done so that if you
subsequently paste the form back into Mathematica, the original contents of the standardForm
cell will automatically be re-created. Without the \ !, only the raw boxes corresponding to

these contents would be obtained.

With default settings for options, \ ! \ (...\) forms pasted into Mathematica notebooks are

automatically displayed in two-dimensional form.

"\ (input\)" a raw character string

"N\ I\ (input\) " a string containing boxes
Embedding two-dimensional box structures in strings.

Mathematica will usually treat a \ (...\) form that appears within a string just like any other
sequence of characters. But by inserting a \ ! you can tell Mathematica instead to treat this
form like the boxes it represents. In this way you can therefore embed box structures within

ordinary character strings.
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Mathematica treats this as an ordinary character string.

"N(x \N 2 \)"

N x \" 20\

The ! \ tells Mathematica that this string contains boxes.

"NIN(x A\ 2 \)”

XZ

You can mix boxes with ordinary

text.

"box 1: \!\(x\"2\); box 2: \I\(y\"3\)"

box 1: x?; box 2: y3

\ (boxi ,boxy, ...\)
boxi \ "~ box,
boxl\_ box,
boxl\_ box, \% boxs
box\ & box,

boxi \ +box;

boxi \ +box, \ % boxs
box\ /box,

\@box

\@box; \ sbox,
form\~ box

\ xinput

RowBox [box| ,box;, ...]

SuperscriptBox [box;,box; ]
SubscriptBox [box; , box; ]
SubsuperscriptBox [box; , box, , box;]
OverscriptBox [box;, box; ]
UnderscriptBox [boxi,box; ]
UnderoverscriptBox [box; ,box, ,boxs]
FractionBox [box;,box;]

SgrtBox [box]

RadicalBox [box;, box; ]

FormBox [box, form]

construct boxes from input

Input forms for boxes.

Mathematica requires that any input forms you give for boxes be enclosed within \ ( and \).
But within these outermost \ ( and \ ) you can use additional \ ( and \) to specify grouping.

Here ordinary parentheses are used to indicate grouping.
\(x\/ (y+2)\) // DisplayForm

(y +2)
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Without the parentheses, the grouping would be different.
\(x\/y+z\) // DisplayForm

—+z

\ (and \ ) specify grouping, but are not displayed as explicit parentheses.

\(x\/\(y+z\)\) // DisplayForm

y+2z

The inner \ ( and \ ) lead to the construction of a RowBox.

\N(x\/ \(y+2z\)\)

FractionBox[x, RowBox[{y, +, 2}]]

When you type aa + bb as input to Mathematica, the first thing that happens is that aa, + and bb
are recognized as being separate “tokens”. The same separation into tokens is done when
boxes are constructed from input enclosed in \ (...\). However, inside the boxes each token is

given as a string, rather than in its raw form.

The RowBox has aa, + and bb broken into separate strings.
\ (aa + bb\) // FullForm

RowBox [List["aa", "+", "bb"]]

Spaces around the + are by default discarded.
\ (aa + bb\) // FullForm

RowBox [List["aa", "+", "bb"]]

Here two nested RowBox objects are formed.
\(aa +bb / cc\) // FullForm

RowBox[List["aa", "+", RowBox[List["bb", "/", "cc"]]]]

The same box structure is formed even when the string given does not correspond to a com-
plete Mathematica expression.
\(aa +bb /\) // FullForm

RowBox [List["aa", "+", RowBox[List["bb", "/"]1]]]
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Within \ (...\) sequences, you can set up certain kinds of boxes by using backslash notations
such as \ *~ and \ @. But for other kinds of boxes, you need to give ordinary Mathematica

input, prefaced by \ =.

This constructs a GridBox.
\ (\*GridBox[{{"a", "b"}, {"c", "d"}}]\) // DisplayForm

Q
o

This constructs a StyleBox.
\ (\*StyleBox["text", FontWeight -> "Bold"]\) // DisplayForm

text

\ » in effect acts like an escape: it allows you to enter ordinary Mathematica syntax even
within a \ (...\) sequence. Note that the input you give after a \ = can itself in turn contain

\ (... \) sequences.

You can alternate nested \ = and \ (... \). Explicit quotes are needed outside of \ (... \).

\ (x + \*GridBox[{{"a", "b"},
{\(c\"2\), \(d\/ \*GridBox[{{"x", "y"}, {"x", "y"}}1\)}}]\) // DisplayForm

a b
X + o2 d
Xy
Xy
\ I\ (input\) interpret input in the current form
\ I\ (form\ " input\) interpret input using the specified form

Controlling the way input is interpreted.

In a StandardForm cell, this will be interpreted in StandardForm, yielding a product.
VN (e (1+x)\)

c (1+x)

The backslash backquote sequence tells Mathematica to interpret this in TraditionalForm.
\!\ (TraditionalForm\" c (1 +x)\)

c[l+x]
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When you copy the contents of a cell from a notebook into a program such as a text editor, no
explicit backslash backquote sequence is usually included. But if you expect to paste what you
get back into a cell of a different type from the one it came from, then you will typically need to
include a backslash backquote sequence in order to ensure that everything is interpreted

correctly.

Converting between Strings, Boxes and Expressions

ToString [expr, form] create a string representing the specified textual form of
expr

ToBoxes [expr, form] create boxes representing the specified textual form of expr

ToExpression [input, form] create an expression by interpreting a string or boxes as
input in the specified textual form

ToString [expr] create a string using OutputForm

ToBoxes [expr] create boxes using StandardForm

ToExpression [input] create an expression using StandardForm

Converting between strings, boxes and expressions.

Here is a simple expression.
x"2+y”"2

x? 4+ y?

This gives the InputForm of the expression as a string.
ToString[x"~2 +y”~2, InputForm]

x"2 + y"2

In FullForm explicit quotes are shown around the string.
FullForm[%]

"x*2 4 yr2"

This gives a string representation for the StandardForm boxes that correspond to the expres-
sion.

ToString[x"2 +y”~ 2, StandardForm] // FullForm

"NV (x\"2 o+ y\t2\) "
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ToBoxes Yields the boxes themselves.
ToBoxes[x"2 +y"2, StandardForm]

RowBox [ {SuperscriptBox[x, 2], +, SuperscriptBox[y, 2]}]

In generating data for files and external programs, it is sometimes necessary to produce two-
dimensional forms which use only ordinary keyboard characters. You can do this using

OutputForm.

This produces a string which gives a two-dimensional rendering of the expression, using only
ordinary keyboard characters.

ToString[x"2 +y~ 2, OutputForm]

The string consists of two lines, separated by an explicit \ n newline.
FullForm[%]

"2 2\nx + y

The string looks right only in a monospaced font.
Style[%, FontFamily -> "Times"]
2 2

X +y
If you operate only with one-dimensional structures, you can effectively use ToString to do

string manipulation with formatting functions.

This generates a string corresponding to the OutputForm of StringForm.
ToString[StringForm["~~"10 = “~", 4, 4710]] // InputForm

"4710 = 1048576"

InputForm strings corresponding to keyboard input

StandardForm strings or boxes corresponding to standard two-dimen-
sional input (default)

TraditionalForm strings or boxes mimicking traditional mathematical
notation

Some forms handled by ToExpression.
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This creates an expression from an InputForm string.
ToExpression["x"2 + y"2"]

X2 +y2

This creates the same expression from StandardForm boxes.
ToExpression[RowBox [ {SuperscriptBox["x", "2"], "+", SuperscriptBox["y", "2"]1}1]11]

x? 4+ y?

In TraditionalForm these are interpreted as functions.
ToExpression["c(l + x) + log(x)", TraditionalForm]

c[l+x] + Log[x]

ToExpression [input, form,h] create an expression, then wrap it with head 2

Creating expressions wrapped with special heads.

This creates an expression, then immediately evaluates it.
ToExpression["1l + 1"]

2

This creates an expression using StandardForm rules, then wraps it in Hold.
ToExpression["1l + 1", StandardForm, Hold]

Hold[1 + 1]

You can get rid of the Hold using ReleaseHold.
ReleaseHold[%]
2

determine whether a string represents syntactically correct
Mathematica input

find out how long a sequence of characters starting at the
beginning of a string is syntactically correct

SyntaxQ [ "string" ]

SyntaxLength [ "string" |

Testing correctness of strings as input.



Notebooks and Documents | 105

ToExpression Wwill attempt to interpret any string as Mathematica input. But if you give it a
string that does not correspond to syntactically correct input, then it will print a message, and
return $Failed.

This is not syntactically correct input, so ToExpression does not convert it to an expression.

ToExpression["1l +/+ 2"]

$Failed

ToExpression requires that the string correspond to a complete Mathematica expression.

ToExpression["1l + 2 + "]

$Failed

You can use the function syntaxQ to test whether a particular string corresponds to syntacti-
cally correct Mathematica input. If SyntaxQ returns False, you can find out where the error
occurred using SyntaxLength. SyntaxLength returns the number of characters which were
successfully processed before a syntax error was detected.

SyntaxQ shows that this string does not correspond to syntactically correct Mathematica input.
SyntaxQ["1 +/+ 2"]

False

SyntaxLength reveals that an error was detected after the third character in the string.
SyntaxLength["1 +/+ 2"]
3

Here SyntaxLength returns a value greater than the length of the string, indicating that the
input was correct so far as it went, but needs to be continued.

SyntaxLength["1 + 2 + "]
10
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The Syntax of the Mathematica Language

Mathematica uses various syntactic rules to interpret input that you give, and to convert strings
and boxes into expressions. The version of these rules that is used for StandardForm and
InputForm in effect defines the basic Mathematica language. The rules used for other forms,

such as TraditionalForm, follow the same overall principles, but differ in many details.

a, xyz, afBy symbols

"some text", "oa+B" strings

123.456, 3.x10% numbers

4, —>, ¢ operators
(xcomment ) input to be ignored

Types of tokens in the Mathematica language.

When you give text as input to Mathematica, the first thing that Mathematica does is to break

the text into a sequence of tokens, with each token representing a separate syntactic unit.

Thus, for example, if you give the input xx+yy - zzzz, Mathematica will break this into the
sequence of tokens xx, +, yy, - and zzzz. Here xx, yy and zzzz are tokens that correspond to
symbols, while + and - are operators.

Operators are ultimately what determine the structure of the expression formed from a particu-
lar piece of input. The Mathematica language involves several general classes of operators,
distinguished by the different positions in which they appear with respect to their operands.

prefix 1x Not [x]

postfix x! Factorial [x]
infix X+y+Z Plus [x,y,Z]
matchfix {xry,2} List [x,y,z]
compound x/:y=z TagSet [x,y,Z]
overfix X OverHat [x]

Examples of classes of operators in the Mathematica language.

Operators typically work by picking up operands from definite positions around them. But when
a string contains more than one operator, the result can in general depend on which operator
picks up its operands first.
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Thus, for example, a « b + ¢ could potentially be interpreted either as (a+b) +c oras ax (b+c)
depending on whether « or + picks up its operands first.

To avoid such ambiguities, Mathematica assigns a precedence to each operator that can

appear. Operators with higher precedence are then taken to pick up their operands first.

Thus, for example, the multiplication operator « is assigned higher precedence than +, so that it

picks up its operands first, and a « b + c is interpreted as (a «b) +c rather thanax (b+c).

The = operator has higher precedence than +, so in both cases Times is the innermost func-
tion.

{FullForm[a *b + c], FullForm[a+b xc]}

{Plus [Times[a, b], c], Plus[a, Times[b, c]]}

The // operator has rather low precedence.
axb+c// £

flab+c]

The @ operator has high precedence.
feaxb+c
c+bfla]

Whatever the precedence of the operators you are using, you can always specify the structure

of the expressions you want to form by explicitly inserting appropriate parentheses.

Inserting parentheses makes Plus rather than Times the innermost function.
FullForm[a * (b+c)]

Times[a, Plus[b, c]]
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Extensions of symbol names XxX_, H2,e::5, etc.
Function application variants e[e] , e@@e , etc.
Power-related operators Ve , e"e, etc.
Multiplication-related operators Ve, e/e, e®e, ee, etc.
Addition-related operators ede, ere, el k, etc.
Relational operators e==e, e~e, e<e, e<le, ece, etc.
Arrow and vector operators e—e , e/e, exe, e—le, etc.
Logic operators Y.e, es&e, e\e, ere, etc.
Pattern and rule operators €., \ e, e->e, e/.e, etc.
Pure function operator e&

Assignment operators e=e, e:=¢, etc.

Compound expression e;e

Outline of operators in order of decreasing precedence.

The table in "Operator Input Forms" gives the complete ordering by precedence of all operators
in Mathematica. Much of this ordering, as in the case of « and +, is determined directly by
standard mathematical usage. But in general the ordering is simply set up to make it less likely
for explicit parentheses to have to be inserted in typical pieces of input.

Operator precedences are such that this requires no parentheses.
Vi 3, x®@y >y Am#0=>npm

Implies[Vy (3y x®y>y) &&m# 0, npm]

FullForm shows the structure of the expression that was constructed.
FullForm|[%]

Implies[And[ForAll[x, Exists[y, Succeeds[CircleTimes[x, y], v]]], Unequal[m, 0]],
NotRightTriangleBar[n, m]]

Note that the first and second forms here are identical; the third requires explicit parentheses.
{x >H#"2¢&, (x->H8"2) &, x-> ("2 &)}

[x>u1%&, xoul’s, x> (H1% &)}

flat X+y+Z X+Y+Z
left grouping x/y/z (x/y)/z
right grouping x"y*z X" (y"z)

Types of grouping for infix operators.
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Plus is a Flat function, so no grouping is necessary here.
FullForm[a +b + c +d]

Plus(a, b, c, d]

Power is not Flat, so the operands have to be grouped in pairs.
FullForm[a"b”"c”"d]

Power [a, Power [b, Power[c, d]]]

The syntax of the Mathematica language is defined not only for characters that you can type on

a typical keyboard, but also for all the various special characters that Mathematica supports.

Letters such as vy, £ and N from any alphabet are treated just like ordinary English letters, and

can for example appear in the names of symbols. The same is true of letter-like forms such as
oo, 7 and L.

But many other special characters are treated as operators. Thus, for example, @ and . are

infix operators, while - is a prefix operator, and ( and ) are matchfix operators.

@ is an infix operator.
a®b®c// FullForm

CirclePlus[a, b, c]

X is an infix operator which means the same as x.

axaxaxbxbxc

a’b?c

Some special characters form elements of fairly complicated compound operators. Thus, for

example, ffdx contains the compound operator with elements f and d.

The f and d form parts of a compound operator.

Jk[x] dx // FullForm

Integrate[k[x], x]
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No parentheses are needed here: the “inner precedence” of f ... d is lower than Times.
Ja[x] b[x] dx + c[x]

c[x] + Ja[x] b[x] dx

Parentheses are needed here, however.
J. (a[x] +b[x]) dx + c[x]

c[x] +J(a[x] +b([x]) dx

Input to Mathematica can be given not only in the form of one-dimensional strings, but also in
the form of two-dimensional boxes. The syntax of the Mathematica language covers not only

one-dimensional constructs but also two-dimensional ones.

This superscript is interpreted as a power.

O, f is a two-dimensional compound operator.
Oy, x"

n x71+n

>, is part of a more complicated two-dimensional compound operator.

i 1
n=1 n®
Zeta([s]

The Y operator has higher precedence than +.

® 1
>l—+n
s

n=1n

n + Zeta(s]
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Operators without Built-in Meanings

When you enter a piece of input such as 2 + 2, Mathematica first recognizes the + as an opera-
tor and constructs the expression plus[2, 2], then uses the built-in rules for plus to evaluate
the expression and get the result 4.

But not all operators recognized by Mathematica are associated with functions that have built-in
meanings. Mathematica also supports several hundred additional operators that can be used in

constructing expressions, but for which no evaluation rules are initially defined.

You can use these operators as a way to build up your own notation within the Mathematica
language.

The @ is recognized as an infix operator, but has no predefined value.
2®3 // FullForm

CirclePlus[2, 3]

In standardForm, @ prints as an infix operator.
263

203

You can define a value for &@.

X_®y_:=Mod[x+y, 2]

Now & is not only recognized as an operator, but can also be evaluated.

263
1
Xy CirclePlus [x,Y]
x=y TildeTilde [x,Y]
x..y Therefore[x,y]
xXoy LeftRightArrow [x,y]
Vx Del [x]
ox Square [x]
(XyYyee) AngleBracket [x,y,...]

A few Mathematica operators corresponding to functions without predefined values.
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Mathematica follows the general convention that the function associated with a particular opera-

tor should have the same name as the special character that represents that operator.

\[Congruent] is displayed as =.

It corresponds to the function Congruent.
FullForm[%]

Congruent [x, y]

x \ [name] vy name[x, y]
\[name] x name[x]
\ [Left name] x,y,... \[Right name] name[x, y, ...]

The conventional correspondence in Mathematica between operator names and function names.

You should realize that even though the functions CirclePlus and CircleTimes do not have
built-in evaluation rules, the operators @ and ® do have built-in precedences. "Operator Input
Forms" lists all the operators recognized by Mathematica, in order of their precedence.

The operators ® and @ have definite precedences—with ® higher than &.
X ®y ® z // FullForm

Mod [Plus [z, CircleTimes[x, y]], 2]
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X Subscript [x,y]
x. SubPlus [x]

‘ SubMinus [x]

x. SubStar [x]

X SuperPlus [x]

= SuperMinus [x]
o SuperStar [x]

o SuperDagger [x]
)yc Overscript [x,y]

M Underscript [x,y]
y

= OverBar [x]

% OverVector [x]

2 OverTilde [x]

2 OverHat [x]

% OverDot [x]

x UnderBar [x]

Some two-dimensional forms without built-in meanings.

Subscripts have no built-in meaning in Mathematica.
X3 +Y2 // InputForm

Subscript[x, 2] + Subscriptly, 2]

Most superscripts are however interpreted as powers by default.

x2 + y2 // InputForm
X"2 + y"2

A few special superscripts are not interpreted as powers.

x' +y* // InputForm
SuperDagger[x] + SuperPlus[y]

Bar and hat are interpreted as OverBar and OverHat.

X +§y // InputForm
OverBar[x] + OverHat[y]
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Defining Output Formats

Just as Mathematica allows you to define how expressions should be evaluated, so also it allows
you to define how expressions should be formatted for output. The basic idea is that whenever
Mathematica is given an expression to format for output, it first calls Format [expr] to find out
whether any special rules for formatting the expression have been defined. By assigning a value
to Format [expr] you can therefore tell Mathematica that you want a particular kind of expres-

sion to be output in a special way.

This tells Mathematica to format bin objects in a special way.
Format[bin[x_, y_]] := MatrixForm[{{x}, {y}}]

Now bin objects are output to look like binomial coefficients.
bin[i +3j, k]

i+j)
k

Internally, however, bin objects are still exactly the same.
FullForm[%]

bin[Plus[i, j], k]

Format [expr] : =expr, define expr, to be formatted like expr,

Format [expr,, form] : =expr, give a definition only for a particular output form

Defining your own rules for formatting.

By making definitions for Format, you can tell Mathematica to format a particular expression so
as to look like another expression. You can also tell Mathematica to run a program to determine

how a particular expression should be formatted.

This specifies that Mathematica should run a simple program to determine how xrep objects
should be formatted.

Format[xrep[n_]] := StringJoin[Table["x", {n}]]

The strings are created when each xrep is formatted.
xrep[1l] + xrep[4] + xrep[9]

X + XXXX + XXXXXXXXX
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Internally however the expression still contains xrep objects.
% /. xrep[n_] ->x"n

X+X4+X9

Prefix|[f[x],h] prefix form h x

Postfix [f[x] ,h] postfix form x i

Infix[f[x,y,...],h] infix formxhyh...

Prefix|[f[x]] standard prefix form fex

Postfix [f[x]] standard postfix form x // f

Infix[f[x,y,...]] standard infix form x~ f~y~f~...

PrecedenceForm [expr,n] an object to be parenthesized with a precedence level n

Output forms for operators.

This prints with £ represented by the "prefix operator" <>.
Prefix[f[x], "<>"]

<>X

Here is output with the "infix operator" <>.
s = Infix[{a, b, c}, "<>"]

a<>b<>c

By default, the "infix operator" <> is assumed to have "higher precedence" than *, so no
parentheses are inserted.

s”2
(a<>b<>c)?

When you have an output form involving operators, the question arises of whether the argu-
ments of some of them should be parenthesized. As discussed in "Special Ways to Input Expres-
sions", this depends on the "precedence" of the operators. When you set up output forms
involving operators, you can use PrecedenceForm to specify the precedence to assign to each
operator. Mathematica uses integers from 1 to 1000 to represent "precedence levels". The

higher the precedence level for an operator, the less it needs to be parenthesized.
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Here <> is treated as an operator with precedence 100. This precedence turns out to be low
enough that parentheses are inserted.

PrecedenceForm[s, 100] ~2

(a<>b<>c)2

When you make an assignment for Format [expr], you are defining the output format for expr in

all standard types of Mathematica output. By making definitions for Format [expr, form], you can

specify formats to be used in specific output forms.

This specifies the TeXxForm for the symbol x.

Format [x, TeXForm] := "{\\bf x}"

The output format for x that you specified is now used whenever the TeX form is needed.

TeXForm[l + x " 2]

x"2+1

Low-Level Input and Output Rules

MakeBoxes [expr, form] construct boxes to represent expr in the specified form

MakeExpression [boxes, form] construct an expression corresponding to boxes

Low-level functions for converting between expressions and boxes.

MakeBoxes generates boxes without evaluating its input.
MakeBoxes[2 + 2, StandardForm]

RowBox[{2, +, 2}]

MakeExpression interprets boxes but uses HoldComplete to prevent the resulting expres-
sion from being evaluated.
MakeExpression[%, StandardForm]

HoldComplete[2 + 2]

Built into Mathematica are a large number of rules for generating output and interpreting input.
Particularly in standardForm, these rules are carefully set up to be consistent, and to allow

input and output to be used interchangeably.
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It is fairly rare that you will need to modify these rules. The main reason is that Mathematica
already has built-in rules for the input and output of many operators to which it does not itself
assign specific meanings.

Thus, if you want to add, for example, a generalized form of addition, you can usually just use
an operator like @ for which Mathematica already has built-in input and output rules.

This outputs using the & operator.
CirclePlus[u, v, w]

uevew

Mathematica understands & on input.
u®vew// FullForm

CirclePlus[u, v, w]

In dealing with output, you can make definitions for Format [expr] to change the way that a
particular expression will be formatted. You should realize, however, that as soon as you do
this, there is no guarantee that the output form of your expression will be interpreted correctly
if it is given as Mathematica input.

If you want to, Mathematica allows you to redefine the basic rules that it uses for the input and
output of all expressions. You can do this by making definitions for MakeBoxes and
MakeExpression. You should realize, however, that unless you make such definitions with great
care, you are likely to end up with inconsistent results.

This defines how gplus objects should be output in StandardForm.

gplus /: MakeBoxes[gplus[x , y_, n_], StandardForm] :=
RowBox [ {MakeBoxes [x, StandardForm],
SubscriptBox["®", MakeBoxes[n, StandardForm] ], MakeBoxes [y, StandardForm]}]

gplus is now output using a subscripted &.
gplus[a, b, m+n]

a®nnb

Mathematica cannot however interpret this as input.
a®unb
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This tells Mathematica to interpret a subscripted @ as a specific piece of FullForm input.

MakeExpression[RowBox [ {x_, SubscriptBox["®", n_], y_}], StandardForm] :=
MakeExpression[RowBox[{"gplus", "[", x, ",", v, ",", n, "1"}], StandardForm]

Now the subscripted & is interpreted as a gplus.
a®u,nb // FullForm

gplus[a, b, Plus[m, n]]

When you give definitions for MakeBoxes, you can think of this as essentially a lower-level
version of giving definitions for Format. An important difference is that MakeBoxes does not
evaluate its argument, so you can define rules for formatting expressions without being con-

cerned about how these expressions would evaluate.

In addition, while Format is automatically called again on any results obtained by applying it,
the same is not true of MakeBoxes. This means that in giving definitions for MakeBoxes you

explicitly have to call MakeBoxes again on any subexpressions that still need to be formatted.

= Break input into tokens.

= Strip spacing characters.

= Construct boxes using built-in operator precedences.

= Strip StyleBox and other boxes not intended for interpretation.

m Apply rules defined for MakeExpression.

Operations done on Mathematica input.

Generating Unstructured Output

The functions described in "Textual Input and Output Overview" determine how expressions
should be formatted when they are printed, but they do not actually cause anything to be

printed.

In the most common way of using Mathematica you never in fact explicitly have to issue a
command to generate output. Usually, Mathematica automatically prints out the final result that
it gets from processing input you gave. Sometimes, however, you may want to get Mathemat-
ica to print out expressions at intermediate stages in its operation. You can do this using the

function Print.
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Print [expr,,expry,...] print the expr;, with no spaces in between, but with a
newline (line feed) at the end

Printing expressions.

Print prints its arguments, with no spaces in between, but with a newline (line feed) at the
end.

Print[a, b]; Print[c]
ab

(o]

This prints a table of the first five integers and their squares.
Do[Print[i, " ", 1i72], {i, 5}]

11
2 4
39
4 16
5 25
Print simply takes the arguments you give, and prints them out one after the other, with no

spaces in between. In many cases, you will need to print output in a more complicated format.

You can do this by giving an output form as an argument to Print.

This prints the matrix in the form of a table.
Print[Grid[{{1, 2}, {3, 4}}1]

1 2
3 4

Here the output format is specified using StringForm.

Print[StringForm["x = ~~, y = “°", a”2, b"2]]
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Print also allows mixing of text and graphics.

Print["A sine wave:", Plot[Sin[x], {x, 0, 2x}]]

10+

05

A sine wave: L N

—10l

The output generated by print is usually given in the standard Mathematica output format.
You can however explicitly specify that some other output format should be used.

This prints output in Mathematica input form.
Print [InputForm[a”2 +b"2]]
a2 +b"2
You should realize that print is only one of several mechanisms available in Mathematica for
generating output. Another is the function Message described in "Messages", used for generat-
ing named messages. There are also a variety of lower-level functions described in "Streams
and Low-Level Input and Output" which allow you to produce output in various formats both as

part of an interactive session, and for files and external programs.

Another command which works exactly like print, but only shows the printed output until the

final evaluation is finished, is PrintTemporary.
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Formatted Output

Ever since Version 3 of Mathematica, there has been rich support for arbitrary mathematical
typesetting and layout. Underlying all that power was a so-called box language, which allowed
notebooks themselves to be Mathematica expressions. This approach turned out to be very
powerful, and has formed the basis of many unique features in Mathematica. However, despite
the power of the box language, in practice it was awkward enough for users to access directly
that few did.

Starting in Version 6, there is a higher-level interface to this box language which takes much of
the pain out of using boxes directly, while still exposing all the same typesetting and layout
power. Functions in this new layer are often referred to as box generators, but there is no need
for you to be aware of the box language to use them effectively. In this tutorial, we will take a
look at box generators that are relevant for displaying a wide variety of expressions, and we
will show some ways in which they can be used to generate beautifully formatted output that

goes beyond simple mathematical typesetting.

Styling Output

The Mathematica front end supports all the usual style mechanisms available in word proces-
sors, for example including menus for changing font characteristics. However, it used to be very
difficult to access those styling mechanisms automatically in generated output. Output contin-
ued to be almost universally plain 12 pt. Courier (or Times for those people using
TraditionalForm). To address this, the function style was created. Whenever you evaluate a

Style expression, its output will be displayed with the given style attributes active.

You can wrap Style around any sort of expression. Here is an example that displays prime and
composite numbers using different font weights and colors via style.

Table[If[PrimeQ[i], Style[i, Bold], Style[i, Gray]], {i, 1, 100}]
(1,2,3,4,5,6,1,8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28,
29I 4 31I 4 ’ 4 ’ 4 37[ 4 ’ 4 41! 4 43! 4 4 4 47! 4 4 4 4 4
53, 54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66, 61, 68, 69, 70, 11, 72, 13, 74, 75, 76,
’ ’ 79[ 4 ’ 4 83! 4 4 4 4 4 89! 4 4 4 4 4 4 4 97! r 4 }
There are hundreds of formatting options that you could apply with style—see the documenta-
tion for style for a more complete listing—but there are a handful that are by far the most

common, listed here.
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Menu Style [] option Style [] directive
Format » Size » 14 FontSize -> 14 14

Format » Text Color » Gray FontColor -> Gray Gray

Format » Face » Bold FontWeight -> Bold Bold

Format » Face » Italic FontSlant -> Italic Italic

Format » Background Color » Yellow |Background -> Yellow

Format » Font FontFamily -> "Times"

Format » Style » Subsection "Subsection"

Note that style can be arbitrarily nested, with the innermost one taking precedence if there is
a conflict. Here we wrap Style around the entire list to apply a new font to all elements of the

list.

Style[%, FontFamily - "Helvetica"]

{1,2,3,4,5,6,7,8,9,10,11, 12,13, 14, 15, 16,17, 18,19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35, 36, 37,
» 39,40, 41,42, 43, 44, 45, 46, 47, 48, 49, 50, 51, 52, 58, 54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66, 67, 68, 69,
,71,72,73,74,75,76,77,78,79, 80, 81, 82, 83, 84, 85, 86, 87, 88, 89, 90, 91, 92, 93, 94, 95, 96, 97, 98, 99, 100}

Another common thing to want is to have a portion of the output styled like text. It can look
quite strange to have text appear in a font which is intended for use by code. For that purpose,
we have a function Text which ensures that its argument will always be rendered in a text font.
(Those of you familiar with Mathematica graphics will recognize the Text function as a graphics
primitive, but that use does not conflict with this use outside of graphics.)

Text [%%]
11,2,3,4,5,6,7,8,9,10, 11, 12, 13, 14, 15, 16, 17, 18, 19,20, 21, 22, 23, 24, 25, 26, 27, 28,29, 30, 31, 32, 33, 34,
L 37,38, 30,40, 41,47, 43,44, 43, 46, 47, 48,49, 50, 51, 52, 53, 54, 53, 56, 57, 55, 59, 60, 61, 62, 63, 64, 63, 66, 67,
ST1, 72,73, 74,75, 76, 77, 75,79, 80, 81, 82, 83, 84, 83, 86, 87, 85,89, 00, 01, 92, 93, 94, 95, 96, 97, 98, 99, 100}

Sstyle can be used to set up a region on the screen where any option is active, not just options
related to fonts. Later in this tutorial, we will see how style can even affect the display charac-

teristics of other formatting constructs, like Grid or Tooltip.

Grid Layout

Using two-dimensional layout structures can be just as useful as applying style directives to
those structures. In Mathematica, the primary function for such layout is Grid. Grid has very
flexible layout features, including the ability to arbitrarily adjust things like alignment, frame
elements, and spanning elements. (Other tutorials go into Grid's features in greater detail, but
we will cover the highlights here.)
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Look again at the style example which displays prime and composite humbers differently.
ptable = Table[If[PrimeQ[i], Style[i, Bold], Style[i, Gray]], {i, 1, 100}];
To put this into a Grid, we first use Partition to turn this 100-element list into a 10x10 array.

Although you can give Grid a ragged array (a list whose elements are lists of different lengths),
in this case we give Grid a regular array, and the resulting display is a nicely formatted layout.

Grid[Partition[ptable, 10]]

2 3 5 7
11 13 17 19
23 29

31 37

41 43 47
53 59

61 67
71 73 79
83 89

97

Notice that the columns are aligned on center, and there are no frame lines. It is an easy mat-

ter to change either of these using Grid's options.

Grid[Partition[ptable, 10], Alignment - Right,
Frame -» True, Background - LightBlue]

2 3 5 7
11 13 17 19
23 29

31 37

41 43 47
53 59

61 67
71 73 79
83 89

97

A complete description of all Grid's options and their syntax is beyond the scope of this docu-
ment, but it is possible to do some remarkable things with them. See the complete Grid docu-

mentation for complete details.

There are a few convenience constructs related to Grid. One is Column, which takes a flat list of
elements and arranges them vertically. This would be slightly awkward to do with Grid. Here is

a simple example, viewing the options of column in, well, a column.
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Column[Options[Column] ]

Alignment - {Left, Baseline}
Background - None
BaselinePosition - Automatic
BaseStyle - {}
ColumnAlignments - Left
DefaultBaseStyle - Grid
DefaultElement - O

Dividers - None

Frame — None

FrameStyle —» Automatic
ItemSize —» Automatic
ItemStyle - None

Spacings - {0.8, 1.}

What about laying out a list of things horizontally? In that case, the main question you need to
ask is whether you want the resulting display to line wrap like a line of math or text would, or
whether you want the elements to remain on a single line. In the latter case, you would use
Grid applied to a 1xn array.

Grid[{Range[15] !}]

1 2 6 24 120 720 5040 40320 362880 3628800 39916800 42%0016‘-, 6333020'-. 8;%3%291 1332;3581
But notice in this example, that the overall grid shrinks so that it fits in the available window
width. As a result, there are elements of the grid which themselves wrap onto multiple lines.
This is due to the default TtemSize option of Grid. If you want to allow the elements of a grid
to be as wide as they would naturally be, set ItemSize to Full.

Grid[{Range[15] !}, ItemSize -» Full]

1 2 6 24 120 720 5040 40320 362880 3628800 39916800 479001600 6227020800 87178291200 1307674368000

Of course, now the whole grid is too wide to fit on one line (unless you make this window very
wide), and so there are elements in the grid which you cannot see. That brings us to the other

horizontal layout function: Row.

Given a list of elements, Row will allow the overall result to word wrap in the natural way, just
like a line of text or math would. This type of layout will be familiar to those of you who might
have used the old (and now obsolete) sequenceForm function.

Row[Range[15] !]

12624120720504040 3203628803 628800399168004790016006227020800871782912001307674368000
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As you can see, Row does not leave space between elements by default. But if you give a sec-
ond argument, that expression is inserted between elements. Here we use a comma, but any
expression can be used.

Row[Range[15]!, ","]

1, 2, 6, 24, 120, 720, 5040, 40320, 362880, 3628800, 39916800,

479001600, 6227020800, 87178291200, 1307674368000
If you resize the notebook window, you will see that Grid with ItemSize -> Automatic contin-

ues to behave differently than Row, and each is useful in different circumstances.

Using Output as Input

This is a good time to point out that style, Grid, and all other box generators are persistent in
output. If you were to take a piece of output that had some formatting created by style or
Grid and reuse that as input, the literal style or Grid expressions would appear in the input
expression. Those of you familiar with the old uses of styleBox and even functions like
MatrixForm Will find this a change.

Consider taking the output of this Grid command, which has lots of embedded styles, and

using it in some input expression.

Grid[Partition[Take[ptable, 16], 4],
Alignment - Right, Frame - True, Background - LightBlue]

2 3
5 7
11
13
2 3 :
5 7 5 E d
11 + // Expan
13
2 2 3 4| 2 3 4
125 + 75 3 7 + 15 3 U + £
11 11 11
13 13 13

Notice that the grid is still a grid, it is still blue, and the elements are still bold or gray as
before. Also notice that having literal Grid and style in the expression interferes with what

would have otherwise been adding a scalar to a matrix, and raising the result to a power. This
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distinction is very important, since you almost always want these composite structures to resist
being interpreted automatically in some way. However, if you ever do want to get rid of these
wrappers and get at your data, that is easy enough to do.

% //. {Grid[a_, ] > a, Stylela_, ] > a}
({216, 343, 512, 729}, {1000, 1331, 1728, 2197}, {2744, 3375, 4096, 4913}, {5832, 6859, 8000, 9261}}

Special Grid Entries

To allow more flexible two-dimensional layout, Grid accepts a few special symbols like
SpanFromLeft as entries. The entry SpanFromLeft indicates that the grid entry immediately to
the left should take up its own space and also the space of the spanning character. There are
also SpanFromAbove and SpanFromBoth. See "Grids, Rows, and Columns" for detailed
information.

Grid[({
{1, 2, 3, 4, 5},
{6, 7, SpanFromLeft, SpanFromLeft, 10},
{11, SpanFromAbove, SpanFromBoth, SpanFromBoth, 15},
{16, 17, 18, 19, 20}}, Frame - All]

2\3\4 5
6 7 10
(11 | 15|
16 17‘18‘19 20

This approach can be used to create complicated spanning setups. Typing something like the
following as an input would take a long time. Luckily you can create this table interactively by
using Make Spanning and Split Spanning in the Insert » Table/Matrix submenu. If you
want to see what would be involved in typing this, evaluate the cell, which will show how it

should be typed as input.

1|2 3|4 5 6|7|8|9|10
11 12| 13 |15 16
21 |22 25 |
3132 33|34 35
41
51 [52[53 |54 |55 // InputForm
61|62 63
71 (72 76 77
81 |82 86
91 |92 2
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We have already seen how to apply things like alignment and background to a grid as a whole,
or to individual columns or rows. What we have not seen though is how to override that for an
individual element. Say you want your whole grid to have the same background, except for a
few special elements. A convenient way to do that is to wrap each such element in Item, and
then specify options to Item which override the corresponding option in Grid.

Grid[Partition[Table[If[PrimeQ[i], Item[i, Background - LightYellow], i],
{i, 1, 100}], 10], Background - LightBlue]

1 2 3 4 5 6 7 8 9 10
11 12 13 14 15 16 17 18 19 20
21 22 23 24 25 26 27 28 29 30
31 32 33 34 35 36 37 38 39 40
41 42 43 44 45 46 47 48 49 50
51 52 53 54 55 56 57 58 59 60
61 62 63 64 65 66 67 68 69 70
71 72 73 74 75 76 77 78 79 80
81 82 83 84 85 86 87 88 89 90
91 92 93 94 95 96 97 98 99 100

You could override this option with style too, but the purpose of Item is to override it in a way
that knows about the two-dimensional layout of Grid. Notice in the preceeding output that
whenever two of the yellow cells are next to each other, there is no blue space between them.

That would be impossible to do with constructs other than Item.

The same thing goes for all 1tem's options, not just Background. Consider the Frame option. If
you want no frame elements except around certain specified elements, you might think that
you have to wrap them in their own Grid with the Frame -> True setting. (We will learn a much

easier way to add a frame around an arbitrary expression in the next section.)

Grid[Partition[Table[If[PrimeQ[i], Grid[{{i}}, Frame -» True], i], {i, 1, 100}], 10]]

1 [2][3] 4 [5] 6 [7] 8 9 10
[11] 12 [13] 14 15 16 [17] 18 [19] 20
21 22 [23] 24 25 26 27 28 [29] 30
[31] 32 33 34 35 36 [37] 38 39 40
[41] 42 [43] 44 45 46 [47] 48 49 50
51 52 [53] 54 55 56 57 58 [59] 60
[61] 62 63 64 65 66 [67] 68 69 70
[71] 72 [73] 74 75 76 77 78 [79] 80
81 82 [83] 84 85 86 87 88 [89] 90
91 92 93 94 95 96 [97] 98 99 100
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But notice that adjacent framed elements do not share their boundaries. Compare that with
using Item, below, which has enough information to not draw more frame elements than are
necessary. Notice now the frames of 2 and 11 meet at a single point, and how the frames of 2
and 3 share a single-pixel line, which in turn is perfectly aligned with the left frame of 13 and
23. That is the power of Item.

Grid[Partition[Table[If[PrimeQ[i], Item[i, Frame - True], i], {i, 1, 100}], 10]]

1273 468 9 10
\ilzi“ 15 161820
21 222324 25 26 27 28[29] 30
31]32 33 34 35 36[37]38 39 40
Euﬁu 45 46 47|48 49 50
51 52|53 |54 55 56 57 SSE 60
61]62 63 64 65 66“68 69 70
71|72 [73]|74 75 76 77 78[79] 80
81 82[83|84 85 86 87 88 90
91 92 93 94 95 96[97)98 99 100

Frames and Labels

Adding a frame or a label to an expression can be done with Grid, but conceptually these are
much simpler operations than general two-dimensional layout, and so there are correspondingly
simpler ways to get them. For instance, Framed is a simple function for drawing a frame around
an arbitrary expression. This can be useful to draw attention to parts of an expression, for

instance.

Table[If[PrimeQ[i], Framed[i, Background - LightYellow], i], {i, 1, 100}]

{1, , , 4, , 6, , 8, 9, 10, , 12, , 14, 15, 16, , 18, , 20,

21, 22, , 24, 25, 26, 27, 28, , 30, , 32, 33, 34, 35, 36, , 38, 39, 40,
, 42, , 44, 45, 46, , 48, 49, 50, 51, 52, [53], 54, 55, 56, 57, 58, , 60,
[61]. 62, 63, 64, 65, 66, , 68, 69, 70, , 72, , 74, 75, 76, 77, 78, , 80,
81, 82, , 84, 85, 86, 87, 88, , 90, 91, 92, 93, 94, 95, 96, , 98, 99, 100}

Labeled is another such function, which allows labels to be placed at arbitrary locations around
a given expression. Here we add a legend to the Grid example from the last section. (spacer is

just a function that is designed to leave empty space.)
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Labeled|[
Grid[Partition[ptable, 10], Alignment - Right, Frame - True],
Text [Row[{Style["e Prime", Bold], Style["e Composite", Gray]}, Spacer[15]]]]

2 3 5 7
11 13 17 19
23 29

31 37

41 43 47
53 59

61 67
71 73 79
83 89

97

¢ Prime

panel is yet another framing construct, which uses the underlying operating system's panel
frame. This is different from Frame, as different operating systems might use a drop shadow,

rounded corners, or fancier graphic design elements for a panel frame.

Panel [%]

2 3 5 7
1 13 17 19
23 29

31 37

41 43 47
53 59

61 67
7 73 79
83 89

97

* Prime

Note that panel has its own concept of font family and size as well, so the contents of Grid
change font family and size, and the Text changes font size. (Text has its own opinion about
font family though, and so it remains in Mathematica's text font.) We will talk about this in

some detail below in the section on the Basestyle option.

Finally, we should point out that panel itself has an optional second argument to specify one or
more labels, which are automatically positioned outside the panel, and an optional third argu-
ment to give details of that position. See the documentation for Panel for more detail.
Panel [ptable, "Primes and Composites"]
Primes and Composites
{1,2,3,4,5,6,7,8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35, 36, 37,

38, 39, 40, 41, 42, 43, 44, 45, 46, 47, 48, 49, 50, 51, 52, 63, 54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66, 67, 68, 69,
70,71,72,73,74,75,76,77,78,79, 80, 81, 82, 83, 84, 85, 86, 87, 88, 89, 90, 91, 92, 93, 94, 95, 96, 97, 98, 99, 100}
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Panel [ptable, {"Primes and Composites"}, {{Bottom, Right}}]

{1.2,8,4,5,6,7,8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35, 36, 37,
,39,40,41, 42,43, 44, 45, 46, 47, 48, 49, 50, 51, 52, 53, 54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66, 67, 68, 69,
,7,72,73,74,75,76,77,78,79, 80, 81, 82, 83, 84, 85, 86, 87, 88, 89, 90, 91, 92, 93, 94, 95, 96, 97, 98, 99, 100}

Primes and Composites

Other Annotations

The annotations mentioned so far have a very definite visual component. There are a number of
annotations which are effectively invisible, until the user needs them. Tooltip for example
does not change the display of its first argument, and only when you move the mouse pointer
over that display is the second argument shown, as a tooltip.

Table[Tooltip[i, Divisors[i]], {i, 1, 100}]

{1, 2,3, 4,5,6,7,8,9, 10,11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28,

29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 44, 45, 46, 47, 48, 49, 50, 51, 52,

53, 54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75, 76,

77, 78, 79, 80, 81, 82, 83, 84, 85, 86, 87, 88, 89, 90, 91, 92, 93, 94, 95, 96, 97, 98, 99, 100}
Mouseover is another such function, but instead of displaying the result in a tooltip, it uses the
same area of the screen that had been used for the display before you moved the mouse
pointer over it. If the two displays are different sizes, then the effect can be jarring, so it is a
good idea to use displays which are closer to the same size, or use the Mouseover ImageSize
option to leave space for the larger of the two displays, regardless of which is being displayed.

Table [Mouseover[i, Framed[Divisors[i], Background - LightYellow]], {i, 1, 100}]

{,2,3,4,5,6,7,8,9, 10,11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27,
28, 29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 44, 45, 46, 47, 48, 49, 50, 51, 52,
53, 54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75, 76,
77, 78, 79, 80, 81, 82, 83, 84, 85, 86, 87, 88, 89, 90, 91, 92, 93, 94, 95, 96, 97, 98, 99, 100}

Also similar to Tooltip are StatusArea and PopupWindow. StatusArea displays the extra
information in the notebook's status area, typically in the lower-left corner, while PopupWindow
will display extra information in a new window when clicked.

Table[StatusArea[i, Divisors[i]], {i, 1, 100}]

{1,2, 3, 4,5, 6,7, 8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28,

29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 44, 45, 46, 47, 48, 49, 50, 51, 52,

53, 54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75, 76,
77, 78, 79, 80, 81, 82, 83, 84, 85, 86, 87, 88, 89, 90, 91, 92, 93, 94, 95, 96, 97, 98, 99, 100}
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Table[PopupWindow[i, Divisors[i]], {i, 1, 100}]

{1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28,
29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 44, 45, 46, 47, 48, 49, 50, 51, 52

53, 54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75, 76

77, 78, 79, 80, 81, 82, 83, 84, 85, 86, 87, 88, 89, 90, 91, 92, 93, 94, 95, 96, 97, 98, 99, 100}

Finally, you can specify an arbitrary location for an annotation by using the pair Annotation

and MouseAnnotation.

Table[Annotation[i, Divisors[i], "Mouse"], {i, 1, 100}]
Dynamic [MouseAnnotation[]]

{1, 2, 3, 4,5, 6,7, 8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27,
28, 29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 44, 45, 46, 47, 48, 49, 50, 51, 52,
53, 54, 55, 56, 57, 58, 59, 60, 61, 62, 63, 64, 65, 66, 67, 68, 69, 70, 71, 72, 73, 74, 75, 76,
77, 78, 79, 80, 81, 82, 83, 84, 85, 86, 87, 88, 89, 90, 91, 92, 93, 94, 95, 96, 97, 98, 99, 100}

Null

When using annotations that are triggered merely by moving the mouse pointer over a region
of the screen, it is important to keep the user in mind. Moving the mouse is not something that
should trigger a long evaluation or a lot of visual clutter. But used sparingly, annotations can be
quite helpful to users.

Finally, note that all these annotations work perfectly well in graphics too. So you can provide
tooltips or mouseovers to aid users in understanding a complicated graphic you have created.
In fact, even visualization functions like ListPlot or DensityPlot support Tooltip. See the
documentation for details.

Graphics[{LightBlue, EdgeForm[Gray], Tooltip[CountryData[#, "SchematicPolygon"],
Panel [CountryData[#, "Flag"], #]] & /@ CountryData[]}, ImageSize - Full]
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Default Styles

As we saw in the section "Frames and Labels", constructs like Panel actually work much like
Style, in that they set up an environment in which a set of default styles is applied to their
contents. This can be overridden by explicit style commands, but it can also be overridden for
the panel itself, through the Basestyle option. BaseStyle can be set to a style or a list of
style directives, just like you would use in style. And those directives then become the ambi-

ent default within the scope of that panel.

As we have already seen, panel by default uses the dialog font family and size. But that can be

overridden by using this Basestyle option.

Panel [Range[10]]

{1,2,3,4,5,6,7,8,9, 10}

Panel [Range[10], BaseStyle - {"StandardForm"}]

{1,2,3,4,5,6,7,8,9, 10}

Actually, almost all of these box generators have a BaseStyle option. For instance, here is a
grid in which the default font color is blue. Notice that the elements that were gray stay gray,
since the inner style wrapper trumps the outer Grid BaseStyle. (This is one of the principal

characteristics of option inheritance, which is beyond the scope of this document to discuss.)
Grid[Partition[ptable, 10], BaseStyle - {FontColor - Blue}]

1 2 3 4 5 6 7 8 9 10
11 12 13 14 15 16 17 18 19 20
21 22 23 24 25 26 27 28 29 30
31 32 33 34 35 36 37 38 39 40
41 42 43 44 45 46 47 48 49 50
51 52 53 54 55 56 57 58 59 60
61 62 63 64 65 66 67 68 69 70
71 72 73 74 75 76 77 78 79 80
81 82 83 84 85 86 87 88 89 90
91 92 93 94 95 96 97 98 99 100
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Default Options

Say you have an expression with multiple occurrences of the same box generator, like a Framed
or a panel, and you want to change all of them to have the same set of options. It might be
cumbersome to go through and add the same set of options to every occurrence of that func-

tion. Thankfully, there is an easier way.

DefaultOptions is an option to style which, when set to a list of elements of the form
head -> {opt -> val, ...}. sets up an environment with the given options as the ambient default
for the given box-generating head. Those options will be active throughout the style wrapper,
but only in any instances of the associated box generator.

So if you had an expression that contained some Framed items, and you wanted them all to be

drawn with the same background and frame style.

Table[If[PrimeQ[i], Framed[i], i], {i, 1, 100}]

Actually, that input is too short to see the advantage of this syntax. Say you had this same list,
but specified manually.

biglist = {1, Framed[2], Framed[3], 4, Framed[5], 6, Framed[7], 8, 9, 10,
Framed[11], 12, Framed[13], 14, 15, 16, Framed[17], 18, Framed[19], 20,
21, 22, Framed[23], 24, 25, 26, 27, 28, Framed[29], 30, Framed[31], 32, 33,
34, 35, 36, Framed[37], 38, 39, 40, Framed[41l], 42, Framed[43], 44, 45, 46,
Framed[47], 48, 49, 50, 51, 52, Framed[53], 54, 55, 56, 57, 58, Framed[59],
60, Framed[61], 62, 63, 64, 65, 66, Framed[67], 68, 69, 70, Framed[71], 72,
Framed[73], 74, 75, 76, 77, 78, Framed[79], 80, 81, 82, Framed[83], 84, 85,
86, 87, 88, Framed[89], 90, 91, 92, 93, 94, 95, 96, Framed[97], 98, 99, 100}

{1, , , 4, , 6, , 8, 9, 10, , 12, [13], 14, 15, 16, [17], 18, [19], 20,

21, 22, , 24, 25, 26, 27, 28, , 30, , 32, 33, 34, 35, 36, , 38, 39, 40,
, 42, [43], 44, 45, 46, , 48, 49, 50, 51, 52, , 54, 55, 56, 57, 58, , 60,
, 62, 63, 64, 65, 66, , 68, 69, 70, , 72, , 74, 75, 76, 77, 78, , 80,
81, 82, [83], 84, 85, 86, 87, 88, , 90, 91, 92, 93, 94, 95, 96, [97], 98, 99, 100}

Now inserting Background and FrameStyle options into every Framed wrapper is prohibitively
time consuming, although you certainly could do it (or you could write a program to do it for
you). But using DefaultOptions, you can effectively set up an environment in which all Framed

wrappers will use your settings for Background and FrameStyle, thus.
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Style[biglist,
DefaultOptions -» {Framed - {Background - LightYellow, FrameStyle - Blue}}]

{1, , , a, , 6, , 8, 9, 10, , 12, , 14, 15, 1s, , 18, , 20,

21, 22, H, 24, 25, 26, 27, 28, , 30, , 32, 33, 34, 35, 36, , 38, 39, 40,
, 42, , 44, 45, 46, , 48, 49, 50, 51, 52, , 54, 55, 56, 57, 58, , 60,
, 62, 63, 64, 65, 66, , 68, 69, 70, , 72, , 74, 75, 76, 77, 78, , 80,
81, 82, , 84, 85, 86, 87, 88, , 90, 91, 92, 93, 94, 95, 96, , 98, 99, 100}

This approach makes it easy to create structures that follow uniform style guidelines without
having to specify those styles in more than one place, which makes for considerably cleaner

code, smaller file sizes, and easier maintenance.

Mathematical Typesetting

No discussion of formatted output would be complete without at least a nod toward the format-

ting constructs that are unique to mathematical syntaxes.

{Subscript[a, b], Superscript[a, b], Underscript[a, b],
Overscript[a, b], Subsuperscript[a, b, c¢], Underoverscript[a, b, c]}

b c
b c
{abl a’, a, a, abl a}
b b

We will not discuss these at length, but we will point out that these constructs do not have any
built-in mathematical meaning in the kernel. For example, Superscript [a, b] Wwill not be
interpreted as power [a, b], even though their displays are identical. So you can use these as
structural elements in your formatted output without having to worry about their meaning
affecting your display.

Table[Row[{i, Row[Superscript @@@ FactorInteger[i], "x"]1}, "=="], {i, 100}]

{1==1%, 2==2% 323" 4--22 5--5' 6-=2'x3!, 7-=7% 8--2% 9--82, 10==2"x5% 11=-=11',
12 ==22x3', 13 ==13%, 14 --21x7', 15==3'x5', 16 ==2% 17-==17%, 18 ==2'x3?, 19 ==19%,
20 ==22x5%, 21 ==3'x7%, 22=-2%x11%, 23==23%, 24--2%x3', 25=-=-52 26=-=2'x13! 27-==3%,
28 ==22x7, 29 ==29%, 30==2'x3'x5' 31==-31% 32--2%5 33--3'x11! 34--2'x17!, 35=-=5'x7!,
36 ==22x3?, 37 ==37%, 38==2%x19%, 39 ==31x13%, 40 ==23x5%, 41 ==41%, 42 ==2'x3'x7%,
43 == 43%, 44 ==22x11%, 45 ==32x5%, 46 ==2'x23%, 47 ==47', 48 ==2%x3!, 49 ==7?, 50 == 2'x5?,
51 ==3'x17%, 52 ==22x13', 53 ==53%, 54 --21x3% 55--5'x11%, 56 ==23x7!, 57 ==31x19%,
58 == 21 x 291, 59 == 59, 60 == 22x3'x5', 61 ==61%, 62 ==2'x31', 63 ==32x7!, 64 ==25 65==5"x13%,
66 == 21 x 31 x11', 67 == 671, 68 ==22x17', 69 ==3'x23%, 70 ==2' x5 x7!, 71 ==71%, 72 ==2%x3?,
73 ==73, 74 ==2'x37}, 75==3'x5%, 76 ==22x19%, 77 ==7'x11', 78 ==2'x3'x13!, 79 ==79%,
80 == 24 x5, 81 ==3% 82==2'x41', 83==83%, 84 ==22x3'x7, 85==5x17!, 86 ==2'x43%,
87 ==3'x29", 88 ==2%3x11', 89 ==89%, 90 ==2'x3%2x5%, 91 ==7'x13", 92 ==22x23", 93 ==3'x31?,
94 == 2 <471, 95 ==5x19', 96 ==25x3', 97 == 97!, 98 ==2'x7% 99 ==32x11', 100 == 22 x5?%}
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Using the Box Language

One final note. Those of you who are already familiar with the box language might occasionally
find that these box generators get in the way of your constructing low level boxes yourselves,
and inserting their display into a piece of output. That can be true for any layered technology
where one abstraction layer attempts to hide the layers on which it sits. However, there is a
simple loophole through which you can take boxes which you happen to know are valid, and

display them directly in output: RawBoxes.

{a, b, RawBoxes [SubscriptBox["c", "d"]], e}

{a, b, cq, €}

As with all loopholes, RawBoxes gives you added flexibility, but it also allows you to shoot
yourself in the foot. Use with care. And if you are not yet familiar with the box language, per-

haps you should not use it at all.

Requesting Input

Mathematica usually works by taking whatever input you give, and then processing it. Some-
times, however, you may want to have a program you write explicitly request more input. You

can do this using Input and InputString.

Input [] read an expression as input
InputString[] read a string as input

Input [ " prompt" ] issue a prompt, then read an expression
InputString [ " prompt" ] issue a prompt, then read a string

Interactive input.

Exactly how Input and InputString work depends on the computer system and Mathematica
interface you are using. With a text-based interface, they typically just wait for standard input,
terminated with a newline. With a notebook interface, however, they typically get the front end
to put up a “dialog box”, in which the user can enter input.

In general, Input is intended for reading complete Mathematica expressions. InputString, on

the other hand, is for reading arbitrary strings.
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Messages

Mathematica has a general mechanism for handling messages generated during computations.
Many built-in Mathematica functions use this mechanism to produce error and warning

messages. You can also use the mechanism for messages associated with functions you write.

The basic idea is that every message has a definite name, of the form symbol: :1ag. You can use
this name to refer to the message. (The object symbol: :tag has head MessageName.)

Quiet [expr] evaluate expr without printing any messages

Quiet [expr, {8512 :tag, sy stag, ...} ] evaluate expr without printing the specified messages
Off [s: :tag] switch off a message, so it is not printed

On [s::rag| switch on a message

Controlling the printing of messages.
As discussed in "Warnings and Messages", you can use Quiet to control the printing of particu-
lar messages during an evaluation. Most messages associated with built-in functions are

switched on by default. If you want to suppress a message permanently, you can use Off.

This prints a warning message. Also, the front end highlights the extra argument in red.
Log[a, b, c]
>

Log[a, b, c]

This suppresses the warning message.
Quiet[Log[a, b, c]]

Log[a, b, c]

The message reappears with the next evaluation.
Log[a, b, c]
>

Log[a, b, c]

You can use on and off to make global changes to the printing of particular messages. You can

use Off to switch off a message if you never want to see it.
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You can switch off the message like this.
Off [Log::argt]

Now no warning message is produced.
Log[a, b, c]

Log[a, b, c]

Although most messages associated with built-in functions are switched on by default, there are
some which are switched off by default, and which you will see only if you explicitly switch them
on. An example is the message General::newsym, discussed in "Intercepting the Creation of

New Symbols", which tells you every time a new symbol is created.

s itag give the text of a message
s¢ stag=string set the text of a message
Messages [s] show all messages associated with s

Manipulating messages.

The text of a message with the name s::7g is stored simply as the value of s::rg, associated
with the symbol s. You can therefore see the text of a message simply by asking for s: :7ag. You

can set the text by assigning a value to s: :7ag.

If you give LinearSolve a singular matrix, it prints a warning message.
LinearSolve[{{1, 1}, {2, 2}}, {3, 5}]
>

LinearsSolve[{{1, 1}, {2, 2}}, {3, 5}]

Here is the text of the message.
LinearSolve: :nosol

Linear equation encountered that has no solution.

This redefines the message.
LinearSolve::nosol = "Matrix encountered is not invertible."

Matrix encountered is not invertible.
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Now the new form will be used.
LinearSolve[{{1, 1}, {2, 2}}, {3, 5}]
>

LinearSolve[{{1, 1}, {2, 2}}, {3, 5}]

Messages are always stored as strings suitable for use with stringForm. When the message is
printed, the appropriate expressions are “spliced” into it. The expressions are wrapped with
HoldForm to prevent evaluation. In addition, any function that is assigned as the value of the
global variable $MessagePrePrint is applied to the resulting expressions before they are given
to stringForm. The default for sMessagePrePrint uses Short for text formatting and a combi-
nation of short and shallow for typesetting.

Most messages are associated directly with the functions that generate them. There are, how-

ever, some “general” messages, which can be produced by a variety of functions.

If you give the wrong number of arguments to a function F, Mathematica will warn you by
printing a message such as F::argx. If Mathematica cannot find a message named F::argx, it
will use the text of the “general” message General::argx instead. You can use Off [F::argx]
to switch off the argument count message specifically for the function F. You can also use

Off [General::argx] to switch off all messages that use the text of the general message.

Mathematica prints a message if you give the wrong number of arguments to a built-in function.
Sqgrt[a, b]
>

Sqgrt(a, b]

This argument count message is a general one, used by many different functions.
General::argx

1% called with “2° arguments; 1 argument is expected.

If something goes very wrong with a calculation you are doing, it is common to find that the
same warning message is generated over and over again. This is usually more confusing than
useful. As a result, Mathematica keeps track of all messages that are produced during a particu-
lar calculation, and stops printing a particular message if it comes up more than three times.

Whenever this happens, Mathematica prints the message General::stop to let you know. If
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you really want to see all the messages that Mathematica tries to print, you can do this by

switching off General: :stop.

$MessageList a list of the messages produced during a particular
computation

MessageList [n] a list of the messages produced during the processing of
the nt" input line in a Mathematica session

Finding out what messages were produced during a computation.

In every computation you do, Mathematica maintains a list $MessageList of all the messages
that are produced. In a standard Mathematica session, this list is cleared after each line of

output is generated. However, during a computation, you can access the list. In addition, when

the »™" output line in a session is generated, the value of $MessageList is assigned to

MessageList [n].

This returns $MessageList, which gives a list of the messages produced.

Sqgrt[a, b, c]; Exp[a, b]; $MessageList
>

>

{Sqrt::argx, Exp::argx}

The message names are wrapped in HoldForm to stop them from evaluating.
InputForm[%]

{HoldForm[Sqrt::argx], HoldForm[Exp::argx]}

In writing programs, it is often important to be able to check automatically whether any
messages were generated during a particular calculation. If messages were generated, say as a
consequence of producing indeterminate numerical results, then the result of the calculation
may be meaningless.

Check [expr, failexpr] if no messages are generated during the evaluation of expr,
then return expr, otherwise return failexpr

Check [expr, failexpr,sy: 21, ,52¢:1>,...] check only for the messages s;: :1;

Checking for warning messages.
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Evaluating 1~ 0 produces no messages, so the result of the evaluation is returned.
Check[1"70, err]
1

Evaluating 0 * 0 produces a message, so the second argument of Check is returned.
Check[0" 0, err]

>

err

Check [expr, failexpr] tests for all messages that are actually printed out. It does not test for
messages whose output has been suppressed using Off.

In some cases you may want to test only for a specific set of messages, say ones associated
with numerical overflow. You can do this by explicitly telling check the names of the messages
you want to look for.

The message generated by Sin[1, 2] is ignored by Check, since it is not the one specified.

Check[Sin[1l, 2], err, General::ind]

>

sin[1, 2]
Message [s: :fag] print a message
Message [s: :fag, expr,...] print a message, with the expr; spliced into its string form

Generating messages.

By using the function Message, you can mimic all aspects of the way in which built-in Mathemat-
ica functions generate messages. You can for example switch on and off messages using on and
Off, and Message will automatically look for General::rg if it does not find the specific
message s: :fag.

This defines the text of a message associated with £.
f::overflow = "Factorial argument ~1° too large."

Factorial argument ~1° too large.

Here is the function £.

f[x_] :=If[x > 10, (Message[f::overflow, x]; Infinity), x!]
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When the argument of £ is greater than 10, the message is generated.
£[20]

This switches off the message.
Off[f::overflow]

Now the message is no longer generated.
£[20]

[ee]

When you call Message, it first tries to find a message with the explicit name you have speci-
fied. If this fails, it tries to find a message with the appropriate tag associated with the symbol
General. If this too fails, then Mathematica takes any function you have defined as the value of
the global variable $NewMessage, and applies this function to the symbol and tag of the

message you have requested.

By setting up the value of $NewMessage appropriately, you can, for example, get Mathematica

to read in the text of a message from a file when that message is first needed.

International Messages

The standard set of messages for built-in Mathematica functions are written in American Eng-
lish. In some versions of Mathematica, messages are also available in other languages. In

addition, if you set up messages yourself, you can give ones in other languages.

Languages in Mathematica are conventionally specified by strings. The languages are given in
English, in order to avoid the possibility of needing special characters. Thus, for example, the

French language is specified in Mathematica as "French".

$Language="lang" set the language to use
$Language={"lang,", "lang," ,...}

set a sequence of languages to try

Setting the language to use for messages.
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This tells Mathematica to use French-language versions of messages.
$Language = "French"

French

If your version of Mathematica has French-language messages, the message generated here
will be in French.

Sqrt[a, b, c]

Sgrt[a, b, c]

symbol: :tag the default form of a message

symbol: :tag: : Language a message in a particular language
Messages in different languages.

When built-in Mathematica functions generate messages, they look first for messages of the
form s::r::Language, in the language specified by $Language. If they fail to find any such

messages, then they use instead the form s: :7 without an explicit language specification.

The procedure used by built-in functions will also be followed by functions you define if you call
Message with message names of the form s::7. If you give explicit languages in message

names, however, only those languages will be used.

Documentation Constructs

When you write programs in Mathematica, there are various ways to document your code. As
always, by far the best thing is to write clear code, and to name the objects you define as

explicitly as possible.

Sometimes, however, you may want to add some "commentary text" to your code, to make it
easier to understand. You can add such text at any point in your code simply by enclosing it in
matching (« and x). Notice that in Mathematica, "comments" enclosed in (» and x) can be

nested in any way.
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You can use comments anywhere in the Mathematica code you write.
If[a > b, (*thenx) p, (*elsex) q]

Iffa>b, p, 4]

(xtext*) a comment that can be inserted anywhere in Mathematica
code

Comments in Mathematica.

There is a convention in Mathematica that all functions intended for later use should be given a
definite "usage message", which documents their basic usage. This message is defined as the
value of f::usage, and is retrieved when you type ? f.

f::usage="text" define the usage message for a function
2f get information about a function
22f get more information about a function

Usage messages for functions.

Here is the definition of a function £.
flx_] :=x"2

Here is a "usage message" for £f.

f::usage = "f[x] gives the square of x.'

f[x] gives the square of x.

This gives the usage message for £.
?2f

f[x] gives the square of x.

?2? £ gives all the information Mathematica has about £, including the actual definition.

?2? £

f[x] gives the square of x.
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When you define a function f, you can usually display its value using ? f. However, if you give a
usage message for f, then ? f just gives the usage message. Only when you type 2?2 f do you
get all the details about f, including its actual definition.

If you ask for information using ? about just one function, Mathematica will print out the com-
plete usage messages for the function. If you ask for information on several functions at the
same time, however, Mathematica will give the name of each function, if possible with a link to
its usage information.

This gives all the symbols in Mathematica that start with "Plot".

? Plot*
System’

Plot PlotJoined PlotRange PlotStyle
PlotRangeClip™.

Plot3D PlotLabel ping
PlotRangePad".

Plot3Matrix PlotMarkers ding

PlotDivision PlotPoints PlotRegion

If you use Mathematica with a text-based interface, then messages and comments are the
primary mechanisms for documenting your definitions. However, if you use Mathematica with a
notebook interface, then you will be able to give much more extensive documentation in text
cells in the notebook.
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Manipulating Notebooks

Cells as Mathematica Expressions

Like other objects in Mathematica, the cells in a notebook, and in fact the whole notebook itself,
are all ultimately represented as Mathematica expressions. With the standard notebook front
end, you can use the command Show Expression to see the text of the Mathematica expres-

sion that corresponds to any particular cell.

Show Expression menu item toggle between displayed form and underlying Mathemat-
ica expression

Ctrl+* or Ctrl+8 (between existing put up a dialog box to allow input of a cell in Mathematica

cells) expression form

Handling Cell expressions in the notebook front end.

Here is a cell displayed in its usual way in the front end.

This is a text cell. ]

Here is the underlying Mathematica expression that corresponds to the cell.

Cell|"This is a text cell.”, "Text"] ]
Cell [contents, "style" ] a cell with a specific style
Cell [contents, "style" , options ] a cell with additional options specified
Cell [contents, "style,", a cell with several styles

"style," , ..., options]
Mathematica expressions corresponding to cells in notebooks.

Within a given notebook, there is always a collection of styles that can be used to determine
the appearance and behavior of cells. Typically the styles are named so as to reflect what role

cells which have them will play in the notebook.
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"Title" the title of the notebook
"Section" a section heading
"Subsection" a subsection heading
"Text" ordinary text

"Input" Mathematica input
"Output" Mathematica output

Some typical cell styles defined in notebooks.

Here are several cells in different styles.

This is a Section Style H
This 1s a text style. 3 ‘
This is Input style jj

Here are the expressions that correspond to these cells.

Cell ["This is a Section Style”, "Section"] ]
Cell ["This is a text style.”, "Text"]
Cell [BoxData|

RowBox|{ "This", " ", "is", " ", "Input", ", "style", "."1]], "Input”]

A particular style such as "Section" or "Text" defines various settings for the options associ-
ated with a cell. You can override these settings by explicitly setting options within a specific
cell.

Here is the expression for a cell in which options are set to use a gray background and to put a
frame around the cell.

CellFrame->True,

Cell ["This is some text."”, "Text"”,
Background->GrayLevel[0.8]] }

This is how the cell looks in a notebook.

This is some text. }
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option default value

CellFrame False whether to draw a frame around the cell

Background Automatic what color to draw the background for the
cell

Editable True whether to allow the contents of the cell to
be edited

TextAlignment Left how to align text in the cell

FontSize 12 the point size of the font for text

CellTags {} tags to be associated with the cell

A few of the large humber of possible options for cells.

The standard notebook front end for Mathematica provides several ways to change the options
of a cell. In simple cases, such as changing the size or color of text, there will often be a spe-
cific menu item for the purpose. But in general you can use the Option Inspector that is built
into the front end. This is typically accessed using the Option Inspector menu item in the
Format menu.

= Change settings for specific options with menus.
» Look at and modify all options with the Option Inspector.
= Edit the textual form of the expression corresponding to the cell.

= Change the settings for all cells with a particular style.
Ways to manipulate cells in the front end.

Sometimes you will want just to change the options associated with a specific cell. But often
you may want to change the options associated with all cells in your notebook that have a
particular style. You can do this by using the Edit Stylesheet command in the front end to
create a custom stylesheet associated with your notebook. Then use the controls in the
stylesheet to create a cell corresponding to the style you want to change and modify the
options for that cell.

CellPrint[Cell][...]] insert a cell into your currently selected notebook
CellPrint[{Cell]| insert a sequence of cells into your currently selected
...],Cell[...],...}] notebook

Inserting cells into a notebook.
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This inserts a section cell into the current notebook.
CellPrint[Cell["The heading"”, "Section"]]

The heading ]

This inserts a text cell with a frame around it.
CellPrint[Cell["Some text", "Text", CellFrame -> True]]

The heading w

Some text 1 ‘

CellPrint allows you to take a raw cell expression and insert it into your current notebook.
The cell created by cellprint is grouped with the input and will be overwritten if the input is

reevaluated.

Notebooks as Mathematica Expressions

Notebook [ {cell; ,celly, ...} ] a notebook containing a sequence of cells

Notebook [cells, options] a notebook with options specified

Expressions corresponding to notebooks.

Here is a simple Mathematica notebook.

Section heading H
Some text. ] ‘

More text. 3 _‘
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Here is the expression that corresponds to this notebook.

Notebook[ {
Cell["Section heading", "Section"],
Cell["Some text.", "Text"],
Cell[ "More text.", "Text"]}]

Just like individual cells, notebooks in Mathematica can also have options. You can look at and

modify these options using the Option Inspector in the standard notebook front end.

option default value

WindowSize {nx,ny} the size in pixels of the window used to
display the notebook

WindowFloating False whether the window should float on top of
others

WindowToolbars {} what toolbars to include at the top of the
window

ShowPageBreaks False whether to show where page breaks would
occur if the notebook were printed

CellGrouping Automatic how to group cells in the notebook

Evaluator "Local" what kernel should be used to do evalua-
tions in the notebook

Saveable True whether a notebook can be saved

A few of the large number of possible options for notebooks.

A notebook with the option setting saveable -> False can always be saved using the Save As
menu item, but does not respond to Save and does not prompt for saving when it is closed.

In addition to notebook options, you can also set any cell option at the notebook level. Doing
this tells Mathematica to use that option setting as the default for all the cells in the notebook.
You can override the default by explicitly setting the options within a particular cell or by using

a named style which explicitly overrides the option.

Here is the expression corresponding to a notebook with a ruler displayed in the toolbar at the
top of the window.
Notebook[ {
Cell["Section heading", "Section"],
Cell["Some text.", "Text"]},
WindowToolbars->{"RulerBar"}]
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This is what the notebook looks like in the front end.

%—"( intro.nb E]@
I1 1 1 1 |2 1 1 1 |3 1 1 1 |" 1 1 1 |5 1 1 1 |s 1 1 1 |T 1 1 “ |A
™ -

Section heading 117
Some text. 3 »

M
100% = [<| M | 2]

This sets the default background color for all cells in the notebook.

Notebook[ {
Cell["Section heading", "Section"],
Cell["Some text.", "Text"]},
Background->GrayLevel[.7]]

Now each cell has a gray background.

Sectionheading
I |

If you go outside of Mathematica and look at the raw text of the file that corresponds to a
Mathematica notebook, you will find that what is in the file is just the textual form of the expres-
sion that represents the notebook. One way to create a Mathematica notebook is therefore to

construct an appropriate expression and put it in a file.

In notebook files that are written out by Mathematica, some additional information is typically
included to make it faster for Mathematica to read the file in again. The information is enclosed
in Mathematica comments indicated by («...x) so that it does not affect the actual expression

stored in the file.
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NotebookOpen [ " file.nb" ] open a notebook file in the front end
NotebookPut [expr] create a notebook corresponding to expr in the front end
NotebookGet [0bj] get the expression corresponding to an open notebook in

the front end

Setting up notebooks in the front end from the kernel.

This writes a notebook expression out to the file sample.nb.

Notebook[{Cell["Section heading", "Section"], Cell["Some text.", "Text"]}] >>
"sample.nb"

This reads the notebook expression back from the file.
<< sample.nb

Notebook [ {Cell[Section heading, Section], Cell[Some text., Text]}]

This opens sample.nb as a notebook in the front end.
NotebookOpen["sample.nb"];

Section heading H
y

Some text.

Once you have set up a notebook in the front end using NotebookOpen, you can then manipu-
late the notebook interactively just as you would any other notebook. But in order to use
NotebookOpen, you have to explicitly have a notebook expression in a file. With NotebookPut,
however, you can take a notebook expression that you have created in the kernel, and immedi-

ately display it as a notebook in the front end.

Here is a notebook expression in the kernel.
Notebook[{Cell["Section heading", "Section"], Cell["Some text.", "Text"]}]

Notebook[{Cell[Section heading, Section], Cell[Some text., Text]}]
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This uses the expression to set up a notebook in the front end.
NotebookPut [%]

Section heading H
]

L

Some text.

You can use NotebookGet to get the notebook corresponding to a particular
NotebookObject back into the kernel.

NotebookGet [%]

Notebook|[ {Cell[CellGroupData|
{Cell[TextData[Section heading], Section], Cell[TextData[Some text.], Text]}, Open]]}]

Manipulating Notebooks from the Kernel

If you want to do simple operations on Mathematica notebooks, then you will usually find it
convenient just to use the interactive capabilities of the standard Mathematica front end. But if
you want to do more complicated and systematic operations, then you will often find it better to

use the kernel.

Notebooks [ ] a list of all your open notebooks

Notebooks [ "name" ] a list of all open notebooks with the specified name
InputNotebook [] the notebook into which typed input will go
EvaluationNotebook [ ] the notebook in which this function is being evaluated
ButtonNotebook[ ] the notebook containing the button (if any) which initiated

this evaluation
Functions that give the notebook objects corresponding to particular notebooks.

Within the Mathematica kernel, notebooks that you have open in the front end are referred to
by notebook objects of the form NotebookObject|fe, id]. The first argument of
NotebookObject specifies the FrontEndObject for the front end in which the notebook resides,

while the second argument gives a unique serial number for the notebook.
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Here is a notebook named Example.nb.

B First Heading ]
® Second Heading ]
This finds the corresponding notebook object in the front end.
Notebooks [ "Example.nb"]
{NotebookObject[<<Example.nb>>]}
This gets the expression corresponding to the notebook into the kernel.
NotebookGet [First[%] ]
Notebook[ {Cell[First Heading, Section],
Cell[Second Heading, Section]}]
This replaces every occurrence of the string "Section" by "Text".
% /. "Section" -> "Text"
Notebook[{Cell[First Heading, Text],
Cell[Second Heading, Text]}]
This creates a new modified notebook in the front end.
NotebookPut [%]
First Heading 3
Second Heading j
{NotebookObject[<<Untitled-1.nb>>]}
NotebookGet [0bj] get the notebook expression corresponding to the note-
book object obj
NotebookPut [expr,obj] replaces the notebook represented by the notebook object
obj with one corresponding to expr
NotebookPut [expr] creates a notebook corresponding to expr and makes it the

currently selected notebook in the front end

Exchanging whole notebook expressions between the kernel and front end.
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If you want to do extensive manipulations on a particular notebook you will usually find it
convenient to use NotebookGet to get the whole notebook into the kernel as a single expres-
sion. But if instead you want to do a sequence of small operations on a notebook, then it is
often better to leave the notebook in the front end, and then to send specific commands from
the kernel to the front end to tell it what operations to do.

Mathematica is set up so that anything you can do interactively to a notebook in the front end

you can also do by sending appropriate commands to the front end from the kernel.

Options [0bj] give a list of all options set for the notebook corresponding
to notebook object obj

Options [0bj, option] give the option setting

AbsoluteOptions [obj, option] give the option setting with absolute option values even
when the actual setting is Automatic

CurrentValue [obj, option] give and set the value of option

SetOptions [obj, option->value] set the value of an option

Finding and setting options for notebooks.

This gives the setting of the WindowSize option for your currently selected notebook.
Options [InputNotebook[], WindowSize]

{WindowSize - {250., 100.}}

This changes the size of the currently selected notebook on the screen.
SetOptions[InputNotebook[], WindowSize -> {250, 100}]

First Heading ]

Second Heading )

{WindowSize -» {250., 100.}}

Alternatively, use CurrentValue to directly get the value of the WindowSize option.
CurrentValue[InputNotebook[], WindowSize]

{WindowSize - {250., 100.}}
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This changes the option using Currentvalue with a simple assignment.
CurrentValue[InputNotebook[], WindowSize] = {400, 300}

First Heading )

Second Heading ]

Within any open notebook, the front end always maintains a current selection. The selection
can consist for example of a region of text within a cell or of a complete cell. Usually the selec-
tion is indicated on the screen by some form of highlighting. The selection can also be between
two characters of text, or between two cells, in which case it is usually indicated on the screen

by a vertical or horizontal insertion bar.

You can modify the current selection in an open notebook by issuing commands from the kernel.

SelectionMove [0bj,Next , unit] move the current selection to make it be the next unit of
the specified type

SelectionMove [0bj,Previous,unit] move to the previous unit

SelectionMove [0bj,After, unit] move to just after the end of the present unit of the
specified type

SelectionMove [0bj,Before, unit] move to just before the beginning of the present unit

SelectionMove |obj,ALL, unit] extend the current selection to cover the whole unit of the

specified type

Moving the current selection in a notebook.
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Character individual character

Word word or other token

Expression complete subexpression

TextLine line of text

TextParagraph paragraph of text

GraphicsContents the contents of the graphic

Graphics graphic

CellContents the contents of the cell

Cell complete cell

CellGroup cell group

EvaluationCell cell associated with the current evaluation
ButtonCell cell associated with any button that initiated the evaluation
GeneratedCell cell generated by the current evaluation
Notebook complete notebook

Units used in specifying selections.

Here is a simple notebook.

® Here is a ([ cell. ]

B Here is a second cell. ]

This sets nb to be the notebook object corresponding to the current input notebook.
nb = InputNotebook[];

This moves the current selection within the notebook to be the next word.
SelectionMove [nb, Next, Word]

m Here is a first (. ]

B Here is a second cell. ]
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This extends the selection to the complete first cell.
SelectionMove[nb, All, Cell]

B Here is a first cell.

B Here is a second cell. ]

This puts the selection at the end of the whole notebook.
SelectionMove[nb, After, Notebook]

B Here is a first cell. ]
B Here is a second cell. ]
NotebookFind [0bj,data] move the current selection to the next occurrence of the

specified data in a notebook
NotebookFind [obj,data,Previous] move to the previous occurrence
NotebookFind [obj,data,A11 | make the current selection cover all occurrences

NotebookFind [obj,data,dir , elems] search in the specified elements of each cell, going in
direction dir

NotebookFind [obj, "text" ,IgnoreCase —>True]

do not distinguish uppercase and lowercase letters in text

Searching the contents of a notebook.

This moves the current selection to the position of the previous occurrence of the word cell.

NotebookFind[nb, "cell", Previous]

B Here is a first 2]. ]

B Here is a second cell. ]
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The letter @ does not appear in the current notebook, so $Failed is returned, and the selection
is not moved.
NotebookFind[nb, "a", Next]

B Here is a first [Z]. ]
B Here is a second cell. ]
$Failed
CellContents contents of each cell
Cellstyle the name of the style for each cell
CellLabel the label for each cell
CellTags tags associated with each cell
{elem; ,elem;, ...} several kinds of elements

Possible elements of cells to be searched by NotebookFind.

In setting up large notebooks, it is often convenient to insert tags which are not usually dis-
played, but which mark particular cells in such a way that they can be found using
NotebookFind. You can set up tags for cells either interactively in the front end, or by explicitly

setting the cellTags option for a cell.

NotebookLocate [ "tag" ] locate and select cells with the specified tag in the current
notebook
NotebookLocate [ {" file", "tag"} ] open another notebook if necessary

Globally locating cells in notebooks.

NotebookLocate is typically the underlying function that Mathematica calls when you follow a
hyperlink in a notebook. The Insert » Hyperlink menu item sets up the appropriate

NotebookLocate as part of the script for a particular hyperlink button.
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NotebookWrite [obj,data] write data into a notebook at the current selection
NotebookApply [obj,data] write data into a notebook, inserting the current selection
in place of the first m that appears in data
NotebookDelete [0bj] delete whatever is currently selected in a notebook
NotebookRead [0bj] get the expression that corresponds to the current selec-

tion in a notebook
Writing and reading in notebooks.

NotebookWrite [obj, data] is similar to a Paste operation in the front end: it replaces the cur-
rent selection in your notebook by data. If the current selection is a cell
NotebookWrite [obj, data] Will replace the cell with data. If the current selection lies between

two cells, however, then NotebookWrite [0bj, data] will create an appropriate new cell or cells.

Here is a notebook with a word of text selected.

m Here is a first (. ]

B Here is a second cell. ]

This replaces the selected word by new text.

NotebookWrite[nb, "<<inserted text>>"]

B Here is a first EEINFENCHEET S . 1

B Here is a second cell. ]

This moves the current selection to just after the first cell in the notebook.
SelectionMove[nb, After, Cell]

B Here is a first <<inserted text>>. ]

B Here is a second cell. ]




160 | Notebooks and Documents

This now inserts a text cell after the first cell in the notebook.
NotebookWrite[nb, Cell["This cell contains text.", "Text"]]

B Here is a first <<inserted text>>. j}

This cell contains text. jJ

m Here is a second cell. ]

This makes the current selection be the next cell in the notebook.
SelectionMove[nb, Next, Cell]

B Here is a first <<inserted text>>. ﬂ
This cell contains text. j,‘
m Here is a second cell.

This reads the current selection, returning it as an expression in the kernel.
NotebookRead [nb]

B Here is a first <<inserted text>>. ﬂ
]

This cell contains text.

m Here is a second cell.

)

Cell [Here is a second one., Section]

NotebookWrite [obj, data] just discards the current selection and replaces it with data. But
particularly if you are setting up palettes, it is often convenient first to modify data by inserting
the current selection somewhere inside it. You can do this using selection placeholders and
NotebookApply. The first time the character "w", entered as \ [SelectionPlaceholder] or Esc
spl Esc, appears anywhere in data, NotebookApply Will replace this character by the current

selection.
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Here is a simple notebook with the current selection being the contents of a cell.

nb = InputNotebook|[];

Expand| (1+)°] ]

This replaces the current selection by a string that contains a copy of its previous form.

NotebookApply[nb, "x + 1/m"]

x+1/Expand[(1+x)“] ]
SelectionEvaluate [0bjf] evaluate the current selection in place
SelectionCreateCell [obj] create a new cell containing just the current selection
SelectionEvaluateCreateCell | evaluate the current selection and create a new cell for the
obj] result
SelectionAnimate [0bj] animate graphics in the current selection
SelectionAnimate [0bj, ] animate graphics for ¢ seconds

Operations on the current selection.

This makes the current selection be the whole contents of the cell.
SelectionMove[nb, All, CellContents]

+1 /Expand | (1+)* | ]

This evaluates the current selection in place.

SelectionEvaluate[nb]

1
X+ - W
l+dx+bx?+ax?sx? J

SelectionEvaluate allows you to take material from a notebook and send it through the kernel
for evaluation. On its own, however, SelectionEvaluate always overwrites the material you
took. But by using functions like SelectionCreateCell you can maintain a record of the

sequence of forms that are generated—just like in a standard Mathematica session.
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This makes the current selection be the whole cell.
SelectionMove[nb, All, Cell]

1 =
X+ -
l+dx+6x? +dax?sxt

This creates a new cell, and copies the current selection into it.
SelectionCreateCell [nb]

: l
X+ - -
ledx+6x?edxtyx? i
: w
S —
1+4x+6x2+4ax?sxd

This wraps Factor around the contents of the current cell.
NotebookApply[nb, "Factor[m]"]

1 W
X+ -
ledx+6x?edx?yx? ]
1 :
Factor[x+ - w
ledx+bx?sdn eyt

This evaluates the contents of the current cell, and creates a new cell to give the result.

SelectionEvaluateCreateCell [nb]

1 9
X+

l+dx+6x?+4x?sx?

1 9
Factor[x+ - ]
l+dx+6x?+4x?ext

ledx+bx?sdxsxtsx®

(1+x)¢

Functions like NotebookWrite and SelectionEvaluate by default leave the current selection
just after whatever material they insert into your notebook. You can then always move the
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selection by explicitly using SelectionMove. But functions like NotebookWrite and
SelectionEvaluate can also take an additional argument which specifies where the current

selection should be left after they do their work.

NotebookWrite [obj,data, sel] write data into a notebook, leaving the current selection as
specified by sel

NotebookApply [obj,data, sel] write data replacing m by the previous current selection,
then leaving the current selection as specified by sel

SelectionEvaluate [obj, sel] evaluate the current selection, making the new current
selection be as specified by sel

SelectionCreateCell [obj, sel] create a new cell containing just the current selection, and
make the new current selection be as specified by sel

SelectionEvaluateCreateCell [obj, sel]

evaluate the current selection, make a new cell for the
result, and make the new current selection be as specified
by sel

Performing operations and specifying what the new current selection should be.

After immediately after whatever material is inserted (default)
Before immediately before whatever material is inserted

All the inserted material itself

Placeholder the first m in the inserted material

None leave the current selection unchanged

Specifications for the new current selection.

Here is a blank notebook.
nb = InputNotebook[];

This writes 10 ! into the notebook, making the current selection be what was written.

NotebookWrite[nb, "10!", All]

101 J
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This evaluates the current selection, creating a new cell for the result, and making the current
selection be the whole of the result.

SelectionEvaluateCreateCell [nb, All]

10!

3628 800 J
This wraps FactorInteger around the current selection.
NotebookApply[nb, "FactorInteger[m]", All]

10!

FactorInteger[3 628 800] 3

This evaluates the current selection, leaving the selection just before the result.

SelectionEvaluate[nb, Before]

10!
{{z, 8}, {3, 4}, {5, 2}, {7, 1}} 3
This now inserts additional text at the position of the current selection.
NotebookWrite[nb, "a = "]
10!
a={{2, 8}1 {3, 4}1 {5, z)l {7, 1}} ]
Options [obj, option] find the value of an option for a complete notebook
Options [NotebookSelection [obj] ,option]
find the value for the current selection
SetOptions [obj, option->value] set the value of an option for a complete notebook

SetOptions [NotebookSelection [0bj] , option->value]

set the value for the current selection

Finding and setting options for whole notebooks and for the current selection.
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Make the current selection be a complete cell.
SelectionMove[nb, All, Cell]

10! 3
a={{2, 8}, {3, 4}, {5, 2}, {7, 1}}
Put a frame around the cell that is the current selection.
SetOptions [NotebookSelection[nb], CellFrame -> True]
10! 3

a={{2, 8}, {3, 4}, {5, 2}, {7, 1}}

CreateWindow| ] create a new notebook

CreateWindow [options] create a notebook with specified options

NotebookOpen [ "name" ] open an existing notebook

NotebookOpen [ "name" , options ] open a notebook with specified notebook options

SetSelectedNotebook [0bj] make the specified notebook the selected one

NotebookPrint [obj] send a notebook to your printer

NotebookPrint [obj, " file" ] send a PostScript version of a notebook to a file

NotebookPrint [obj, " ! command" ] send a PostScript version of a notebook to an external
command

NotebookSave [0bj] save the current version of a notebook in a file

NotebookSave [0bj, " file" ] save the notebook in a file with the specified name

NotebookClose [0bj] close a notebook

Operations on whole notebooks.

If you call Createwindow[] @ new empty notebook will appear on your screen.

By executing commands like setSelectedNotebook and NotebookOpen, you tell the Mathemat-
ica front end to change the windows you see. Sometimes you may want to manipulate a note-
book without ever having it displayed on the screen. You can do this by using the option setting

Visible -> False in NotebookOpen Or CreateWindow.
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Manipulating the Front End from the Kernel

SFrontEnd the front end currently in use

Options [$FrontEnd, option | the setting for a global option in the front end

AbsoluteOptions [ the absolute setting for an option
$FrontEnd, option]

SetOptions [ reset an option in the front end

$FrontEnd, option- >value]

CurrentValue [sFrontEnd, option} return option value, and also allow setting of option when
used as the left-hand side of an assignment

Manipulating global options in the front end.

Just like cells and notebooks, the complete Mathematica front end has various options, which
you can look at and manipulate from the kernel.

This gives the object corresponding to the front end currently in use.
SFrontEnd

- FrontEndObject -

This gives the current directory used by the front end for notebook files.

Options[$FrontEnd, NotebookBrowseDirectory]

{NotebookBrowseDirectoryeC:\Documents and Settings\All Users\Documents}

option default value

NotebookBrowseDirectory (system the default directory for opening and saving
dependent) notebook files

NotebookPath (system the path to search when trying to open
dependent) notebooks

Language "English" default language for text

MessageOptions (list of settings) how to handle various help and warning

messages

A few global options for the Mathematica front end.



Notebooks and Documents | 167

By using NotebookWrite you can effectively input to the front end any ordinary text that you
can enter on the keyboard. FrontEndTokenExecute allows you to send from the kernel any
command that the front end can execute. These commands include both menu items and con-

trol sequences.

FrontEndTokenExecute [ "name" ] execute a named command in the front end

Executing a named command in the front end.

"Indent" indent all selected lines by one tab

"NotebookStatisticsDialog" display statistics about the current notebook

"OpenCloseGroup"” toggle a cell group between open and closed

"CellSplit" split a cell in two at the current insertion point

"DuplicatePreviousInput" create a new cell which is a duplicate of the nearest input
cell above

"FindDialog" bring up the Find dialog

"ColorSelectorDialog" bring up the Color Selector dialog

"GraphicsAlign" align selected graphics

"CompleteSelection" complete the command name that is the current selection

A few named commands that can be given to the front end. These commands usually correspond to menu
items.

Front End Tokens

Front end tokens let you perform kernel commands that would normally be done using the
menus. Front end tokens are particularly convenient for writing programs to manipulate

notebooks.

FrontEndToken is a kernel command that identifies its argument as a front end token.
FrontEndExecute is a kernel command that sends its argument to the front end for execution.

For example, the following command creates a new notebook.

FrontEndExecute [FrontEndToken["New"]]

FrontEndExecute can take a list as its argument, allowing you to execute multiple tokens in a
single evaluation. When you evaluate the following command, the front end creates a new

notebook and then pastes the contents of the clipboard into that notebook.

FrontEndExecute [ {FrontEndToken["New"], FrontEndToken["Paste"]}]
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Simple and Compound Front End Tokens

Front end tokens are divided into two classes: simple tokens and compound tokens that take

parameters.

For simple tokens, FrontEndToken can have one or two arguments.

If FrontEndToken has one argument, the token operates on the input notebook. The following

examples use the front end token "save". The result is the same as using File » Save.
FrontEndExecute [FrontEndToken["Save"]]

With two arguments, the arguments of FrontEndToken must be a NotebookObject and a front

end token. For example, to save the notebook containing the current evaluation, the first argu-

ment of FrontEndToken is the notebook object EvaluationNotebook , and the second argu-

ment is the front end token "save".

FrontEndExecute [FrontEndToken [FrontEnd EvaluationNotebook[], "Save"]]

You can execute a simple, one-argument front end token with the command
FrontEndTokenExecute [foken]. This is equivalent to FrontEndExecute [FrontEndToken [token] ].
For example, the following command will save the input notebook.

FrontEndTokenExecute["Save"]

Compound tokens have a token parameter that controls some aspect of their behavior. For a
compound token, the three arguments of FrontEndToken must be a NotebookObject, the front

end token, and the selected token parameter.

For example, this saves the selected notebook as plain text.

FrontEndExecute[
{FrontEndToken [FrontEnd InputNotebook[], "SaveRenameSpecial", "Text"]}]
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Executing Notebook Commands Directly in the Front
End

When you execute a command like NotebookWrite [obj, data] the actual operation of inserting
data into your notebook is performed in the front end. Normally, however, the kernel is needed
in order to evaluate the original command, and to construct the appropriate request to send to
the front end. But it turns out that the front end is set up to execute a limited collection of

commands directly, without ever involving the kernel.

NotebookWrite [obj,data] version of NotebookWrite to be executed in the kernel
FrontEnd NotebookWrite [obj,data]

version of NotebookWrite to be executed directly in the
front end

Distinguishing kernel and front end versions of commands.

The basic way that Mathematica distinguishes between commands to be executed in the kernel
and to be executed directly in the front end is by using contexts. The kernel commands are in

the usual system™ context, but the front end commands are in the FrontEnd™~ context.

FrontEndExecute [expr] send expr to be executed in the front end

Sending an expression to be executed in the front end.

Here is a blank notebook.

This uses kernel commands to write data into the notebook.
NotebookWrite[SelectedNotebook[], "x + y + z"]

X+V+2 3
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In the kernel, these commands do absolutely nothing.
FrontEnd NotebookWrite[FrontEnd SelectedNotebook[], "a + b + ¢ + d"]

K+4y+2Z 3

If they are sent to the front end, however, they cause data to be written into the notebook.
FrontEndExecute[%]

X+y+2

a+b+ced b

If you write sophisticated programs for manipulating notebooks, then you will have no choice
but to execute these programs primarily in the kernel. But for the kinds of operations typically
performed by simple buttons, you may find that it is possible to execute all the commands you

need directly in the front end—without the kernel even needing to be running.

The Structure of Cells

Cell [contents, "style" ] a cell in a particular style
Cell [contents, "style," , "style," , ...] a cell with multiple styles
Cell [contents, "style" , options ] a cell with additional options set

Expressions corresponding to cells.

Here is a notebook containing a text cell and a Mathematica input cell.

Here is some ordinary text. i

x*/y

()

Here are the expressions corresponding to these cells.

Cell ["Here is some ordinary text.”, "Text"] i
Cell [BoxData|
ROWBOX |
SuperscriptBox|["x", "\ [Alpha|"], "/", "¥"}!]], "Input”
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Here is a notebook containing a text cell with Mathematica input inside.

Text with the formula xyz™ inside. ]

This is the expression corresponding to the cell. The Mathematica input is in a cell embedded
inside the text.

Cell [TextData|
"Text with the formula ",
Cell [BoxData|

SuperscriptBox|"xyz", "\[Alpha]"]]],

" inside."

|, "Text”,

GeneratedCell ->False]|
"text" plain text
TextData [ {text|,text, ...} ] text potentially in different styles, or containing cells
BoxData [boxes] formatted Mathematica expressions
GraphicsDatal[ "type" ,data] graphics or sounds
OutputFormData [ "itext", "otext" ] text as generated by InputForm and OutputForm
RawData [ "data" ] unformatted expressions as obtained using Show

Expression

CellGroupData [ an open group of cells

{celly,cell,,...} ,Open]

CellGroupData [ a closed group of cells
{celly,cell,,...} ,Closed]

StyleDatal[ "style" ] a style definition cell

Expressions representing possible forms of cell contents.

Styles and the Inheritance of Option Settings

Global the complete front end and all open notebooks
Notebook the current notebook

Style the style of the current cell

Cell the specific current cell

Selection a selection within a cell

The hierarchy of levels at which options can be set.
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Here is a notebook containing three cells.

First Section H
Some text in the first section. ]
Some more text in the first section. j|

This is what happens when the setting CellFrame -> True is made specifically for the third
cell.

First Section

Some more text in the first section.

T

Some text in the first section. ]

This is what happens when the setting CellFrame -> True is made globally for the whole

notebook.
First Section ]
Some text in the first section. ]
Some more text in the first section. ]

This is what happens when the setting is made for the "Section" style.

First Section ]

Some text in the first section. il

Some more text in the first section. i
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In the standard notebook front end, you can check and set options at any level by using the
Option Inspector menu item. If you do not set an option at a particular level, then its value
will always be inherited from the level above. Thus, for example, if a particular cell does not set
the cellFrame option, then the value used will be inherited from its setting for the style of the
cell or for the whole notebook that contains the cell.

As a result, if you set CellFrame -> True at the level of a whole notebook, then all the cells in
the notebook will have frames drawn around them—unless the style of a particular cell, or the
cell itself, explicitly overrides this setting.

= Choose the basic default styles for a notebook
m Choose the styles for screen and printing style environments
» Edit specific styles for the notebook

Ways to set up styles in a notebook.

Depending on what you intend to use your Mathematica notebook for, you may want to choose
different basic default styles for the notebook. In the standard notebook front end, you can do
this by selecting a different stylesheet in the Stylesheet menu or by using the Edit
Stylesheet menu item.

"StandardReport" styles for everyday work and for reports
"NaturalColor" styles for colorful presentation of everyday work
"Outline" styles for outlining ideas

"Notepad" styles for working with plain text documents

Some typical choices of basic default styles.

With each choice of basic default styles, the styles that are provided will change. Thus, for
example, the Notepad stylesheet provides a limited number of styles since it is designed to

work with plain text documents.
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Here is a notebook that uses NaturalColor default styles.

Riccati Equations

A Riccatl equation is a first-order equation of the form

(Y] e
i

¥ (3) = Fx)+ g(x) vix) + h(x) wix).

This equation was used by Count Riccati of Venice (1676-1754) to help in solving
second-order ordinary differential equations.

L

Solving Riccati equations is considerably more difficult than solving linear ODEs.

[T '

Here is a simple Riccati equation for which the solution is available in closed form:

n[1]= DSolve[y'[x] +(2/x°2)=-3y([x]"2=0, y[x], x] // Simplify

T —
L

[ 3x*-zc(1]
Cut[1]= ‘ ‘Y[xl 4 ‘_—‘ |'
3X"+3xXC[1]
option default value
ScreenStyleEnvironment "Working" the style environment to use for display on
the screen
PrintingStyleEnvironment "Printout" the style environment to use for printed
output

Options for specifying style environments.

Within a particular set of basic default styles, Mathematica allows for two different style environ-
ments: one for display on the screen, and another for output to a printer. The existence of
separate screen and printing style environments allows you to set up styles which are sepa-
rately optimized both for low-resolution display on a screen, and high-resolution printing.

"Working" onscreen working environment

"Presentation” onscreen environment for presentations
"Condensed" onscreen environment for maximum display density
"Slideshow" onscreen environment for displaying slides
"Printout"” paper printout environment

Some typical settings for style environments.
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The way that Mathematica actually sets up the definitions for styles is by using style definition
cells. These cells can either be given in separate stylesheet notebooks, or can be included in the
options of a specific notebook. In either case, you can access style definitions by using the Edit
Stylesheet menu item in the standard notebook front end.

Options for Cells

Mathematica provides a large number of options for cells. All of these options can be accessed
through the Option Inspector menu item in the front end. They can be set either directly at

the level of individual cells or at a higher level, to be inherited by individual cells.

option typical default

value
CellDingbat None a dingbat to use to emphasize the cell
CellFrame False whether to draw a frame around the cell
Background None the background color for the cell
ShowCellBracket True whether to display the cell bracket
Magnification 1. the magnification at which to display the

cell

CellOpen True whether to display the contents of the cell

Some basic cell display options.

This creates a cell in "Section" style with default settings for all options.
CellPrint[Cell["A Heading", "Section"]]

A Heading 1
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This creates a cell with dingbat and background options modified.

CellPrint|

Cell["A Heading", "Section", CellDingbat -> "@", Background -> GrayLevel[.7]]]

A Heading

® A Heading

option typical default
value
CellMargins {{7,0},{4,4}} outer margins in printer's points to leave
around the contents of the cell
CellFrameMargins 8 margins to leave inside the cell frame
CellElementSpacings list of rules details of the layout of cell elements
CellBaseline Baseline how to align the baseline of an inline cell

Options for cell positioning.

The option cellMargins allows you to specify both horizontal and vertical margins to put
around a cell. You can set the horizontal margins interactively by using the margin stops in the

with text around it

ruler displayed when you choose the Show Ruler menu item in the front end.

Whenever an option can refer to all four edges of a cell, Mathematica follows the convention
that the setting for the option takes the form {{left, right}, {bottom, top}}. By giving nonzero
values for the top and borrom elements, CellMargins can specify gaps to leave above and below

a particular cell. The values are always taken to be in printer's points.
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This leaves 50 points of space on the left of the cell, and 20 points above and below.
CellPrint[Cell["First text", "Text", CellMargins -> {{50, 0}, {20, 20}}]]

A Heading ]
® A Heading H
First text ] ‘

Almost every aspect of Mathematica notebooks can be controlled by some option or another.
More detailed aspects are typically handled by "aggregate options" such as
CellElementSpacings. The settings for these options are lists of Mathematica rules, which
effectively give values for a sequence of suboptions. The names of these suboptions are usually
strings rather than symbols.

This shows the settings for all the suboptions associated with CellElementSpacings.
Options[SelectedNotebook[], CellElementSpacings]

{CellElementSpacings » {CellMinHeight - 12., ClosedCellHeight - 19.,
ClosedGroupTopMargin - 4., GroupIconTopMargin - 3., GroupIconBottomMargin —» 12.}}
Mathematica allows you to embed cells inside pieces of text. The option CellBaseline deter-
mines how such "inline cells" will be aligned vertically with respect to the text around them. In
direct analogy with the option BaselinePosition for a Grid, the option CellBaseline speci-
fies what aspect of the cell should be considered its baseline.

Here is a cell containing an inline formula. The baseline of the formula is aligned with the
baseline of the text around it.

X
= the - fraction
Y

Here is a cell in which the bottom of the formula is aligned with the baseline of the text around
it.

x
= the v fraction :‘
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This alignment is specified using the Cel1lBaseline -> Bottom setting.

Cell [TextData
"the ",
Cell [BoxData|
FractionBox|["x", "y7]],
CellBaseline-=Bottom]|,
" fraction"
], "Subsection”] ]
option typical default
value
CellLabel " a label for a cell
ShowCellLabel True whether to show the label for a cell
CellLabelAutoDelete True whether to delete the label if the cell is
modified
CellTags {1} tags for a cell
ShowCellTags False whether to show tags for a cell
ConversionRules {} rules for external conversions

Options for ancillary data associated with cells.

In addition to the actual contents of a cell, it is often useful to associate various kinds of ancil-
lary data with cells.

In a standard Mathematica session, cells containing successive lines of kernel input and output
are given labels of the form In[n] := and out[n] =. The option ShowCellLabel determines
whether such labels should be displayed. cellLabelAutoDelete determines whether the label
on a cell should be removed if the contents of the cell are modified. Doing this ensures that
In[n] := and out[n] = labels are only associated with unmodified pieces of kernel input and
output.

Cell tags are typically used to associate keywords or other attributes with cells, that can be
searched for using functions like NotebookFind. Destinations for hyperlinks in Mathematica
notebooks are usually implemented using cell tags.

The option ConversionRules allows you to give a list containing entries such as "TeXx" -> data
which specify how the contents of a cell should be converted to external formats. This is particu-
larly relevant if you want to keep a copy of the original form of a cell that has been converted in
Mathematica notebook format from some external format.
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option typical default
value

Deletable True whether to allow a cell to be deleted
interactively with the front end

Copyable True whether to allow a cell to be copied

Selectable True whether to allow the contents of a cell to
be selected

Editable True whether to allow the contents of a cell to
be edited

Deployed False whether the user interface in the cell is

Options for controlling interactive operations on cells.

active

The options Deletable, Copyable, Selectable and Editable allow you to control what interac-

tive operations should be allowed on cells. By setting these options to False at the notebook

level, you can protect all the cells in a notebook.

Deployed allows you to treat the contents of a cell as if they were a user interface. In a user

interface, labels are typically not selectable and controls such as buttons can be used, but not

modified. Deployed can also be set on specific elements inside a cell so that, for example, the

output of Manipulate is always deployed even if the cell it is in has the Deployed option set to

False.
option typical default
value

Evaluator "Local" the name of the kernel to use for
evaluations

Evaluatable False whether to allow the contents of a cell to
be evaluated

CellAutoOverwrite False whether to overwrite previous output when
new output is generated

GeneratedCell False whether this cell was generated from the
kernel

InitializationCell False whether this cell should automatically be

Options for evaluation.

evaluated when the notebook is opened
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Mathematica makes it possible to specify a different evaluator for each cell in a notebook. But
most often, the Evaluator option is set only at the notebook or global level, typically using the

Kernel Configuration Options menu item in the front end.

The option CellAutoOverwrite is typically set to True for styles that represent Mathematica
output. Doing this means that when you reevaluate a particular piece of input, Mathematica will
automatically delete the output that was previously generated from that input, and will over-

write it with new output.

The option GeneratedCell is set whenever a cell is generated by an external request to the
front end rather than by an interactive operation within the front end. Thus, for example, any
cell obtained as an output or side effect from a kernel evaluation will have
GeneratedCell -> True. Cells generated by low-level functions designed to manipulate note-

books directly, such as NotebookWrite and NotebookApply, do not have the GeneratedCell

option set.
option typical default
value

PageBreakAbove Automatic whether to put a page break just above a
particular cell

PageBreakWithin Automatic whether to allow a page break within a
particular cell

PageBreakBelow Automatic whether to put a page break just below a
particular cell

GroupPageBreakWithin Automatic whether to allow a page break within a

particular group of cells
Options for controlling page breaks when cells are printed.

When you display a notebook on the screen, you can scroll continuously through it. But if you
print the notebook out, you have to decide where page breaks will occur. A setting of
Automatic for a page break option tells Mathematica to make a page break if necessary; True
specifies that a page break should always be made, while False specifies that it should never
be.

Page breaks set using the PageBreakAbove and PageBreakBelow options also determine the
breaks between slides in a slide show. When creating a slide show, you will typically use a cell
with a special nhamed style to determine where each slide begins. This named style will have

one of the page-breaking options set on it.
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Additional functionality related to this tutorial has been introduced in subsequent versions
of Mathematica. For the latest information, see Text Styling.

Text and Font Options

option typical default

value
PageWidth WindowWidth how wide to assume the page to be
TextAlignment Left how to align successive lines of text
TextJustification 0 how much to allow lines of text to be

stretched to make them fit

Hyphenation False whether to allow hyphenation
ParagraphIndent 0 how many printer’s points to indent the

first line in each paragraph
General options for text formatting.

If you have a large block of text containing no explicit newline characters, then Mathematica
will automatically break your text into a sequence of lines. The option PageWwidth specifies how
long each line should be allowed to be.

WindowWidth the width of the window on the screen
PaperWidth the width of the page as it would be printed
Infinity an infinite width (no line breaking)

n explicit width given in printer’s points

Settings for the PageWidth option in cells and notebooks.

The option TextAlignment allows you to specify how you want successive lines of text to be
aligned. Since Mathematica normally breaks text only at space or punctuation characters, it is
common to end up with lines of different lengths. Normally the variation in lengths will give
your text a ragged boundary. But Mathematica allows you to adjust the spaces in successive
lines of text so as to make the lines more nearly equal in length. The setting for
TextJustification gives the fraction of extra space which Mathematica is allowed to add.
TextJustification -> 1 leads to “full justification” in which all complete lines of text are
adjusted to be exactly the same length.
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aligned on the left

Left

Right aligned on the right

Center centered

X aligned at a position x running from -1 to +1 across the

page
Settings for the TextAlignment option.

Here is text with TextAlignment -> Left and TextJustification -> 0.

=%

4% Untitled-1 *
Like other objects in Mathemafica, the cells in a notebook, and in fact the whole notebook itself, are all 1 ‘A‘
ultirnately represented as Mathemafica expressions. With the standard notebook front end, you can us the ‘ 3
cornand Show Expression to see the text of the Mafhemafica expression that cormesponds to any
particular cell. Ils
100% +

With TextAlignment -> Center the text is centered.

M=

45 Untitled-1 *

Like other ohjects in Mafhemefica, the cells in a notebook, and in fact the whole notebook itself, are all ‘A‘
ultimately represented as Mathemafica expressions. With the standard notebook front end, you can us the
corurnand Show Expression to see the text of the Mefhemafica expression that corresponds to any
particular cell | v
100% =~

TextJustification -> 1 adjusts word spacing so that both the left and right edges line up.

BEX

"A

4% Untitled-1 *
Like other ohjects in Mafhematica, the cells in a notebook, and in fact the whole notebook itself, are all
ultirately represented as Mafhemafica expressions. With the standard notebook front end, sou can us the
cormand Show Expression to see the text of the Mefhemafica expression that comesponds to any

s

particular cell.
100% =

TextJustification -> 0.5 reduces the degree of raggedness, but does not force the left

and right edges to be precisely lined up.
=

4% Untitled-1 *
Like other objects in Mathemafica, the cells ina notebook, and in fact the whole notebook itself, are all ‘A‘
ultimately represented as Mafhemafica expressions. With the standard notebook front end, you can us the
corrnand Show Expression to see the text of the Mafthemafica expression that conesponds to any
particular cell | v
100% =
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With Hyphenation -> True the text is hyphenated.

A Untitled-1 *

l=Joj&d

Like other objects in Mathemafics, the cells in a notebook, and in fact the whole notebook itself, are all
ultimately represented as Mathemafica expressions. With the standard notebook front end, you can us the
corarnand Show Expression to see the text of the Mathemafica expression that corresponds to arny particu-
lar cell.

100%

-

>

When you enter a block of text in a Mathematica notebook, Mathematica will treat any explicit

newline characters that you type as paragraph breaks. The option ParagraphIndent allows you

to specify how much you want to indent the first line in each paragraph. By giving a negative

setting for ParagraphIndent, you can make the first line stick out to the left relative to subse-

quent lines.

LineSpacing-> {c, 0}

LineSpacing-> { 0, n}

LineSpacing->{c,n}

the height of its contents

plus n printer’s points

leave space so that the total height of each line is ¢ times

make the total height of each line exactly n printer’s points

make the total height ¢ times the height of the contents

ParagraphSpacing-> {c /0 }
ParagraphSpacing-> { 0, n}

ParagraphSpacing->{c,n}

before the beginning of each paragraph

beginning of each paragraph

n printer’s points

Options for spacing between lines of text.

leave an extra space of ¢ times the height of the font

leave an extra space of exactly n printer’s points before the

leave an extra space of ¢ times the height of the font plus

Here is some text with the default setting LineSpacing -> {1, 1}, which inserts just 1
printer’s point of extra space between successive lines.

4% Untitled-1 *

=Jo/ed

Like other ohjects in Mathemafica, the cells in a notebook, and in fact the whole notebook itself, are all
ultirmately represented as Mathemafica expressions. With the standard notebook front end, you can us the
cornand Show Expression to see the text of the Mafhemafica expression that comesponds to any
particular cell.

100%

-

~
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With LineSpacing -> {1, 5} the text is “looser”.

+ Untitled-1 * =JoJed

Like other objects in Mathemafice, the cells in a notebook, and in fact the whole notebook itself, are all -
ultirmately represented as Mathemafica expressions. With the standard notebook front end, you can us the
cornand Show Expression to see the text of the Mafhemafica expression that cormesponds to any
particular cell | ]
v
100% =

LineSpacing -> {2, 0} makes the text double-spaced.

4% Untitled-1 * Q@

Like other objects in Mathemafica, the cells in a notebook, and in fact the whole notebook itself, are all -
ultirmately represented as Mathemafica expressions. With the standard notebook front end, you can us the
cormand Show Expression to see the text of the Mafhematica expression that cormesponds to any
particular cell.
R%
100% =

With LineSpacing -> {1, -2} the text is tight.

4 Untitled-1 * E]@

Like other ohjects in Mathemafica, the cells in a notebook, and in fact the whole notebook itself, are all -
ultirnately represented as Mathematica expressions. With the standard notebook front end, you can us the
cornand Show Expression to see the text of the Mafhemafica expression that cormesponds to any
particular cell |
2
100% =
option typical default
value
FontFamily "Courier" the family of font to use
FontSubstitutions {} a list of substitutions to try for font family
names
FontSize 12 the maximum height of characters in
printer’s points
FontWeight "Bold" the weight of characters to use
FontSlant "Plain" the slant of characters to use
FontTracking "Plain" the horizontal compression or expansion of
characters
FontColor GrayLevel [0] the color of characters
Background GrayLevel[1] the color of the background for each
character

Options for fonts.
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"Courier" text like this
"Times" text like this
"Helvetica" text like this

Some typical font family names.

FontWeight->"Plain" text like this
FontWeight->"Bold" text like this
FontWeight->"ExtraBold" text like this
FontSlant->"Oblique" text like this

Some settings of font options.

Mathematica allows you to specify the font that you want to use in considerable detail. Some-
times, however, the particular combination of font families and variations that you request may
not be available on your computer system. In such cases, Mathematica will try to find the
closest approximation it can. There are various additional options, such as
FontPostScriptName, that you can set to help Mathematica find an appropriate font. In addi-
tion, you can set FontSubstitutions to be a list of rules that give replacements to try for font
family names.

There are a great many fonts available for ordinary text. But for special technical characters,
and even for Greek letters, far fewer fonts are available. The Mathematica system includes
fonts that were built to support all of the various special characters that are used by Mathemat-
ica. There are three versions of these fonts: ordinary (like Times), monospaced (like Courier),
and sans serif (like Helvetica).

For a given text font, Mathematica tries to choose the special character font that matches it
best. You can help Mathematica to make this choice by giving rules for "FontSerifed" and
"FontMonospaced" in the setting for the FontProperties option. You can also give rules for
"FontEncoding" to specify explicitly from what font each character is to be taken.
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Options for Expression Input and Output

option typical default
value

AutoIndent Automatic whether to indent after an explicit Return
character is entered

DelimiterFlashTime 0.3 the time in seconds to flash a delimiter
when a matching one is entered

ShowAutoStyles True whether to show automatic style variations
for syntactic and other constructs

ShowCursorTracker True whether an elliptical spot should appear
momentarily to guide the eye if the cursor
position jumps

ShowSpecialCharacters True whether to replace \ [Name] by a special
character as soon as the ] is entered

ShowStringCharacters True whether to display " when a string is
entered

SingleLetterItalics False whether to put single-letter symbol names
in italics

ZeroWidthTimes False whether to represent multiplication by a
zero width character

InputAliases {1} additional :name: aliases to allow

InputAutoReplacements

AutoItalicWords

LanguageCategory

("osostLn, )

{"Mathematica",
!

"NaturalLangua-

ge

strings to automatically replace on input

words to automatically put in italics

what category of language to assume a cell
contains for spell checking and hyphenation

Options associated with the interactive entering of expressions.

The option singleLetterItalics is typically set whenever a cell uses TraditionalForm.

Here is an expression entered with default options for a StandardForm input cell.

e xy+15x yrr20x v 415t vl e byt 4 y® 3
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Here is the same expression entered in a cell with SingleLetterItalics -> True and
ZeroWidthTimes -> True.

¥ +6x" y+15x 20y 415 P B x e vt ?

Built into Mathematica are a large number of aliases for common special characters.
InputAliases allows you to add your own aliases for further special characters or for any other
kind of Mathematica input. A rule of the form "name" -> expr specifies that :name: should immedi-

ately be replaced on input by expr.

Aliases are delimited by explicit Esc characters. The option InputAutoReplacements allows you
to specify that certain kinds of input sequences should be immediately replaced even when they
have no explicit delimiters. By default, for example, -> is immediately replaced by —. You can
give a rule of the form "seq" -> "rhs" to specify that whenever seq appears as a token in your

input, it should immediately be replaced by rhs.

"NaturalLanguage" human natural language such as English
"Mathematica" Mathematica input

"Formula" mathematical formula

None do no spell checking or hyphenation

Settings for LanguageCategory to control spell checking and hyphenation.

The option LanguageCategory allows you to tell Mathematica what type of contents it should
assume cells have. This determines how spelling and structure should be checked, and how

hyphenation should be done.

option typical default
value
StructuredSelection False whether to allow only complete subexpres-
sions to be selected
DragAndDrop False whether to allow drag-and-drop editing

Options associated with interactive manipulation of expressions.

Mathematica normally allows you to select any part of an expression that you see on the
screen. Occasionally, however, you may find it useful to get Mathematica to allow only selec-
tions which correspond to complete subexpressions. You can do this by setting the option

StructuredSelection -> True.
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Here is an expression with a piece selected.

EPERAINEY + x) (1-x+x° - x° KRN |

With StructuredSelection -> True only complete subexpressions can ever be selected.

(-1+x) (1+x) (L-x+x® -x’ +x") (Texex® +x7 +xf) i

(=1+x) (1+x) | ) (1+x+x® +x? +x?) i

(1+3) (140 ]

Unlike most of the other options here, the DragandDrop option can only be set for the entire

front end, rather than for individual cells or cell styles.

GridBox [data, opts] give options that apply to a particular grid box
StyleBox [boxes,opts] give options that apply to all boxes in boxes
Cell [contents , opts] give options that apply to all boxes in contents

Cell [contents ,GridBoxOptions->opts]

give default options settings for all GridBox objects in
contents

Examples of specifying options for the display of expressions.

As discussed in "Textual Input and Output", Mathematica provides many options for specifying
how expressions should be displayed. By using StyleBox [boxes, opts] you can apply such
options to collections of boxes. But Mathematica is set up so that any option that you can give
to a styleBox can also be given to a complete cell object, or even a complete Notebook.
Thus, for example, options like Background and LineIndent can be given to complete cells as

well as to individual styleBox objects.

There are some options that apply only to a particular type of box, such as GridBox. Usually
these options are best given separately in each GridBox where they are needed. But some-
times you may want to specify default settings to be inherited by all GridBox objects that
appear in a particular cell. You can do this by giving these default settings as the value of the

option GridBoxOptions for the whole cell.
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For most box types named XXXBox, Mathematica provides a cell option XXXBoxOptions that
allows you to specify the default options settings for that type of box. Box types which take
options can also have their options set in a stylesheet by defining the xxx style. The stylesheets

which come with Mathematica define many such styles.

Options for Notebooks

= Use the Option Inspector menu to change options interactively.
m Use SetOptions [0bj, options] from the kernel.

m Use CreateWindow [options] to create a new notebook with specified options.

Ways to change the overall options for a notebook.

This creates a notebook displayed in a 40x30 window with a thin frame.

CreateWindow [WindowFrame -> "ThinFrame", WindowSize -> {40, 30}]

option typical default
value
StyleDefinitions "Default.nb" the basic stylesheet to use for the notebook
ScreenStyleEnvironment "Working" the style environment to use for screen
display
PrintingStyleEnvironment "Printout" the style environment to use for printing

Style options for a notebook.

In giving style definitions for a particular notebook, Mathematica allows you either to reference

another notebook, or explicitly to include the Notebook expression that defines the styles.

option typical default
value
CellGrouping Automatic how to group cells in the notebook
ShowPageBreaks False whether to show where page breaks would
occur if the notebook were printed
NotebookAutoSave False whether to automatically save the notebook

after each piece of output

General options for notebooks.
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With CellGrouping -> Automatic, cells are automatically grouped based on their style.

First text cell.

Second text cell.

Section heading

With CellGrouping -> Manual, you have to group cells by hand.

First text cell.

Second text cell.

Section heading

[T R

option typical default
value
DefaultNewCellStyle "Input" the default style for new cells created in the
notebook
DefaultDuplicateCellStyle "Input" the default style for cells created by auto-

matic duplication of existing cells

Options specifying default styles for cells created in a notebook.

Mathematica allows you to take any cell option and set it at the notebook level, thereby specify-

ing a global default for that option throughout the notebook.

option typical default
value

Editable True whether to allow cells in the notebook to be
edited

Selectable True whether to allow cells to be selected

Deletable True whether to allow cells to be deleted

ShowSelection True whether to show the current selection
highlighted

Background GrayLevel[1] what background color to use for the
notebook

Magnification 1 at what magnification to display the
notebook

PageWidth WindowWidth how wide to allow the contents of cells to be

A few cell options that are often set at the notebook level.



Notebooks and Documents | 191

Here is a notebook with the Background option set at the notebook level.

Here is some text. j
option typical default
value

Visible True whether the window should be visible on
the screen

WindowSize {Automatic, the width and height of the window in

Automatic} printer’s points

WindowMargins Automatic the margins to leave around the window
when it is displayed on the screen

WindowFrame "Normal" the type of frame to draw around the
window

WindowElements {"StatusArea", elements to include in the window

)

WindowTitle Automatic what title should be displayed for the
window

WindowMovable True whether to allow the window to be moved
around on the screen

WindowFloating False whether the window should always float on
top of other windows

WindowClickSelect True whether the window should become
selected if you click in it

DockedCells {} a list of cells specifying the content of a

docked area at the top of the window
Characteristics of the notebook window.

WindowSize allows you to specify how large you want a window to be; windowMargins allows
you to specify where you want the window to be placed on your screen. The setting
WindowMargins -> { {left, right}, {bottom, top}} gives the margins in pixels to leave around your
window on the screen. Often only two of the margins will be set explicitly; the others will be
Automatic, indicating that these margins will be determined from the particular size of screen

that you use.

WindowClickSelect is the principal option that determines whether a window acts like a
palette. Palettes are generally windows with content that acts upon other windows, rather than
windows which need to be selected for their own ends. Palettes also generally have a collection

of other option settings such as windowFloating -> True and WindowFrame -> "Palette".
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DockedCells allows you to specify any content that you want to stay at the top of a window
and never scroll offscreen. A typical use of the DockedCells option is to define a custom tool-
bar. Many default stylesheets have the DockedCells option defined in certain environments to

create toolbars for purposes such as presenting slideshows and editing package files.

"Normal" an ordinary window

"Palette" a palette window

"ModelessDialog" a modeless dialog box window

"ModalDialog" a modal dialog box window

"MovableModalDialog" a modal dialog box window that can be moved around the
screen

"ThinFrame" an ordinary window with a thin frame

"Frameless" an ordinary window with no frame at all

"Generic" a window with a generic border

Typical possible settings for WindowFrame.

Mathematica allows many different types of windows. The details of how particular windows are
rendered may differ slightly from one computer system to another, but their general form is
always the same. WindowFrame specifies the type of frame to draw around the window.

WindowElements gives a list of specific elements to include in the window.

"StatusArea" an area used to display status messages, such as those
created by StatusArea

"MagnificationPopUp" a popup menu of common magnifications

"HorizontalScrollBar" a scroll bar for horizontal motion

"VerticalScrollBar" a scroll bar for vertical motion

Some typical possible entries in the WindowElements list.
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Here is a window with a status area and horizontal scroll bar, but no magnification popup or
vertical scroll bar.

=% intro.nb [E| @]

Input v B &

1
I
il
(1]
E

Global Options for the Front End

In the standard notebook front end, Mathematica allows you to set a large number of global
options. The values of all these options are by default saved in a “preferences file”, and are
automatically reused when you run Mathematica again. These options include all the settings

which can be made using the Preferences dialog.

style definitions default style definitions to use for new notebooks
file locations directories for finding notebooks and system files
data export options how to export data in various formats

character encoding options how to encode special characters

language options what language to use for text

message options how to handle messages generated by Mathematica
dialog settings choices made in dialog boxes

system configuration private options for specific computer systems

Some typical categories of global options for the front end.

You can access global front end options from the kernel by using Options [$FrontEnd, name].
But more often, you will want to access these options interactively using the Option Inspector in

the front end.
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Mathematical and Other Notation

Mathematical Notation in Notebooks

If you use a text-based interface to Mathematica, then the input you give must consist only of
characters that you can type directly on your computer keyboard. But if you use a notebook
interface then other kinds of input become possible.

There are palettes provided which operate like extensions of your keyboard, and which have
buttons that you can click to enter particular forms. You can access standard palettes using the

Palettes menu.

Clicking the & button in this palette will enter a Pi into your notebook.

Special Characters

Letters | Symbols

xlalaja|a|a
¢ B y d e & n @
Lok A g v & o =T
P T T v x w
F © § P

4 BT A E Z H ®
I E A MNZE O II
P ZT Y T & X ¥
nF Q9 ¢ 2

s & x @ g @
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Clicking the first button in this palette will create an empty structure for entering a power. You
can use the mouse to fill in the structure.

Basic Math Assistant

» Calculator

» Basic Commands

v Typesetting ®
W wm | ox | = W

al

o om

e =T - T )

‘@ o gm = ] i [e] [m

oo (o o] EI a3

o o oo oo o

o [n] [n n] oo W
[

dp 0O Ao 0 ; ‘;

Jodo P odo Ipg O IE.o

» Help and Settings

You can also give input by using special keys on your keyboard. Pressing one of these keys
does not lead to an ordinary character being entered, but instead typically causes some action

to occur or some structure to be created.

Escp Esc the symbol 7

Escinf Esc the symbol co

EsceeEsc the symbol e for the exponential constant (equivalent to E)
EsciiEsc the symbol i for V-1 (equivalent to 1)

Escdeg Esc the symbol ° (equivalent to Degree)

Ctrl+~ or Ctrl+6 go to the superscript for a power

Ctri+/ go to the denominator for a fraction

Ctrl+@ or Ctrl+2 go into a square root

Ctrl+Space return from a superscript, denominator or square root

A few ways to enter special notations on a standard English-language keyboard.
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Here is a computation entered using ordinary characters on a keyboard.
N[Pi"2/ 6]
1.64493

Here is the same computation entered using a palette or special keys.

{2

1.64493

Here is an actual sequence of keys that can be used to enter the input.

N[ EscpEsc Ctrl+~ 2 Ctrl+Space Ctrl+/ 6 Ctrl+Space ]
1.64493

In a traditional computer language such as C, Fortran, Java or Perl, the input you give must
always consist of a string of ordinary characters that can be typed directly on a keyboard. But
the Mathematica language also allows you to give input that contains special characters, super-

scripts, built-up fractions, and so on.

The language incorporates many features of traditional mathematical notation. But you should
realize that the goal of the language is to provide a precise and consistent way to specify compu-
tations. And as a result, it does not follow all of the somewhat haphazard details of traditional

mathematical notation.

Nevertheless, as discussed in "Forms of Input and Output", it is always possible to get Mathemat
ica to produce output that imitates every aspect of traditional mathematical notation. And it is
also possible for Mathematica to import text that uses such notation, and to some extent to

translate it into its own more precise language.

Mathematical Notation in Notebooks

If you use the notebook front end for Mathematica, then you can enter some of the operations

discussed here in special ways.
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Emax f
hnin

It/

[fdx
St
Oxf
Oy f

Sum [fl {iliminlim(lx}]

Product [ f, {iiminsimax}]

Integrate[f,x]

Integrate [f, {X, Xpinr Xmax } ]

D[f,x]

D[f,x,y]

sum

product
indefinite integral
definite integral

partial derivative

multivariate partial derivative

Special and ordinary ways to enter mathematical operations in notebooks.

This one of the standard palettes for entering mathematical operations. When you click a button
in the palette, the form shown in the button is inserted into your notebook, with the black
square replaced by whatever you had selected in the notebook.

Basic Math Assistant

X

» Calculator

» Basic Commands

e .

_[ndn

v Typesetting
u” o f

*

P odo

I— ul—
YE Vam

" .

a [ ]

{mp (m

» Help and Settings
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Esc sumEsc summation sign ),

Escprod Esc product sign []

Escint Esc integral sign f

Escdd Esc special differential d for use in integrals

Esc pd Esc partial derivative 0

Ctrl+_ or Ctrl+- move to the subscript position or lower limit of an integral

Ctrl+~ or Ctrl+6 move to the superscript position or upper limit of an
integral

Ctrl++ or Ctrl+= move to the underscript position or lower limit of a sum or
product

Ctrl+& or Ctrl+7 move to the overscript position or upper limit of a sum or
product

Ctrl+% or Ctrl+5 switch between upper and lower positions

Ctrl+Space return from upper or lower positions

Ways to enter special notations on a standard English-language keyboard.

You can enter an integral like this. Be sure to use the special differential d entered as Escdd
Esc, not just an ordinary d.

jx“ dx

xl+n

l+n

Here is the actual key sequence you type to get the input.
Escint Esc x Ctrl+~ n Ctrl+Space EscddEsc x

x1+n

l+n

When entering a sum, product or integral that has limits, you can create the first limit using the
standard control sequences for subscripts, superscripts, underscripts, or overscripts. However,

you must use Ctrl+% to create the second limit.

You can enter a sum like this.
n

DX

=0

n (1+n)

N RN
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Here is the actual key sequence you type to get the input.

Esc sumEsc Ctrl+= x=0 Ctrl+% n Ctrl+Space x

1
—n (1+n)
2

Special Characters

Built into Mathematica are a large number of special characters intended for use in mathemati-

cal and other notation. "Listing of Named Characters" gives a complete listing.

Each special character is assigned a full name such as \[Infinity]. More common special
characters are also assigned aliases, such as Escinf Esc. You can set up additional aliases
using the InputAliases notebook option discussed in "Options for Expression Input and Out-
put".

For special characters that are supported in standard dialects of TeX, Mathematica also allows
you to use aliases based on TeX names. Thus, for example, you can enter \[Infinity] using
the alias Esc \infty Esc. Mathematica also supports aliases such as Esc « Esc based on names
used in SGML and HTML.

Standard system software on many computer systems also supports special key combinations
for entering certain special characters. On a Macintosh, for example, Option+5 will produce « in
most fonts. With the notebook front end Mathematica automatically allows you to use special
key combinations when these are available, and with a text-based interface you can get Mathe-
matica to accept such key combinations if you set an appropriate value for

$CharacterEncoding.

m Use a full name such as \[Infinity]

= Use an alias such as Esc inf Esc

m Use a TeX alias such as Esc \infty Esc

= Use an SGML or HTML alias such as Esc o Esc

= Click a button in a palette

= Use a special key combination supported by your computer system

Ways to enter special characters.
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In a Mathematica notebook, you can use special characters just like you use standard keyboard
characters. You can include special characters both in ordinary text and in input that you intend

to give to Mathematica.

Some special characters are set up to have an immediate meaning to Mathematica. Thus, for
example, r is taken to be the symbol pi. Similarly, = is taken to be the operator >=, while | Jis

equivalent to the function union.

st and > have immediate meanings in Mathematica.
T2 3

True

|Jor\[Union] is immediately interpreted as the Union function.

{a, b, c} U {c, 4, e}
{a, b, ¢, d, e}

| | or \[SquareUnion] has no immediate meaning to Mathematica.

{a, b, ¢} || {c, 4, e}
{a, b, c}J{c, d, e}

Among ordinary characters such as E and i, some have an immediate meaning to Mathematica,

but most do not. And the same is true of special characters.

Thus, for example, while t and «» have an immediate meaning to Mathematica, X and £ do not.
This allows you to set up your own definitions for X and .
A has no immediate meaning in Mathematica.

A[2] +A[3]
A[2] + A[3]

This defines a meaning for A.

Alx_]1 :=Vx*-1

Now Mathematica evaluates 2 just as it would any other function.
A[2] +A[3]

27 o7
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Characters such as 2 and £ are treated by Mathematica as letters—just like ordinary keyboard
letters like a or b.

But characters such as @ and | | are treated by Mathematica as operators. And although these
particular characters are not assigned any built-in meaning by Mathematica, they are neverthe-

less required to follow a definite syntax.

|| is an infix operator.
{a, b, ¢} || {c, 4, e}
{a; b, c} U {c, d, e}

The definition assigns a meaning to the | | operator.

x_ |l y_ :=Join[x, y]

Now | | can be evaluated by Mathematica.
{a, b, c} U {c, 4, e}

{a, b, ¢, ¢, d, e}

The details of how input you give to Mathematica is interpreted depends on whether you are
using StandardForm or TraditionalForm, and on what additional information you supply in

InterpretationBox and similar constructs.

But unless you explicitly override its built-in rules by giving your own definitions for
MakeExpression, Mathematica will always assign the same basic syntactic properties to any

particular special character.

These properties not only affect the interpretation of the special characters in Mathematica
input, but also determine the structure of expressions built with these special characters. They
also affect various aspects of formatting; operators, for example, have extra space left around

them, while letters do not.

Letters a, E n B, L, etc.
Letter-like forms 0, @, U, £, etc.
Operators ®, 0, =, =, etc.

Types of special characters.
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In using special characters, it is important to make sure that you have the correct character for
a particular purpose. There are quite a few examples of characters that look similar, yet are in

fact quite different.

A common issue is operators whose forms are derived from letters. An example is > or \ [Sum],

which looks very similar to = or \[CapitalSigma].

As is typical, however, the operator form J is slightly less elaborate and more stylized than the
letter form =. In addition, 3 is an extensible character which grows depending on the summand,
while = has a size determined only by the current font.

A A \[CapitalAlpha], A U \[Micro], \[Mu]

A A \[Angstrom], \[CapitalARing] o o \[EmptySet], \[CapitalOSlash]
dd \ [DifferentialD], d 1o \ [Product], \[CapitalPi]

e e \[ExponentialE], e > % \[Sum], \[CapitalSigma]

€ € \ [Element], \[Epsilon] T T \[Transpose], T

i \[ImaginaryI],i Uu \ [Union], U

Different characters that look similar.

In cases such as \[CapitalAlpha] versus A, both characters are letters. However, Mathemat-
ica treats these characters as different, and in some fonts, for example, they may look quite
different.

The result contains four distinct characters.
Union[{A, A, A, pu, u, u}]

{A, A, uy p}
Traditional mathematical notation occasionally uses ordinary letters as operators. An example is
the d in a differential such as dx that appears in an integral.

To make Mathematica have a precise and consistent syntax, it is necessary at least in

StandardForm to distinguish between an ordinary d and the d used as a differential operator.

The way Mathematica does this is to use a special character d or \ [DifferentialD] as the

differential operator. This special character can be entered using the alias Esc dd Esc.
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Mathematica uses a special character for the differential operator, so there is no conflict with an
ordinary d.

de dx

x1+d

1+d

When letters and letter-like forms appear in Mathematica input, they are typically treated as
names of symbols. But when operators appear, functions must be constructed that correspond
to these operators. In almost all cases, what Mathematica does is to create a function whose

name is the full name of the special character that appears as the operator.

Mathematica constructs a CirclePlus function to correspond to the operator &, whose full
name is \[CirclePlus].

a®b®®c//FullForm

CirclePlus[a, b, c]

This constructs an And function, which happens to have built-in evaluation rules in
Mathematica.
a A b A c// FullForm

And[a, b, c]

Following the correspondence between operator names and function names, special characters
such as |J that represent built-in Mathematica functions have names that correspond to those
functions. Thus, for example, = is named \ [Divide] to correspond to the built-in Mathematica

function Divide, and = is named \ [Implies] to correspond to the built-in function Implies.

In general, however, special characters in Mathematica are given names that are as generic as
possible, so as not to prejudice different uses. Most often, characters are thus named mainly
according to their appearance. The character ¢ is therefore named \ [CirclePlus], rather
than, say \[DirectSum], and =~ is named \[TildeTilde] rather than, say,

\ [ApproximatelyEqual].
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X x \ [Times], \[Cross] * * \[Star], *

A A \ [And], \[Wedge] \ \  \[Backslash], \

Vv \[Or], \[Vee] \ [CenterDot], .

- > \ [Rule], \[RightArrow] A N \[Wedge], N

> = \ [Implies], \[DoubleRightArrow] r \ [VerticalBar], |

= = \ [LongEqual], = [ \ [VerticalSeparator], |
T { \ [Piecewise], { ( < \ [LeftAngleBracket], <

Different operator characters that look similar.

There are sometimes characters that look similar but which are used to represent different
operators. An example is \ [Times] and \[Cross]. \[Times] corresponds to the ordinary
Times function for multiplication; \ [Cross] corresponds to the cross function for vector cross
products. The x for \ [Cross] is drawn slightly smaller than x for \ [Times], corresponding to

usual careful usage in mathematical typography.

The \ [Times] operator represents ordinary multiplication.
{5,6,7} x {2, 3, 1}
{10, 18, 7}

The \ [Cross] operator represents vector cross products.
{5,6,7} x {2, 3, 1}
{-15, 9, 3}

The two operators display in a similar way—with \ [Times] slightly larger than \ [Cross].
{a x b, a x b}

{ab, axb}

In the example of \ [And] and \ [Wedge], the \ [And] operator—which happens to be drawn
slightly larger—corresponds to the built-in Mathematica function aAnd, while the \ [Wedge]
operator has a generic name based on the appearance of the character and has no built-in

meaning.



Notebooks and Documents | 205

You can mix \[Wedge] and \[And] operators. Each has a definite precedence.
aabAcad//FullForm

And [Wedge [a, b], Wedge[c, d]]

Some of the special characters commonly used as operators in mathematical notation look
similar to ordinary keyboard characters. Thus, for example, » or \[Wedge] looks similar to the *

character on a standard keyboard.

Mathematica interprets a raw ~ as a power. But it interprets » as a generic wedge function. In
cases such as this where there is a special character that looks similar to an ordinary keyboard
character, the convention is to use the ordinary keyboard character as the alias for the special
character. Thus, for example, Esc ~ Esc is the alias for \ [Wedge] .

The raw " is interpreted as a power, but the Esc ~ Esc is a generic wedge operator.
{x *~ y, x Esc”Esc y}

{xY, XAY}

A related convention is that when a special character is used to represent an operator that can
be typed using ordinary keyboard characters, those characters are used in the alias for the
special character. Thus, for example, Esc ->Esc is the alias for - or \ [Rule], while Esc && Esc
is the alias for A or \ [And].

Esc ->Esc is the alias for \ [Rule], and Esc && Esc for \ [And].
{x Esc->Esc y, x Esc&&Esc y} // FullForm

List [Rule(x, y], And[x, y]]

The most extreme case of characters that look alike but work differently occurs with vertical

bars.
form character name alias interpretation
x|y | Alternatives [x, Y]
x|y \ [VerticalSeparator] Esc | Esc VerticalSeparator [x,y]
X1y \ [VerticalBar] Esc_.| Esc VerticalBar [x,y]
x| \ [LeftBracketingBar] Escl| Esc BracketingBar [x]
\ [RightBracketingBar)] Escr| Esc

Different types of vertical bars.
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Notice that the alias for \ [VerticalBar] is Esc, | Esc, while the alias for the somewhat more
common \ [VerticalSeparator] is Esc | Esc. Mathematica often gives similar-looking charac-
ters similar aliases; it is a general convention that the aliases for the less commonly used
characters are distinguished by having spaces at the beginning.

Esc nnn Esc built-in alias for a common character

Esc_ nnn Esc built-in alias for similar but less common character
Esc .nnn Esc alias globally defined in a Mathematica session
Esc ,nnn Esc alias defined in a specific notebook

Conventions for special character aliases.

The notebook front end for Mathematica often allows you to set up your own aliases for special
characters. If you want to, you can overwrite the built-in aliases. But the convention is to use
aliases that begin with a dot or comma.

Note that whatever aliases you may use to enter special characters, the full names of the
characters will always be used when the characters are stored in files.

Names of Symbols and Mathematical Objects

Mathematica by default interprets any sequence of letters or letter-like forms as the name of a

symbol.
All these are treated by Mathematica as symbols.
{§, 2a, Ro, H, X, LABC, X, m.n}
{¢, 2a, Ro, H, X, LABC, EMX, m.n}
form character name alias interpretation
b \[Pi] Escp Esc, Escpi Esc equivalent to Pi
\[Infinity] Escinf Esc equivalent to Infinity
e \ [ExponentialE] EsceeEsc equivalent to E
i \[ImaginaryI] EsciiEsc equivalent to T
J \[ImaginaryJ] Esc jjEsc equivalent to I

Symbols with built-in meanings whose names do not start with capital English letters.
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Essentially all symbols with built-in meanings in Mathematica have names that start with capital

English letters. Among the exceptions are e and i, which correspond to E and 1 respectively.

Forms such as e are used for both input and output in StandardForm.

{e”"(271i), e n}

Ty

In OutputForm e is output as E.
OutputForm[%]
, £Pi
In written material, it is standard to use very short names—often single letters—for most of the
mathematical objects that one considers. But in Mathematica, it is usually better to use longer

and more explicit names.

In written material you can always explain that a particular single-letter name means one thing
in one place and another in another place. But in Mathematica, unless you use different con-
texts, a global symbol with a particular name will always be assumed to mean the same thing.

As a result, it is typically better to use longer names, which are more likely to be unique, and
which describe more explicitly what they mean.

For variables to which no value will be assigned, or for local symbols, it is nevertheless conve-

nient and appropriate to use short, often single-letter, names.

It is sensible to give the global function LagrangianL a long and explicit name. The local
variables can be given short names.

LagrangianL[¢_, u_] = (0¢)? + u® ¢°

1 o? + (09)?
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form input interpretation

Xn x Ctrl+_ n Ctrl+Space Subscript [x,n]
X, x Ctrl+_ + Ctrl+Space SubPlus [x]

X_ x Ctrl+_ - Ctrl+Space SubMinus [x]

X, x Ctrl+_ * Ctrl+Space SubStar [x]

x* x Ctrl+~ + Ctrl+Space SuperPlus [x]
b x Ctrl+~ - Ctrl+Space SuperMinus [x]
x* x Ctrl+~ * Ctrl+Space SuperStar [x]
xt x Ctrl+~ Escdg Esc Ctrl+Space SuperDagger [x]
x x Ctrl+& _ Ctrl+Space OverBar [x]

X x Ctrl+& Escvec Esc Ctrl+Space OverVector [x]
X x Ctrl+& ~ Ctrl+Space OverTilde [x]

X x Ctrl+& ~ Ctrl+Space OverHat [x]

X x Ctrl+& . Ctrl+Space OverDot [x]

X x Ctrl++ _ Ctrl+Space UnderBar [x]

X Style [x, Bold} X

Creating objects with annotated names.

Note that with a notebook front end, you can change the style of text using menu items.

option typical default
value
SingleLetterItalics False whether to use italics for single-letter
symbol names
MultiLetterItalics False whether to use italics for multi-letter
symbol names
SingleLetterStyle None the style name or directives to use for
single-letter symbol names
MultiLetterStyle None the style name or directives to use for

multi-letter symbol names
Options for cells in a notebook.

It is conventional in traditional mathematical notation that names consisting of single ordinary
English letters are normally shown in italics, while other names are not. If you use
TraditionalForm, then Mathematica will by default follow this convention. You can explicitly
specify whether you want the convention followed by setting the SingleLetterItalics option
for particular cells or cell styles. You can further specify styles for names using single English
letters or multiple English letters by specifying values for the options singleLetterStyle and

MultiLetterStyle.
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Greek Letters
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form

S I NN O N SR

~

=

T N QR T g N oMt R > o=

full name
\[Alpha]
\[Beta]
\ [ Gamma ]
\[Delta]
\[Epsilon]

\[CurlyEpsilon]

\[Zeta]
\[Eta]
\[Theta]
\[CurlyTheta]
\[Iota]
\[Kappa]
\[CurlyKappa]
\ [Lambda ]
\[Mu]

\[Nu]

\[Xi]
\[Omicron]
\[Pi]
\[CurlyPi]
\[Rho]
\[CurlyRho]
\[Sigma]
\[FinalSigma]
\[Tau]
\[Upsilon]

aliases

:a:, :alpha:

:b:, :beta:

gz, :gamma:

:d:, :delta:

ez, :epsilon:
:ce:, :cepsilon:
:z:, :zeta:

ch:, :et:, :eta:
:q:, :ths, :theta:
:cq:;, :cth:, :ctheta:
:i:, :iota:

:k:, :kappa:
:ck:, :ckappa:
:1:, :1ambda:
m:, mu:

in:, :nu:

ixz, xi:

zom:, :omicron:
:p:, pi:

:cp:, :cpi:

:ir:, :rho:

:cr:, :crho:

:s:, :sigma:

:fs:

:t:, stau:

cuz, :upsilon:

form

=4 o mz > (=] T N m B> 1w

g

=

full name
\[CapitalAlpha]
\[CapitalBeta]
\[CapitalGamma ]
\[CapitalDelta]
\[CapitalEpsilon]

\[CapitalZeta]
\[CapitalEta]
\[CapitalTheta]

\[CapitalIota]
\[CapitalKappa]

\[CapitalLambda]
\[CapitalMu]
\[CapitalNu]
\[CapitalXi]
\[CapitalOmicron]
\[CapitalPi]

\[CapitalRho]
\[CapitalSigma]

\[CapitalTau]
\[CapitalUpsilon]

\[CurlyCapitalUpsilon]

aliases

:A:;, :Alpha:
:B:, :Beta:
:G:, :Gamma:
:D:, :Delta:
:E:, :Epsilon:
:Z:, :Zeta:

H:, :Et:, :Eta
:Q:, :Th:, :Theta:

:I:, :Iota:
:K:, :Kappa:
:L:, :Lambda:
Mz, Mu:

:N:, :Nu:

Xz, Xi:

:Om:, :Omicron:

Pz, Pi:
iRz, :Rho:
:S:, :Sigma:
:T:, :Tau:

:U:, :Upsilon:

:cU:, :cUpsilon:
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form  full name aliases form  full name aliases

1) \[Phi] :f:, :ph:, :phi: T \[CurlyCapitalUpsilon] :cU: :cUpsilon:

@ \[CurlyPhi] :j: :cph:, :cphi: @ \[CapitalPhi] :F:, :Ph:, :Phi:

X \[Chi] zcz, :ch:, :chi:

v \[Psi] :y:, ips:, psi: X \[CapitalChi] :Cz, :Ch;, :Chi:

W \ [Omega ] :0:, :w:, :omega: ¥ \[CapitalPsi] :Y:, :Ps:, :Psi:

f \ [Digamma] :di:, :digamma: Q \[CapitalOmega] :0:, W:, :Omega:

0 \ [Koppa ] :ko:, :koppa: F \[CapitalDigamma ] :Di:, :Digamma:

S \[Stigma] :stiz, :stigma: @ \[CapitalKoppa] :Koz, :Koppa:

2 \ [ Sampi ] :sa:, :sampi: q \[CapitalStigma] :Sti:, :Stigma:
) \[CapitalSampi ] :Sa:, :Sampi:

The complete collection of Greek letters in Mathematica.

You can use Greek letters as the names of symbols. The only Greek letter with a built-in mean-
ing in standardForm is n, which Mathematica takes to stand for the symbol pi.

Note that even though n on its own is assigned a built-in meaning, combinations such as =2 or

xn have no built-in meanings.

The Greek letters T and IT look very much like the operators for sum and product. But as dis-
cussed above, these operators are different characters, entered as \[Sum] and \[Product] respec-

tively.
Similarly, e is different from the € operator \[Element], and u is different from u or \[Micro].

Some capital Greek letters such as \[CapitalAlpha] look essentially the same as capital English
letters. Mathematica however treats them as different characters, and in TraditionalForm it

uses \[CapitalBeta], for example, to denote the built-in function Beta.

Following common convention, lower-case Greek letters are rendered slightly slanted in the
standard fonts provided with Mathematica, while capital Greek letters are unslanted. On Greek
systems, however, Mathematica will render all Greek letters unslanted so that standard Greek
fonts can be used.

Almost all Greek letters that do not look similar to English letters are widely used in science and
mathematics. The capital xi = is rare, though it is used to denote the cascade hyperon particles,
the grand canonical partition function and regular language complexity. The capital upsilon Y is
also rare, though it is used to denote b b particles, as well as the vernal equinox.
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Curly Greek letters are often assumed to have different meanings from their ordinary counter-
parts. Indeed, in pure mathematics a single formula can sometimes contain both curly and

ordinary forms of a particular letter. The curly pi w is rare, except in astronomy.

The final sigma g is used for sigmas that appear at the ends of words in written Greek; it is not

commonly used in technical notation.

The digamma ¢, koppa ¢, stigma ¢ and sampi » are archaic Greek letters. These letters provide
a convenient extension to the usual set of Greek letters. They are sometimes needed in making
correspondences with English letters. The digamma corresponds to an English w, and koppa to

an English q. Digamma is occasionally used to denote the digamma function PolyGamma [x].

Variants of English Letters

form  full name alias form  full name alias
! \[ScriptL] :scl: € \[DoubleStruckCapitalC] :dscC:
& \[ScriptCapitalE] :scE: R \[DoubleStruckCapitalR] :dsR:
H \[ScriptCapitalH] :scH: @ \[DoubleStruckCapitalQ] :dso:
L \[ScriptCapitalL] :scL: =z \[DoubleStruckCapitalZ] :dsz:
C \[GothicCapitalC] :goC: N \ [DoubleStruckCapitalN] :dsN:
H \[GothicCapitalH] :goH: 1 \[DotlessI]

1 \[GothicCapitalI] :goI: J \[DotlessJ]

R \[GothicCapitalR] :goR: o \[WeierstrassP] wp:

Some commonly used variants of English letters.

By using menu items in the notebook front end, you can make changes in the font and style of
ordinary text. However, such changes are usually discarded whenever you send input to the

Mathematica kernel.

Script, gothic and double-struck characters are, however, treated as fundamentally different
from their ordinary forms. This means that even though a c that is italic or a different size will

be considered equivalent to an ordinary ¢ when fed to the kernel, a double-struck C will not.

Different styles and sizes of C are treated as the same by the kernel. But gothic and double-
struck characters are treated as different.

C+C+C+C+C
3C+C+C
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In standard mathematical notation, capital script and gothic letters are sometimes used inter-
changeably. The double-struck letters, sometimes called blackboard or openface letters, are
conventionally used to denote specific sets. Thus, for example, C conventionally denotes the set
of complex numbers, and Z the set of integers.

Dotless i and j are not usually taken to be different in meaning from ordinary i and j; they are
simply used when overscripts are being placed on the ordinary characters.

\[WeierstrassP] is a notation specifically used for the Weierstrass P function weierstrassp.

full names aliases
\[ScriptA] - \[ScriptZ] :sca: - :sCcz: lowercase script letters
\[ScriptCapitalA] - \[ScriptCapitalZ]
:SCA: - :sCZ: uppercase script letters
\[GothicA] - \[GothicZ] :goa: - :goz: lowercase gothic letters
\[GothicCapitalA] - \[GothicCapitalZ]
:goA: - :goZ: uppercase gothic letters
\[DoubleStruckA] - \[DoubleStruckZ]
:dsa: - :dsz: lowercase double-struck
letters
\[DoubleStruckCapitalA] - \[DoubleStruckCapitalZ]
:dsA: - :dsZ: uppercase double-struck
letters
\[FormalA] - \[FormalZ]
:$a: - =Sz lowercase formal letters
\[FormalCapitalA] - \[FormalCapitalZ]
:$A: - :$2: uppercase formal letters

Complete alphabets of variant English letters.

Formal Symbols

Symbols represented by formal letters, or formal symbols, appear in the output of certain
functions. They are indicated by gray dots above and below the English letter.

DifferentialRoot automatically chooses the names for the function arguments.

root = DifferentialRootReduce[Cos]

DifferentialRoot[Function[{3:/, x}, y %] —?”[):(] =0, y[0] =1, y'[0] = H
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Formal symbols are protected, so they cannot be accidentally assigned a value.

Trying to modify a formal symbol fails.
y=0

>

This means that expressions depending on formal symbols will not be accidentally modified.
root[[1l, 2]]

Y% -y [%] =0, yl0] =1, y'[0] =0}
Specific values for formal symbols can be substituted using replacement rules.

Verify that the defining equations hold for cosine.

root[[1l, 2]] /. ¥ - Cos

{True, True, True}

Formal symbols can be temporarily modified inside of a Block because Block clears all defini-
tions associated with a symbol, including Attributes. Table works essentially like Block, thus

also allowing temporary changes.

Assign a temporary value to v:

Block[{;} = Cos}, root[[1, 2]]]

{True, True, True}

In most situations modifying formal symbols is not necessary. Since in DifferentialRoot
formal symbols are used as names for the formal parameters of a function, the function should

simply be evaluated for the actual values of arguments.

Evaluating the function substitutes x for x and y for y.

root[[1]] [y, x]

{y[x] +y'[x] =0, y[0] =1, y'[0] ==0}
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It is possible to define custom typesetting rules for formal symbols.

Use coloring to highlight formal symbols.

MakeBoxes [x, _] 1= TagBox["x" , X &, AutoDelete - True,

BaseStyle » {FontColor -» RGBColor[.6, .4, .2], ShowSyntaxStyles - False}]
MakeBoxes [y, _| := TagBox["y", ¥ &, AutoDelete - True,

BaseStyle » {FontColor -» RGBColor[.6, .4, .2], ShowSyntaxStyles -» False}]
root

DifferentialRoot[Function[{v, =}, {v[=] + v [x] = 0, v[0] = 1, ¥'[0] = 0}]]

The formatting rules were attached to MakeBoxes. Restore the original formatting:
FormatValues @MakeBoxes = {};

root

DifferentialRoot[Function[{3:/, x}, yx] y”[x} =0, 3:/[0] =1, 3:/'[0] = O}H

Hebrew Letters

form  full name alias form  full name
N \[Aleph] :al: A \[Gimel]
1 \[Bet] T \[Dalet]

Hebrew characters.

Hebrew characters are used in mathematics in the theory of transfinite sets; x, is for example
used to denote the total number of integers.
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Units and Letter-Like Mathematical Symbols

form  full name alias form  full name alias
u \[Micro] mis: ° \ [Degree] :deg:
[ \ [Mho] :mho: 0] \[EmptySet] :es:
A \[Angstrom] :Ang: S \[Infinity] :inf:
h \ [HBar] :hb: e \[ExponentialE] :ee:
¢ \[Cent] :cent: i \[ImaginaryI] =idis
£ \[Sterling] 3 \[ImaginaryJ] j5:
< \[Euro] euro: v \ [DoubledPi] :pp:
¥ \[Yen] ¥ \[DoubledGamma] :gg:

Units and letter-like mathematical symbols.

Mathematica treats ° or \ [Degree] as the symbol Degree, so that, for example, 30 ° is equiva-
lent to 30 Degree.

Note that x, A and ¢ are all distinct from the ordinary letters p (\[Mu]), A
(\[CapitalARing]) and @ (\[CapitalOSlash]).

Mathematica interprets « as Infinity, e as E, and both i and j as 1. The characters ¢, i and j

are provided as alternatives to the usual uppercase letters E and 1.

n and y are not by default assigned meanings in StandardForm. You can therefore use =n to
represent a pi that will not automatically be treated as pi. In TraditionalForm v is interpreted

as EulerGamma.

form  full name alias form  full name alias

o \ [PartialD] :pd: Z \ [Sum] :sum:

d \ [DifferentialD] :dd: N \ [Product ] prod:

D \ [CapitalDifferentialD] :DD:
T - -

. \ [Del] el \ [Tran?pc.Jse} . tr:

. H \ [HermitianConjugate] :hc:

A \ [DifferenceDelta] :diffd:
E \ [DiscreteShift] :shift:
@ \ [DiscreteRatio] :dratio:

Operators that look like letters.
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V is an operator while #, ° and ¥ are ordinary symbols.
{v £, "2, 45°, 5000 ¥} // FullForm

List|[Del[£f], Power[\[HBar], J, Times[45, Degree], Times[5000, \[Yen]]]

Shapes, Icons and Geometrical Constructs

form  full name alias form  full name alias

. \[FilledVerySmallSquare] :fvssq: © \[EmptySmallCircle] :esci:

o \[EmptySmallSquare] :essq: . \[FilledSmallCircle] :fsci:

. \[FilledSmallSquare] :fssq: @) \[EmptyCircle] :eci:

] \ [EmptySquare] z:esq: o \[GrayCircle] :gci:

= \ [GraySquare] :gsq: ° \[FilledCircle] :feoi:

] \[FilledSquare] :fsq: A \ [EmptyUpTriangle]

\ [DottedSquare] A \[FilledUpTriangle]

0 \ [EmptyRectangle] \Y \ [EmptyDownTriangle]

[ \[FilledRectangle] v \[FilledDownTriangle]

o \ [EmptyDiamond] * \[FivePointedStar] *5:

. \[FilledDiamond] * \[SixPointedStar] x6:
Shapes.

Shapes are most often used as “dingbats” to emphasize pieces of text. But Mathematica treats

them as letter-like forms, and also allows them to appear in the names of symbols.

In addition to shapes such as \[EmptySquare], there are characters such as \ [Square]
which are treated by Mathematica as operators rather than letter-like forms.

form  full name alias form  full name aliases

& \[Mathematicalcon] :math: ©) \ [HappySmiley] )5 -)
() \[KernelIcon] ) \[NeutralSmiley] ::-|:

% \[LightBulb] ® \[SadSmiley] &

A \[WarningSign] \[FreakedSmiley] ::-@:

o} \ [WatchIcon] PN \[Wolf] :wf:, :-wolf:

Icons.

You can use icon characters just like any other letter-like forms.
Expand[ (@ + A) " 4]

0 +40° L +60% 8%+ 403+ p
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form  full name form  full name

L \[Angle] < \ [SphericalAngle]
N \[RightAngle] A \[EmptyUpTriangle]
L \ [MeasuredAngle] %) \ [Diameter]

Notation for geometrical constructs.

Since Mathematica treats characters like L as letter-like forms, constructs like (BC are treated in
Mathematica as single symbols.

Textual Elements

form  full name alias  form  full name alias
- \[Dash] 2= ’ \[Prime] 20z
\[LongDash] 2=g ” \[DoublePrime] 30 0g
. \[Bullet] bu: \ \ [ReversePrime] =z
T \ [Paragraph] N \ [ReverseDoublePrime] =g
s \[Section] « \[LeftGuillemet] g<<:
é \ [DownQuestion] :d?: » \[RightGuillemet] :g>>:
i \[DownExclamation] :d!: \[Ellipsis]

Characters used for punctuation and annotation.

form  full name form  full name alias
© \[Copyright] t \ [Dagger] :dg:
® \[RegisteredTrademark] t \ [DoubleDagger] :ddg:
e \ [Trademark] * \[ClubSuit]
b \[Flat] o \ [DiamondSuit]

\ [Natural] V) \[HeartSuit]

\[Sharp] - \[SpadeSuit]

Other characters used in text.
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form

Characters used in building sequences and arrays.

full name
\[HorizontalLine]
\[VerticalLine]
\[Ellipsis]
\[CenterEllipsis]
\[VerticalEllipsis]
\[AscendingEllipsis]
\[DescendingEllipsis]

alias

:hline:

:vline:

form  full name

— \ [UnderParenthesis]
— \ [OverParenthesis]

— \ [UnderBracket]
— \[OverBracket]
- \[UnderBrace]
— \[OverBrace]

The under and over braces grow to enclose the whole expression.

Underoverscript [Expand[ (1 +x) ~4], «, ~]

1+4x+6x%+4x%+x

Extended Latin Letters

Mathematica supports all the characters commonly used in Western European languages based

on Latin scripts.

alias
u(:
o (:
uf:
of:
u{:
o{:

form

o

[VHE

@ Qo

8

o ™ O Q «Q O

o: ™

full name alias
\[AGrave] :a:
\[AAcute] :a':
\[AHat] :at:
\[ATilde] :a~:
\[ADoubleDot ] :a":
\[ARing] :ao:
\[ABar] :a-:
\[ACup] :au:
\[AE] :ae:
\[CAcute] :c':
\[CCedilla] :c,:
\ [CHacek] :cv:
\[EGrave] e
\[EAcute] e':
\[EBar] ie-:
\ [EHat] :e’:

\ [EDoubleDot ] :e':

form  full name

o L 2 I

BB P e

(s HE s D R s N = A @ T O BN @ N

\[CapitalAGrave]

\ [CapitalAAcute]
\[CapitalAHat]
\[CapitalATilde]
\[CapitalADoubleDot ]
\[CapitalARing]
\[CapitalABar]
\[CapitalACup]
\[CapitalAE]

\ [CapitalCAcute]
\[CapitalCCedilla]
\[CapitalCHacek]
\[CapitalEGrave]
\[CapitalEAcute]
\[CapitalEBar]
\[CapitalEHat]

\ [CapitalEDoubleDot ]

alias
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& \[ECup] :eu E \[CapitalECup] :Eu:
i \[IGrave] S I \[CapitalIGrave] ST
i \[IAcute] S I \[CapitalIAcute] I
i \[IHat] =it 1 \[CapitalIHat] I
i \[IDoubleDot] g™ I \[CapitalIDoubleDot ] s
i \[ICup] zius I \[CapitalICup] Tu:
o) \[Eth] :d-: 2] \[CapitalEth] :D-:
1 \[LSlash] :1/: E \[CapitalLSlash] SV
i \[NTilde] :n~ N \[CapitalNTilde] N~:
e} \[OGrave] :0” o] \[CapitalOGrave] h
o) \[OAcute] :0' 0 \[CapitalOAcute] '
o) \ [OHat ] 0" 0] \[CapitalOHat] :0”:
o) \[0Tilde] 0~ o] \[CapitalOTilde] :0~:
o) \ [ODoubleDot ] :0" o] \[CapitalODoubleDot ] :0":
6 \[ODoubleAcute] :o0'' o] \[CapitalODoubleAcute] :0"'
] \[0Slash] :0/: (4] \[CapitalOSlash] :0/:
® \[OE] :0e: (3 \[CapitalOE] :OE:
§ \ [ SHacek] :sV: S \[CapitalSHacek] :Sv:
u \[UGrave] u” U \[CapitalUGrave] B0l
a \[UAcute] u' 0] \[CapitalUAcute] EURE
a \ [UHat ] u” i) \[CapitalUHat] S
i \ [UDoubleDot ] u" U \[CapitalUDoubleDot ] EURE
d \[UDoubleAcute] :wu'' G \[CapitalUDoubleAcute] :U"'
y \[YAcute] S ¥ \[CapitalYAcute] Y
b \ [Thorn] thn: b \[CapitalThorn] Thn:
B \[SZ] sz, :Ss:

Variants of English letters.

Most of the characters shown are formed by adding diacritical marks to ordinary English letters.
Exceptions include \[SZ] B, used in German, and \[Thorn] p and \[Eth] 9, used primarily in

Old English.

You can make additional characters by explicitly adding diacritical marks yourself.

char Ctrl+& mark Ctrl+Space add a mark above a character

char Ctrl++ mark Ctrl+Space add a mark below a character

Adding marks above and below characters.
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form alias full name
! (keyboard character) \ [RawQuote] acute accent
’ 20 3 \[Prime] acute accent
N (keyboard character) \ [RawBackquote] grave accent
\ R \ [ReversePrime] grave accent
. (keyboard characters) umlaut or diaeresis
. (keyboard character) \ [RawWedge ] circumflex or hat
o :esci: \[EmptySmallCircl- ring
e]

. (keyboard character) \ [RawDot ] dot
~ (keyboard character) \ [RawTilde] tilde
_ (keyboard character) \ [RawUnderscore] bar or macron
. the: \ [Hacek] hacek or check
. :bv: \ [Breve] breve
- :dbv: \ [DownBreve] tie accent
” N \ [DoublePrime] long umlaut

:cd: \[Cedilla] cedilla

Diacritical marks to add to characters.

Operators

Basic Mathematical Operators

form  full name alias form  full name alias

X \ [Times ] x: x \ [Cross] :cross:
2 \ [Divide] :div: + \ [PlusMinus] :+-:

\/ \ [Sqrt] :sqrt: T \ [MinusPlus] :—+:

Some operators used in basic arithmetic and algebra.

Note that the x for \[Cross] is distinguished by being drawn slightly smaller than the x for \
[Times].
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XXy Times [x,Y] multiplication

x=y Divide[x,y] division

Vx Sqrt [x] square root

Xxy Cross [x,y] vector cross product
X PlusMinus [x] (no built-in meaning)
Xty PlusMinus [x,y] (no built-in meaning)
FX MinusPlus [x] (no built-in meaning)
XFy MinusPlus [x,y] (no built-in meaning)

Interpretation of some operators in basic arithmetic and algebra.

Operators in Calculus and Algebra

form  full name alias form  full name alias
v \ [Del] :del: | \ [Integral] :int:
0 \ [PartialD] :pd: $ \ [ContourIntegral] :cint:
d \[DifferentialD]  id: 9@5 \ [DoubleContourIntegral]
Z \ [Sum] ssum: . .
93 \ [CounterClockwiseContourIntegral] :cccint:
H \ [Product] ARFEECE gS \ [ClockwiseContourIntegral] :ccint:

Operators used in calculus.

form  full name aliases form  full name alias
* \ [Conjugate] :co: :conj: u \ [ConjugateTranspose] :ct:
i \ [Transpose] :tr: " \ [HermitianConjugate] :hc:

Operators for complex numbers and matrices.



222 | Notebooks and Documents

Logical and Other Connectives

form  full name aliases form  full name alias
A\ \ [And] :§&7 zand: > \ [Implies] =>:
v \[or] - \ [RoundImplies]
\ [Therefore] StePs

N sy snot. \ [Because]
€ \ [Element ] 2ils . \ [RightTee]
v \ [BEERLL] e - \ [LeftTee]
2 b [EElsEs] e E \ [DoubleRightTee]
G My e e 4 \ [DoubleLeftTee]
! \ [Xor] BdelE 5 \ [SuchThat ] ist:
7\ \ [Nand] mnand: | \ [VerticalSeparator] :|:
\7 \ [Nor] nor: \ [Colon]

Operators used as logical connectives.

The operators A, v and - are interpreted as corresponding to the built-in functions aAnd, or and
Not, and are equivalent to the keyboard operators &&, || and !. The operators v, A and U

correspond to the built-in functions xor, Nand and Nor. Note that - is a prefix operator.

x=y and x>y are both taken to give the built-in function Implies[x, y]. xey gives the built-in

function Element [x, y].

This is interpreted using the built-in functions And and Implies.
3<4 ANx>5=>y<17

Implies[x>5, y<7]

Mathematica supports most of the standard syntax used in mathematical logic. In Mathematica,
however, the variables that appear in the quantifiers v, 3 and # must appear as subscripts. If
they appeared directly after the quantifier symbols then there could be a conflict with multiplica-

tion operations.

v and 3 are essentially prefix operators like &.
Vyx 3y ¢[x, y] // FullForm

ForAll[x, Exists[y, \[Phi][x,y] H



Notebooks and Documents | 223

Operators Used to Represent Actions

form  full name alias form  full name alias
° \ [SmallCircle] :sc: A \ [Wedge] =
® \ [CirclePlus] :c+: v \ [Vee] v:
) \ [CircleMinus] ic-: U \ [Union] un:
® \ [CircleTimes] ks @ \ [UnionPlus]
o) \ [CircleDot] :c.: )
R \|[Diamond] dia: ﬂ \ [Intersection] :inter:
\ [CenterDot] ﬂ \ [SquareIntersection]
* \ [Star] :star: u \ [SquareUnion]
! \ [VerticalTilde]
i \ [Coproduct] :coprod:
\ \ [Backslash] \e
~ \ [Cap]
- \ [Cup]
o \ [Square] :sq:

Operators typically used to represent actions. All the operators except \[ Square] are infix.

Following Mathematica’s usual convention, all the operators in the table are interpreted to give
functions whose names are exactly the names of the characters that appear in the operators.

The operators are interpreted as functions with corresponding names.
x®y ~ z// FullForm

CirclePlus[x, Caply, 2]]

All the operators in the table above, except for o, are infix, so that they must appear in

between their operands.
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Bracketing Operators

form  full name alias form  full name alias

| \ [LeftFloor] 53 ( \ [LeftAngleBracket] <t

| \ [RightFloor] rf: \ [RightAngleBracket] >

[ \ [LeftCeiling] :lc: | \ [LeftBracketingBar] olE

] \ [RightCeiling] ire: } \ [RightBracketingBar] e[

[ \ [LeftDoubleBracket] & I \ [LeftDoubleBracketingBar] gl (|2

] \ [RightDoubleBracket] :]]: I \ [RightDoubleBracketingBar] :r|]|:
Characters used as bracketing operators.

[ x] Floor [x]

[x] Ceiling[x]

mli, j,...1 Part [(m,i,j,...]

(XyYyeer) AngleBracket [x,y,...]

1 X, y,... 1 BracketingBar [x,y,...]

lx, ¥, DoubleBracketingBar [x,y,...]

Interpretations of bracketing operators.

Operators Used to Represent Relations

form  full name alias form  full name alias
= \ [Equal] ==: # \ [NotEqual] s1=:

= \ [LongEqual] :1=: # \ [NotCongruent] ===
= \ [Congruent ] === + \ [NotTilde] 2~

~ \ [Tilde] i~ % \ [NotTildeTilde] Pl
= \ [TildeTilde] R % \ [NotTildeEqual] o=
= \ [TildeEqual] =t % \ [NotTildeFullEqual] :!~==:
= \ [TildeFullEqual] :~==: % \ [NotEqualTilde] =~
= \ [EqualTilde] 1=~z # \ [NotHumpEqual] :1h=:
ES \ [HumpEqual ] h=: # \ [NotHumpDownHump ]

= \ [HumpDownHump ] * \ [NotCupCap]

= \ [CupCap] o \ [Proportional] :prop:
= \ [DotEqual] \ [Proportion]

Operators usually used to represent similarity or equivalence.
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The special character == (or \[Equal]) is an alternative input form for ==. # is used both for input

and output.
{a==b,a =b,al!=b, a # b}
{a==b, a==b, a+b, a+b}

form  full name alias  form  full name alias

> \ [GreaterEqual] >=: ES \ [NotGreaterEqual] D1>=:

< \ [LessEqual] <=z * \ [NotLessEqual] sl<=:

> \ [GreaterSlantEqual] >/ # \ [NotGreaterSlantEqual] 21>/:

< \ [LessSlantEqual] </: £ \ [NotLessSlantEqual] 11</:

ES \ [GreaterFullEqual] 3 \ [NotGreaterFullEqual]

< \ [LessFullEqual] £ \ [NotLessFullEqual]

2 \ [GreaterTilde] >~ * \ [NotGreaterTilde] o>~

< \ [LessTilde] i<~ % \ [NotLessTilde] Io<~

> \ [GreaterGreater] » \ [NotGreaterGreater]

< \ [LessLess] « \ [NotLessLess]

> \ [NestedGreaterGreater] * \ [NotNestedGreaterGreater]

< \ [NestedLessLess] # \ [NotNestedLessLess ]

z \ [GreaterLess] £ \ [NotGreaterLess]

s \ [LessGreater] £ \ [NotLessGreater]

z \ [GreaterEqualless] » \ [NotGreater] =

= \ [LessEqualGreater] « \ [NotLess] 1<:
Operators usually used for ordering by magnitude.

form  full name alias form  full name alias

c \ [Subset] :sub: ¢ \ [NotSubset] :1sub:

> \ [Superset] :sup: b \ [NotSuperset] :!sups

c \ [SubsetEqual] :sub=: ¢ \ [NotSubsetEqual] :Isub=:

) \ [SupersetEqual] :sup=: ? \ [NotSupersetEqual] I sup=:

5 \ [Element] :el: ¢ \ [NotElement] :lel:

> \ [ReverseElement] :mem: » \ [NotReverseElement] :!mem:

Operators used for relations in sets.
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form  full name form  full name

> \ [Succeeds] ¥ \ [NotSucceeds]

< \ [Precedes] b3 \ [NotPrecedes]

> \ [SucceedsEqual] * \ [NotSucceedsEqual]

< \ [PrecedesEqual] % \ [NotPrecedesTilde]

> \ [SucceedsSlantEqual] * \ [NotSucceedsSlantEqual]

< \ [PrecedesSlantEqual] % \ [NotPrecedesSlantEqual]

z \ [SucceedsTilde] * \ [NotSucceedsTilde]

s \ [PrecedesTilde] # \ [NotPrecedesEqual]

> \ [RightTriangle] ¥ \ [NotRightTriangle]

q \ [LeftTriangle] 1% \ [NotLeftTriangle]

> \ [RightTriangleEqual] ¥ \ [NotRightTriangleEqual]

Q \ [LeftTriangleEqual] # \ [NotLeftTriangleEqual]

> \ [RightTriangleBar] » \ [NotRightTriangleBar]

a \ [LeftTriangleBar] % \ [NotLeftTriangleBar]

] \ [SquareSuperset] i \ [NotSquareSuperset]

C \ [SquareSubset] ¢ \ [NotSquareSubset ]

| \ [SquareSupersetEqual] 2 \ [NotSquareSupersetEqual ]

E \ [SquareSubsetEqual] rs \ [NotSquareSubsetEqual]
Operators usually used for other kinds of orderings.

form  full name alias form  full name alias

i \ [VerticalBar] A E b \ [NotVerticalBar] SHE

I \ [DoubleVerticalBar] :]||: " \ [NotDoubleVerticalBar] :!|]|:

Relational operators based on vertical bars.

Operators Based on Arrows and Vectors

Operators based on arrows are often used in pure mathematics and elsewhere to represent

various kinds of transformations or changes.

- is equivalent to ->.
Xx+y/.x > 3

3+y
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form  full name alias  form  full name alias
- \ [Rule] =>: > \ [Implies] =>:
S \ [RuleDelayed] ::>: > \ [RoundImplies]
Arrow-like operators with built-in meanings in Mathematica.

form  full name alias form  full name
—— \[RightArrow] 5. =5% T \ [UpArrow]
«—— \[LeftArrow] <- l \ [DownArrow]
«—— \[LeftRightArrow] <> I \ [UpDownArrow]
—— \[LongRightArrow] ——>:
¢ \ [LongLeftArrow] e I \ [UpTeeArrow]
«— \[LongLeftRightArrow] <——> I \ [DownTeeArrow]
> \ [ShortRightArrow] T \ [UpArrowBar]
< \ [ShortLeftArrow] | \ [DownArrowBar |
—— \[RightTeeArrow] H \ [DoubleUpArrow]
«—— \[LeftTeeArrow]

] i \ [DoubleDownArrow]
— \[RightArrowBar]
O\ [TefiimrerEer] U \ [DoubleUpDoOwnArrow]
—— \[DoubleRightArrow] 1 =>: —— \[RightArrowLeftArrow]
«——— \[DoubleLeftArrow] i<= —— \[LeftArrowRightArrow]
—— \[DoubleLeftRightArrow] <=> 1 \ [UpArrowDownArrow]
—— \[DoubleLongRightArrow] ==>: ﬂ \ [DownArrowUpArrow]
¢ \ [DoubleLongLeftArrow] x@==g N \ [LowerRightArrow]
<~ \[DoubleLongLeftRightArrow] :<==>: / \ [LowerLeftArrow]

AN \ [UpperLeftArrow]
/ \ [UpperRightArrow]

Ordinary arrows.
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form  full name
\ [RightVector]

~——— \[LeftVector]

«~——~ \[LeftRightVector]
—— \[DownRightVector]
—— \[DownLeftVector]
—— \[DownLeftRightVector]
—— \[RightTeeVector]
«—— \[LeftTeeVector]

—— \ [DownRightTeeVector]
— \ [DownLeftTeeVector]
——  \[RightVectorBar]
—— \[LeftVectorBar]

—— \[DownRightVectorBar]
~—— \ [DownLeftVectorBar]
—— \[Equilibrium]

—— \[ReverseEquilibrium]

Vectors and related arrows.

alias form

vec:

zequi:

1
|
]
[
|
[
1
|
[
!
I
l
I
|

I
[

full name
\ [LeftUpVector]

\ [LeftDownVector]

\ [LeftUpDownVector]
\ [RightUpVector]

\ [RightDownVector]

\ [RightUpDownVector]
\ [LeftUpTeeVector]

\ [LeftDownTeeVector]
\ [RightUpTeeVector]
\ [RightDownTeeVector]
LeftUpVectorBar]
LeftDownVectorBar |

RightUpVectorBar]

\
\
\
\
\ [UpEquilibrium]
\

[
[
[
[RightDownVectorBar]
[
[

ReverseUpEquilibrium]

All the arrow and vector-like operators in Mathematica are infix.

x2y1z

x=2yllz
form  full name alias form  full name
F \ [RightTee] :rT: E \ [DoubleRightTee]
4 \ [LeftTee] :17T: 4 \ [DoubleLeftTee]
n \ [UpTee] wuT:
T \ [DownTee] :dT:

Tees.
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Structural Elements and Keyboard Characters

full name alias full name alias
\[InvisibleComma ] Esc, Esc \[AlignmentMarker] EscamEsc

\ [InvisibleApplication] Esc@Esc \ [NoBreak] Escnb Esc
\[InvisibleSpace] Escis Esc \[Null] Escnull Esc
\ [ImplicitPlus] Esc+ Esc

Invisible characters.

In the input there is an invisible comma between the 1 and 2.

mp>

my,2

Here there is an invisible space between the x and y, interpreted as multiplication.
FullForm|[xy]

Times [x, Y]

\[Null] does not display, but can take modifications such as superscripts.
f[x, "a]

f[x, a}

The \[AlignmentMarker] does not display, but shows how to line up the elements of the
column.

Grid[{{"b + ¢ + 4"}, {"a + b + ¢"}}, Alignment -> ""] // DisplayForm

b+c+d
a+ b+ c

The \ [ImplicitPlus] operator is used as a hidden plus sign in mixed fractions.

2
1—

3
5

3
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full name alias full name

alias
\[VeryThinSpace] Esc_ Esc \[NegativeVeryThinSpace] Esc-_Esc
\[ThinSpace] Esc_, Esc \[NegativeThinSpace] Esc-__Esc
\ [MediumSpace] Esc_._._Esc \ [NegativeMediumSpace] Esc-_._. Esc
\[ThickSpace] Esc_. .. Esc \[NegativeThickSpace] Esc-____Esc
\[InvisibleSpace] EscisEsc \ [NonBreakingSpace] Escnbs Esc
\[NewLine] \[IndentingNewLine] Escnl Esc
Spacing and newline characters.
form  full name alias form  full name alias
[ \[SelectionPlaceholder] EscsplEsc O \[Placeholder] EscplEsc

Characters used in buttons.

In the buttons in a palette, you often want to set up a template with placeholders to indicate
where expressions should be inserted. \[SelectionPlaceholder] marks the position where
an expression that is currently selected should be inserted when the contents of the button are

pasted. \[Placeholder] marks other positions where subsequent expressions can be ins-

erted. The Tab key will take you from one such position to the next.

form  full name alias form  full name

alias
_ \[SpaceIndicator] EscspaceEsc \ [RoundSpaceIndicator]
d \[ReturnIndicator] EscretEsc [crR] \[ControlKey] Escctr
RET \ [ReturnKey] Esc_ret Esc oM \ [CommandKey ] Esccmc
[EnTeR] \[EnterKey] Escent Esc { \[LeftModified] Esc [ Es
ESC \ [EscapeKey] Esc_escEsc ] \[RightModified] Esc ] E¢
\[AliasIndicator] Escesc Esc 32 \[CloverLeaf] Esccll

Representations of keys on a keyboard.

In describing how to enter input into Mathematica, it is sometimes useful to give explicit repre-

sentations for keys you should press. You can do this using characters like < and [c]. Note that

_ and _ are actually treated as spacing characters by Mathematica.

This string shows how to type o?.
"dal] A:z @u}"
[dafes) o ~]2
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form  full name form

full name

\[Continuation] -
<< \ [LeftSkeleton]
> \[RightGuillemet]

Characters generated in Mathematica output.

\[SkeletonIndicator]
\[ErrorIndicator]

Mathematica uses a \ [Continuation] character to indicate that the number continues onto

the next line.
80!

71569457 046263802294811533723186532165584657342365752577109445058227039255480148842 -

668944867280814080000000000000000000

form full name form  full name
\[RawTab ] / \ [RawSlash]
\ [NewLine] \ [RawColon]
\ [RawReturn] ; \ [RawSemicolon]
\ [RawSpace] < \ [RawLess ]
! \ [RawExclamation] = \ [RawEqual]
" \ [RawDoubleQuote] > \ [RawGreater]
t \ [RawNumberSign] 2 \ [RawQuestion]
$ \[RawDollar] ® \ [RawAt ]
% \ [RawPercent] [ \ [RawLeftBracket]
& \[RawAmpersand] \ \ [RawBackslash]
[RawQuote] ] \ [RawRightBracket]
( \ [RawLeftParenthesis]
~ \ [RawWedge]
) \ [RawRightParenthesis] N
* \ [RawStar] - \ [RawBackquote]
i \ [RawPlus] { \ [RawLeftBrace]
, \ [RawComma ] .
‘ \ [RawVerticalBar]
= \ [RawDash] )
\ [RawDot ] } \ [RawRightBrace]
[

Raw keyboard characters.

\ [RawTilde]

The fonts that are distributed with Mathematica contain their own renderings of many ordinary

keyboard characters. The reason for this is that standard system fonts often do not contain

appropriate renderings. For example, *~ and ~ are often drawn small and above the centerline,

while for clarity in Mathematica they must be drawn larger and centered on the centerline.





